
PART 6 — CONTENTS

46 Editing, Adding, and Copying Effects and Filters ������������������������������������������������������898

47 Using Transitions ����������������������������������������������������������������������������������������������������������������912

48 Titles, Generators, and Stills �������������������������������������������������������������������������������������������933

49 Using the DaVinci Resolve Speed Editor and Editor Keyboard �����������������������������947

50 Compositing and Transforms in the Timeline ������������������������������������������������������������986

51 Speed Effects ���������������������������������������������������������������������������������������������������������������������1002

52 Subtitles and Closed Captioning  ���������������������������������������������������������������������������������1015

53 Keyframing Effects in the Edit Page �������������������������������������������������������������������������� 1034

54 VFX Connect ���������������������������������������������������������������������������������������������������������������������� 1048

Editing Effects 
and Transitions



Chapter 46

Editing, Adding, 
and Copying 
Effects and Filters
This chapter covers how to browse for and apply effects 
to clips in the Timeline, how to copy them from clip to clip, 
how to remove them, and how to edit them in the Inspector 
once they’ve been added. 

For more information about the specific Resolve FX that are available, see Part 12, “Resolve FX.”
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Using the Effects Library
All effects that you can add to your edit, including filters, transitions, titles, and generators, are found 
in the Effects panel. The Effects panel shows a hierarchical list of all of the different transitions, title 
effects, generators, and filters that are available, sorted by category.

To preview a video effect before placing it on a clip, ensure that “Hover Scrub Preview” is checked in 
the Effects option menu, then simply hover your pointer over any thumbnail in the Effects tab and 
move it across the thumbnail. The effect will preview in the Viewer using its default parameters, and 
scrub through the clip that is selected in the Timeline. If no clip is selected then it will use the clip 
currently under the playhead.

To activate a specific video effect on a clip, simply drag the thumbnail of the selected effect to a clip on the 
Timeline. You can also double click the thumbnail, or drag an effect directly into the Inspector to apply the 
effect to the selected clip. To adjust the effect’s parameters, open the Effects tab in the Inspector.  

Scrubbing over an Effect Thumbnail previews that effect in the Viewer.

The Toolbox
All of the video and audio transitions, titles, and generators that ship along with DaVinci Resolve:

 — Toolbox: Exposes all transitions, titles, generators, and effects at once.

 — Video Transitions: Contains all of the built-in transitions that are available from DaVinci, 
organized by category. At the bottom of the list, a User category shows presets that 
you’ve saved. You can drag any video transition to any edit point in the Timeline that has 
overlapping clip handles to add it to your edit; you have the option to drag the transition so 
that it ends on, is centered on, or starts on the edit point. For more information, see Chapter 47, 
“Using Transitions.” Audio Transitions: Contains audio transitions for creating crossfades.

 — Titles: Titles can be edited into the Timeline like any other clip. Once edited into the Timeline, 
you can edit the title text and position directly in the Timeline Viewer, or you can access its 
controls in the Inspector for further customization.

 — Generators: Generators can also be edited into the Timeline like any other clip. Selecting a generator 
and opening the Inspector lets you access its controls for further customization. You can also choose 
a standard duration for generators to appear within the Editing panel of the User Preferences.

 — Effects: Effects are essentially placeholders in the Timeline that allow for more specialized 
compositing in Fusion, or that let you modify the underlying tracks with an adjustment clip.
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Open FX
DaVinci Resolve supports the use of third-party Open FX filters, transitions, and generators in the 
Edit page. Once you install these effects on your workstation, they appear in this section of the Effects 
Library, organized by type and group depending on the metadata within each effect.

 — Open FX: Exposes all Resolve FX and third-party Open FX installed on your workstation at once.

 — Filters: Contains the Resolve FX filters that ship with DaVinci Resolve, as well as any third-
party OFX plugins you’ve installed on your workstation. Filters can be dragged onto video 
clips to apply an effect to that clip. Once applied, filters can be edited and customized by 
opening the Open FX panel of the Inspector.

 — Generators: Contains any third-party OFX generators you have installed on your workstation. 
Can be edited into the Timeline just like the native generators that ship with DaVinci Resolve, 
but they also expose an Open FX panel next to the Transition panel in the Inspector, where 
you can customize settings that are unique to that transition.

 — Transitions: Contains any third-party OFX transitions you have installed on your workstation. 
OFX transitions can be used similarly to any other transition, but they also expose an Open FX 
panel next to the Transition panel in the Inspector, where you can customize settings that are 
unique to that transition.

Audio FX
On all platforms, DaVinci Resolve supports a set of built-in Fairlight FX, a native audio plugin format 
that makes various audio tools and effects available on macOS, Windows, and Linux. On macOS and 
Windows, DaVinci Resolve supports the use of third-party VST audio plugins, which includes most of 
the professional third-party tools and effects used in the audio postproduction industry. On macOS, 
DaVinci Resolve supports Audio Unit (AU) audio plugins. Once you install these effects on your 
workstation, they appear in this panel of the Effects Library. Audio plugins let you apply effects to 
audio clips or entire tracks’ worth of audio, to add creative qualities such as echo or reverb, or to take 
care of mastering issues using noise reduction, compression, or EQ.

Effects Library Favorites
You can click on the far right of any transition, title, or generator flag that effect with a star as a 
favorite effect. When you do so, the favorited effects appear in a separate Favorites area at the 
bottom of the Effects Library Bin list
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Stars indicate a flagged 
favorite effect; all favorites 
are currently filtered.

Converting Fusion 
Compositions to Edit Effects
If you have created a Fusion Composition that you would like to use across a number of projects, you 
can now save it to the Effects toolbox in the Edit page. This allows easy access to the effect from the 
Edit page, and simple application to video clips in the Timeline.

To convert a Fusion composition to an Edit effect:

1 Export the composition as a macro in Fusion, by right clicking on a node and selecting Create 
Macro from the contextual menu.

2 Save the macro file (.setting) to the following directory: 

 — MacOS: /Library/Application Support/Blackmagic Design/DaVinci Resolve/Fusion/Templates/
Edit/Effects

 — Windows: C:\ProgramData\Blackmagic Design\DaVinci Resolve\Fusion\Templates\Edit\Effects

 — Linux: /opt/resolve/Fusion/Templates/Edit/Effects

The effect will now be available as a drag and drop effect in the “Fusion Effects” section of the toolbox 
in the Effects Library on the Edit page.
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Seeing Effects in the Timeline
When you apply any kind of an effect to a clip in the Timeline, be it an adjustment in the Inspector, a 
speed effect, a plugin you’ve applied, etc., clips with that effect appear a darker shade of whatever 
color they are to show you there’s an effect applied. Removing all effects from a clip (for example, 
using the Remove Attributes command) returns that clip to its original color. This makes it easy to see, 
at a glance, which clips have effects, and which clips don’t.

A clip with effects that’s shaded darker between two other regularly-shaded clips without effects

Using the Inspector
Once you’ve added effects to a timeline, the Effects Inspector is where you can edit their parameters. 
The Inspector is the central area for editing all of the settings relating to filters, compositing, sizing, 
titling, transitions, generators, and effects of all kinds. 

The Inspector displays different 
parameters depending on what 
you’ve selected in the Timeline; 
(left) parameters of a clip, 
(right) parameters of a title.
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Many of the instructions in this section require the use of the Inspector, which can be opened or 
closed by clicking the Inspector button at the far right of the Edit and Cut page toolbars, or by double-
clicking a transition or generator in the Timeline. 

There are three ways that the parameters of clips in the Timeline can be displayed in the Inspector:

 — If no clips are selected in the Timeline, then the clip in the highest auto-select-enabled track that 
intersects the playhead will have its parameters shown in the Inspector.

 — The Inspector always shows the parameters of one or more selected items in the Timeline, which 
will override the clip in the highest track that intersects the playhead, if necessary. Changing the 
selection changes which parameters are displayed, and the parameters you edit in the Inspector 
only alter the currently selected clip. If multiple clips are selected, the Inspector displays “Multiple 
Clips” and allows you to adjust the parameters of all selected clips at the same time.

 — Choosing Timeline > Selection Follows Playhead sets DaVinci Resolve to always select whichever 
clip intersects the playhead in the Timeline. The result is that the Inspector always displays the 
parameters of the clip at the playhead, with the added bonus that the clip at the playhead is also 
selected for other editorial functions. If there are multiple superimposed clips intersecting the 
playhead all at once, the topmost video clip with an enabled Auto Select control will be selected, 
thus exposing its parameters in the Inspector, and all other clips will be ignored.

Inspector Effects Controls
Different Effects clips in the Timeline expose different controls. Whichever panels are exposed, 
parameters within each panel are organized into groups, with a title bar providing the name of that 
group, along with other controls that let you control all parameters within that group at the same time. 

The Effects Inspector controls

These controls include:

 — Enable button: A toggle control to the left of the parameter group’s name lets you disable and re-
enable every parameter within that group at once. Orange means that track’s enabled. Gray is disabled.

 — Parameter group title bar: Double-clicking the title bar of any group of parameters collapses or 
opens them. Even more exciting than that, Option-double-clicking the title bar of one parameter 
group collapses or opens all parameter groups at once.

 — Keyframe and Next/Previous Keyframe buttons: This button lets you add or remove 
keyframes at the position of the playhead to or from every single parameter within the group. 
When the button is highlighted orange, a keyframe is at the current position of the playhead. 
When it’s dark gray, there is no keyframe. Left and right arrow buttons let you jump the playhead 
from keyframe to keyframe for further adjustment.

 — Reset button: Lets you reset all parameters within that group to their default settings.
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Adding Filters to Video Clips
DaVinci Resolve supports both built-in Resolve FX and third-party OFX plugins to create various 
effects. These effects can be applied both to clips in the Edit page, and to nodes in the Color page. 
This section shows how to apply, edit, and remove these filters in the Edit page. For more information 
about using video effects in the Color page, see Chapter 149, “Using Open FX and Resolve FX.” 

For a detailed explanation of each of the Resolve FX plugins that accompany DaVinci Resolve, see 
Part 12, “Resolve FX Overview.”

Methods of applying video filters in the Edit page:

 — To apply a video filter to a clip: 

 — Drag any filter from the Effects Library onto the clip in the Timeline you want to apply it to.

 — Double Click the filter in the Effects Library to apply it to the selected clip.

 — Drag the Filter from the Effects Library to the Inspector to apply it to the selected clip.

 — Drag the Filter from the Effects Library to the Viewer to apply it to the clip being viewed.

 — To apply a video filter to multiple clips: Select all of the clips you want to apply a filter to in the 
Timeline, and then drag any filter from the Open FX category of the Effects Library onto any of the 
selected clips. This is undoable.

Applying a video filter to a single clip in the Timeline
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To edit a clip’s video filters:

 — Select that clip and open the Inspector’s Effects tab. The effects will be further 
sub-grouped by type: Fusion, Open FX, or Audio. If a clip does not have any effects 
assigned to it, this panel will be dimmed.

Resolve FX controls appear in the 
Effects panel of the Inspector.

Turning on the onscreen controls for 
Resolve FX in the Edit page Timeline Viewer

Some video filters have custom onscreen controls that can be modified in the Viewer. 
These can be exposed in the Edit page using the OFX mode of the Viewer.

Once enabled, the OFX onscreen controls appear in the Viewer.

Modifying onscreen controls for Resolve FX in the Edit page Timeline Viewer

Many audio filters expose custom controls that appear in a floating window.
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To expose a filter’s custom controls: 

 — Open the parameters if they’re not open already by double-clicking that filter’s title bar. A button 
should appear at the top of the parameters for filters that have custom UI. Clicking this button 
opens a floating window with all the custom controls. When you’re finished adjusting the custom 
controls, close the window.

The Fairlight FX Noise Reduction custom UI interface

Methods of working with video filters in the Inspector:

 — To rearrange the order of multiple video filters applied to a clip: Click the move up or move 
down buttons in any filter’s title bar, to the left of each filter’s Trash Can button.

 — To disable or re-enable a filter: Click the toggle control at the far left of each filter’s title bar. 
Orange means that track’s enabled. Gray is disabled.

 — To remove a filter: Click the Trash Can button.

 — To reset a filter: Click the Reset button at the far right of the filter’s title bar.

 — To open or collapse a filter’s parameters: Double-click the title bar.

 — To open or collapse the parameters of all filters: Option-click the title bar.

Once applied to a clip, video filters can also be keyframed or automated just like any other Inspector 
setting, to create dynamic effects that change over time.

Render in Place
Render in Place allows you to render and bake in all effects that are applied to a single clip on the Edit 
page Timeline. This command, which only works in the Edit page, creates an entirely new media file 
that replaces the original clip on the Timeline. This new file is created in the same directory as the 
original source file and is added to the Media Pool automatically.

You can use Render in Place to improve the playback performance of a computationally intensive clip, 
or use it to create a new high-quality master media with effects that have been finalized baked in. 
For example, perhaps you have created a clip with a complicated speed ramp, and you want to pass it 
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to another editor or vfx artist in a round-trip rendering scenario, but you are worried about how other 
programs may interpret the speed effects. In this scenario you could render the clip in place at master 
quality, and then render and deliver the program.

Render in Place is not a one way operation. Afterwards, you have the option to “Decompose to 
Original” to bring back the original clip with the original effects, if you need to make a change because 
the clip was not really as finalized as you were hoping.

To Render in Place:

1 Select one or more clips on the Edit Page timeline. Selecting multiple clips results in each clip 
being individually rendered in place, but as a batch operation.

2 Right-click the selection, and choose “Render in Place” from the contextual menu.

3 Choose the appropriate Render Clip Options, and then click the “Render” button.

 — Start Timecode: Sets the starting timecode value for the clip.

 — Format: Selects the media file format.

 — Codec: Selects the video codec.

 — Type: Specifies the compression parameters of the selected codec.

 — Include Handles: Gives you the option to specify the number of frames before and after the 
clip In/Out points to be rendered.

 — Include Video Effects: Turn on this checkbox to bake in all effects that have been applied to 
the clip, such as sizing, Open FX or Resolve FX, and speed effects. Turning this checkbox off 
renders the clip with speed effects baked in, but no other effects applied.

 — Include Fusion Composition: Turn on this checkbox to bake in any compositions 
attached to the clip. 

 — Include Color Grading Effects: Turn on this checkbox to bake in any color grading attached 
to the clip from the Color page.

The Render in Place options

4 Use the File dialog that appears to choose where you want to save the resulting media. Choose a 
location and click Open. 

A progress bar appears to show you how long this will take. When finished, your new media is 
saved in the designated location, added to the Media Pool, and will replace each corresponding 
source clip on the Timeline.
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If you’ve used Render in Place and end up having buyer’s remorse, or a late-breaking change comes 
back to you later, you can easily decompose to the original clip with its editable effects to make 
the change.

To Decompose to Original:

1 Select one or more clips that have already been Rendered in Place, on the Edit Page timeline. 

2 Right-click the selection, and choose “Decompose to Original” from the contextual menu.

The original clip, along with all of its editable effects, will be returned to the Timeline. The new 
media created in the Render in Place process will not be deleted from the source folder, nor will it 
be removed from the Media Pool. It is effectively a new clip.

Adjusting Multiple Clips 
at the Same Time
There’s an easy way to make adjustments to the Inspector parameters of multiple clips at the same 
time, without needing to use Paste Attributes (described later in this chapter). All you need to do is 
simultaneously select every clip you want to alter, and then modify the parameter in the Inspector that 
you want to change. As a result, every selected clip will be adjusted by the same amount. This works 
for compositing effects, transforms, text parameters, filters, and audio settings, just about anything 
that can be simultaneously exposed in the Inspector for multiple selected clips.

When you select multiple clips, the Inspector will display “Multiple Clips” as the title. If each of the 
selected clips have different values in the parameter you’re adjusting, that parameter will have two 
dashes in the value field. There are two ways you can make adjustments to multiple clips:

 — If you want to make a relative adjustment to all selected clips while keeping their original offsets 
from one another, then drag the virtual slider in the parameter field which will display a + or – 
before however many units your adjustment is.

 — However, if you want to set all selected clips to the same value, you can double-click in the number 
field, type the value, and press Return.

Making a relative adjustment of plus 4.9 
in the Rotation Angle of all selected clips
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Adjustment Clips
You can also apply all sorts of effects to multiple clips in the Timeline using Adjustment clips, available 
from the Effects bin of the Toolbox in the Effects Library. When an Adjustment Clip is superimposed 
above one or more clips in the Timeline, any filters or other effects that are applied to the Adjustment 
clip are also applied to all clips underneath it. 

Adjustment clips can be used to apply the following types of effects:

 — Resolve FX and Open FX plugins

 — Inspector parameters including Composite, Transform, Cropping, and Dynamic Zoom

 — Fusion page effects

 — Color page grading and sizing

Adjustment clips are a fast and easily revised way to apply one or more effects and grades to a 
range of clips. Adjustment clips that are difficult to playback in real time can be rendered to cache, 
just like any normal video clip. Adjustment Clips can be named using the Inspector. To store an 
Adjustment clip, simply drag it from the Timeline to the Media Pool. You can then manage the 
Adjustment clip just like any other media type. 

An Adjustment clip applying a Prism Blur Resolve FX’s vignette to two other clips
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Paste Attributes
You can copy and paste video and audio attributes, as well as color corrections, from one clip to 
multiple clips using the Paste Attributes command. This is a fast way to apply video and audio 
adjustments and effects from one clip to many others in the Timeline.

To copy attributes:

1 Select a clip with attributes you want to apply to other clips, and press Command-C.

2 Select one or more other clips to paste to.

3 Choose Edit > Paste Attributes (Option-V), or right-click one of the selected clips and choose Paste 
Attributes from the contextual menu.

4 When the Paste Attributes window appears, click the checkboxes of each of the attributes you 
want to paste, and click Apply when you’re done.

The Paste Attributes window

The Paste Attributes window shows you the clip you’re copying from and the clip(s) you’re pasting to at 
the top, and provides checkboxes you can use to select which attributes you’d like to paste. 

Keyframe Options for Pasting Keyframed Attributes
A pop-up menu below lets you choose how you’d like to apply any keyframes that are part of the 
attributes being pasted; the options are Maintain Timing or Stretch to Fit.

Option to Ripple the Timeline 
for Pasting Speed Effects
When using Paste Attributes to copy speed effects from one clip to another, the Ripple Sequence 
checkbox lets you choose whether or not the pasted speed effect will ripple the Timeline.
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Remove Attributes
You can also eliminate specific attributes from one or more clips, using a window that’s the opposite of 
the Paste Attributes window.

The Remove Attributes window

To remove attributes:

1 Select one or more other clips that have effects you want to remove.

2 Choose Edit > Remove Attributes, or right-click one of the selected clips and choose Remove 
Attributes from the contextual menu.

3 When the Remove Attributes window appears, the checkboxes of effects that can be removed are 
enabled, so turn on attributes you want to remove.

4 (Optional) If one of the attributes you’re removing is a retime effect, use the Ripple Sequence 
checkbox to choose whether or not the Timeline will ripple as a result.

5 Click Apply when you’re done.
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Chapter 47

Using Transitions
Transitions are the connective tissue binding together moments 
requiring a more significant way of changing from one image to the 
next than a simple cut. 

This chapter shows the many ways you can add and edit transitions in your program.
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Working With Transitions
Transitions provide another way of bridging the change from one clip to another, and are often used 
to indicate a change in time or location when changing scenes. DaVinci Resolve supports a variety 
of transitions ranging from various forms of the traditional cross dissolve to different types of wipes, 
allowing for great flexibility when finishing creative edits. In addition, DaVinci Resolve supports 
third-party OpenFX transitions that you install on your system. Transitions are applied at edit points, 
and appear as editable objects in the Timeline.

Video and audio transitions in the Timeline

Previewing Transitions
To preview a transition before you place it into the Timeline, ensure that “Hover Scrub Preview” is 
checked in the Transitions option menu, then simply hover your pointer over any transition in the 
Transitions tab (Cut page) or Effects Library Toolbox (Edit page) and move it across the thumbnail. 
The transition will preview in the Viewer using the two clips nearest the smart indicator in the Cut 
page, or the two clips nearest the playhead in the Edit page.

Scrubbing over a Transition Thumbnail previews the transition in the Viewer.
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Adding and Editing Transitions
The following procedures describe how to work with add and edit transitions in the Timeline using 
both the mouse and keyboard shortcuts.

Methods of adding transitions using the mouse:

 — To add a transition by dragging it from the Effects Library: Drag a video transition from the 
Effects Library to an edit point in the Timeline so that it’s centered at, ends at, or starts at the edit 
point. If there is no overlap between the heads and tails of the two clips, you may not be able to 
add a transition where you want.

 — To add a transition by double-clicking its icon in the Effects Library: Double click a transition’s 
icon in the Effects Library to apply that transition to the edit point indicated by the smart indicator 
(Cut page), or at the end of the clip that is currently under the playhead (Edit page).

 — To add a transition by clicking the Transition Alignment icons: In the Cut page, at the bottom 
of the Transitions Library, are three Transition Alignment icons. Clicking any of these icons applies 
the selected transition to the edit point indicated by the smart indicator, with the specified 
alignment.

 — To add a transition using the Effects Library contextual menu: Select one or more edit points 
(one per track), then right-click a video transition in the Effects Library and choose Add to Selected 
Edit Points. That transition will be added to every selected edit point at once.

The Transition contextual menu in the Effects Library

 — To add a transition using the Edit Point contextual menu: In the Edit page, right-click any edit 
point between clips with overlapping handles, and choose one of the four durations available for 
the standard transition; the available choices are quarter-second, half-second, one second, and 
two seconds, expressed in frames at whatever the current frame rate of the Timeline is.

The Transition contextual menu for an edit in the Timeline
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Methods of adding transitions using keyboard shortcuts:

 — To add a video+audio transition using the keyboard: Select one or more edit points using 
the Selection tool, or move the playhead near an edit you want to select and press V to select it, 
then press Command-T  (Timeline > Add Transition) to add the standard transition. Transitions 
are added using the “Standard transition duration” as specified in the Editing panel of the User 
Preferences, which defaults to one second, or however long the overlapping handles of the 
selected edit point allow.

 — To add a video or audio-only transition using the keyboard: Select one or more edit points, 
and press Option-T (Timeline > Add Video Only Transition) to add only a video transition, or Shift-T 
(Timeline > Add Audio Only Transition) to add only an audio transition. Transitions are added using 
the “Standard transition duration” as specified in the Editing panel of the User Preferences, which 
defaults to one second, or however long the overlapping handles of the selected edit point allow.

 — To add a transition with specific alignment using the keyboard: Select an edit, press the U 
key to choose the start, center, or end of the edit, then press Command-T. The standard transition 
will be added with its alignment based on the edit selection; selecting the start of the edit places a 
transition that ends on the edit; selecting the end of the edit places a transition that starts on the 
edit, and choosing the center of the edit places a transition that is similarly centered.

Methods of moving and duplicating transitions:

 — To move a transition from one edit to another: Select a transition, then drag it to another edit point.

 — To copy a transition from one edit to another: Select a transition, then option-drag it 
to another edit point.

 — Copying a transition from one edit to multiple edit points:

 — Right-Click on the transition you want to duplicate, and select copy (or hit Command-C). 

 — Hold down the Command-Key, and select all the edit points in the Timeline you want to copy 
the transition to, so they’re highlighted green. Release the Command-Key.

 — Right-Click on any one of the green highlighted edit points, and select Paste (or hit 
Command-V) to duplicate the selected transition to all selected edit points.

Methods of altering transitions in the Timeline:

 — To change a transition’s type: Drag a different transition from the Effects Library onto the 
current one in the Timeline.

 — To change a transition’s duration: Drag the beginning or end of the transition in the Timeline 
to be longer or shorter symmetrically about the current edit. Alternately, you can do one 
of the following:

 — Right-click any transition and select Change Transition Duration, or select the transition and 
press Command-D, then alter the duration in the dialog that appears, and click Change.

 — Double-click any transition to open it in the Inspector, and set a new duration in seconds or frames.

 — Click and drag a transition’s edge on the Timeline to alter its duration. Holding down the 
Command key while you drag allows you to adjust the duration of just one side of the transition. 

 — To change a transition’s alignment: Right-click a transition in the Timeline and choose a new 
method of alignment from the contextual menu. Alternately, you can double-click any transition to 
open it in the Inspector, and choose a new option from the Alignment drop-down.

 — To remove a transition: Select a transition in the Timeline and press the Delete key. Or, right-click 
a transition in the Timeline and choose Delete from the contextual menu.
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Adding Transitions When 
There’s Not Enough Handles
If the outgoing and incoming overlapping handles at a given edit point don’t have enough frames 
to fit the standard transition duration, and you try to add a transition by selecting one or more edit 
points and pressing Command-T, or by right-clicking an edit point and using the transition options in 
the resulting contextual menu, then you’ll be presented with a dialog that gives you three choices:

 — Trim Clips: You can automatically trim the incoming and outgoing sides of each selected edit 
point to create the overlap needed for adding the standard transition.

 — Skip Clips: Don’t add transitions to the selected edit points that lack the appropriate overlap.

 — Cancel: Cancel the operation entirely.

Adding Transitions By Dragging 
to Create Overlap
There’s another method you can use to create transitions that makes it easy to create transitions while 
you’re doing drag and drop editing by simply overlapping the beginning and end of two clips where 
you want a transition to appear. Just press and hold the Option and Shift keyboard modifiers together 
while you drag a clip or edit to create overlap with another clip. You can do this in three ways:

 — Select the In or Out point of a clip, then press and hold Option-Shift down and drag the selected 
edit point to overlap a neighboring clip where you want to create a transition.

Creating a transition by Option-Shift 
dragging an edit point to create 
an overlap between two clips

 — Select a clip, then press and hold Option-Shift down and drag the entire clip to overlap a 
neighboring clip where you want to create a transition.

Creating a transition by Option-Shift 
dragging a whole clip to create an 
overlap between it and another clip
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 — Hold the Option-Shift keys down while you drag a clip from the Media Pool to overlap a clip that’s 
already in the Timeline.

Creating a transition by Option-Shift 
dragging a clip from the Media Pool 
to overlap a clip in the Timeline

Transition Properties in the Inspector
Double-clicking a transition in the Timeline opens that Transition tab in the Inspector. Each transition 
has the following properties you can edit.

 — Transition Type: The currently selected transition. You can change to any other installed 
transition by selecting one in the drop-down menu. 

 — Duration: The duration of the transition, shown in both seconds and frames.

 — Alignment: A drop-down that lets you choose the transition’s position relative to the edit point it’s 
applied to. Your choices are “Start on Edit,” “Center on Edit,” and “End on Edit.”

Additional properties that are specific to each type of transition appear in another group below. 
Since the Cross Dissolve transition is the most common transition used, its properties will be shown as 
an example.

 — Style: The different Dissolve transitions (Cross Dissolve, Additive Dissolve, and so on) expose this 
drop-down that lets you choose different ways for the outgoing clip to blend into the incoming 
clip during the dissolve. There are six different options to choose from:

 — Video: A simple linear dissolve; the outgoing clip fades out as the incoming clip fades in.

 — Film: A logarithmic dissolve, simulating film dissolves as created by an optical printer.

 — Additive: The outgoing and incoming clips are cross faded using the Additive composite 
mode. As a result, the transition seems to brighten at the halfway point.

 — Subtractive: The outgoing and incoming clips are cross faded using the Subtractive 
composite mode. As a result, the transition seems to darken at the halfway point.

 — Highlights: The outgoing and incoming clips are cross faded using the Lighten composite 
mode. The lightest parts of each clip are emphasized during this transition.

 — Shadows: The outgoing and incoming clips are cross faded using the Darken composite 
mode. The darkest parts of each clip are emphasized during this transition.

 — Start Ratio: Defines the percentage of completion for the transition at its first frame, from 0 
to 100 percent. Setting the Start Ratio to anything but 0 results in the transition immediately 
appearing at a more fully cross-dissolved state from the very first frame.
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 — End Ratio: Defines the percentage of completion for the transition at its last frame. Setting the 
End Ratio to anything but 0 results in the transition never fully dissolving to the incoming shot at 
its last frame.

 — Reverse: Reverses the transition. This parameter is disabled for Dissolve transitions.

 — Ease: A drop-down that lets you apply nonlinear acceleration to the beginning, ending, or overall 
duration of a transition. The result is to add inertia to the transition from the outgoing clip to the 
incoming clip, and providing a gentler change from each clip into and out of the transition.

 — None: The outgoing clip fades away to the next shot in a linear fashion.

 — In: The outgoing clip lingers as the beginning of the transition dissolves more slowly 
than the end.

 — Out: The outgoing clip fades away more quickly, as the beginning of the transition dissolves 
more quickly than the end.

 — In & Out: Both the outgoing and incoming clips make slower transitions at the beginning and 
end of the dissolve, but the very center of the transition is faster as a result.

 — Custom: Lets you modify the parameters of the fade manually using the Transition 
Curves below.

 — Transition Curve: Allows you to manually set keyframes controlling the progress of the transition 
along its duration.

Other types of transitions display properties that are specific to that transition’s particular effect. 
These are described at length in the following section.

Using Transition Curves in the Edit Page
You can create even more highly customized transition effects using the transition curve associated 
with each transition you add to the Timeline. Clicking the button at the bottom-right corner of a 
transition in the Timeline reveals a Keyframe Editor, and clicking the Curve Editor button in the 
Keyframe Editor track for the transition reveals the Transition Curve Editor.

A transition curve opened underneath a Cross Dissolve transition
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The Transition Curve Editor works identically to the Curve Editor you can access from any clip, except 
instead of using the curve to animate image transforms, you use the curve to retime the transition. 
Combined with eased or bezier keyframes at the beginning and end of a transition curve, you can 
create transitions that slowly start and quickly end, quickly start and slowly end, or any variation your 
project requires. A graphical representation of the curve appears as a shaded area on the transition 
itself in the Timeline.

Methods of editing a transition curve:

 — To change the interpolation of a control point: Click the control point you want to edit, and 
then click one of the four Bezier interpolation buttons in the Curve Editor title bar. Adding Bezier 
handles to a transition control point lets you create an eased transition. If you chose an option 
from the Ease drop-down of the Transition Properties in the Inspector, one or both of the 
transition curve keyframes may already be set to Bezier.

 — To adjust a Bezier handle: Drag the Bezier handle in any direction to alter the curve. Whenever 
you customize Bezier handles on a transition curve, the Ease drop-down of the Transition 
Properties in the Inspector changes to Custom.

 — To add a new control point to a curve: Option-click anywhere on a curve to add a new 
control point.

 — To drag a control point on a curve: Click any control point and drag left or right to retime it, 
and up or down to change the value of the control point. Once you begin to move the pointer, the 
control point is constrained in that direction.

 — To delete a control point from a curve: Right-click a keyframe and choose Delete Selected from 
the contextual menu. You cannot delete the last two control points of a transition curve.

 — To turn a curve on and off: Clicking the white dot at the upper left-hand corner of the Keyframe 
Editor lets you turn a transition curve’s effect on and off, without disabling the transition. When 
you turn the keyframes off, the transition defaults to a linear transition with no easing.

Favorite Transitions
While DaVinci Resolve provides a wide variety of transitions by default, most editors typically only use 
a subset of these in their day-to-day work. Also, it’s typical to save customized versions of a particular 
transition in order to reuse that specific set of transition settings over and over again.

To set a transition or other effect as a favorite in the Effects Library: 

 — Move the pointer over any transition, and click the star button when it appears to set that 
transition as a favorite. Click any transition’s star to “un-favorite” it. Favorites are displayed in the 
Favorites area of the Effects Library bin list in the Edit page, or the Favorites tab in the Transitions 
panel in the Cut page. 

Changing the Standard Transition
Different projects may require different transitions be used as the standard transition. DaVinci Resolve 
gives you several tools for dealing with this.
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To change the standard transition:

 — Right-click any transition or effect and choose “Set as Standard Transition.” The standard transition 
appears with an orange indicator to the left of its name in the Effects Library.

 

The Effects Library open in the Edit page, showing starred 
transitions that have been favorited, and the standard 
transition with an orange indicator to the left of its name

The Transitions tab open in the Cut page, showing starred transitions that have been 
favorited, and the standard transition with an orange indicator to the left of its name

To change the standard transition duration:

 — Open the Editing panel of the User Preferences, and change the “Standard transition duration” 
setting (there are controls for setting the duration in either Seconds or Frames). Click Save when 
you’re finished.
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Creating Transition Presets
If you find yourself using a particular transition that’s customized in a particular way over and over 
in your work, you can create a Preset of that transition for easy recall. Once saved, Presets can be 
favorited or set to be the Standard Transition to make them more easily available.

To save a transition preset for future use:

1 Add a transition to the Timeline, then double-click it to open it in the Inspector to adjust its 
settings to be the way you need it to be.

2 (Optional) if necessary, open the transition’s Curve Editor and set the type of curve you want the 
transition to have. A customized transition curve will be saved inside of that transition’s preset.

3 Right-click on the transition you want to save, and choose Create Transition Preset. 

4 Type a name for the transition preset in the dialog that appears, and click OK. That transition is 
saved to the User section at the bottom of the Toolbox Video Transitions area, where you can 
apply it just like any other transition.

To remove a transition preset:

 — Right-click any preset and choose Delete Transition Preset.

Changing Transitions to 
Fusion Compositions
If you need to create a more complex transition than you can get from the Inspector, it is now possible 
to change any transition to a Fusion Composition on the Edit page Timeline.

To convert a Resolve transition to a Fusion composition:

1 Add a transition between two clips on your Timeline.

2 Right-click on the transition and select “Convert to Fusion Cross Dissolve.”

3 Right-click on the transition again and select “Open in Fusion Page.”

A new Fusion composition opens with the base Cross Dissolve nodes and tools already set. You now 
can use all of the powerful tools in the Fusion page to customize your transition.

The node tree you start with after converting a transition to a Fusion cross dissolve
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Video Transitions
The following are transitions that are available within DaVinci Resolve by default, along with the 
parameters that are available for each of them from the Inspector:

Dissolve
A dissolve in the visual language of film generally denotes a passage of time or place. It indicates to 
your audience that one scene has ended and another is beginning.

 — Additive Dissolve: Style lets you choose what type of cross dissolve you want; choices include: 
Video, Film, Additive, Subtractive, Highlights, Shadows. Start Ratio lets you adjust how far along 
the transition is when it first begins. End Ratio lets you adjust how far the transition gets at the 
very end. The Reverse checkbox reverses the direction of the transition.

 — Blur Dissolve: Horizontal/Vertical Strength sets how much blur is performed in the X and Y 
dimensions during the course of this transition. Start Ratio lets you adjust how far along the 
transition is when it first begins. End Ratio lets you adjust how far the transition gets at the very 
end. The Reverse checkbox reverses the direction of the transition.

 — Cross Dissolve: Style lets you choose what type of cross dissolve you want; choices include: Video, 
Film, Additive, Subtractive, Highlights, Shadows. Start Ratio lets you adjust how far along the 
transition is when it first begins. End Ratio lets you adjust how far the transition gets at the very 
end. The Reverse checkbox reverses the direction of the transition.

 — Dip to Color Dissolve: Start Ratio lets you adjust how far along the transition is when it first 
begins. End Ratio lets you adjust how far the transition gets at the very end. The Reverse 
checkbox reverses the direction of the transition. Color lets you choose what color the dissolve 
dips to at the midpoint.

 — Non-Additive Dissolve: Start Ratio lets you adjust how far along the transition is when it 
first begins. End Ratio lets you adjust how far the transition gets at the very end. The Reverse 
checkbox reverses the direction of the transition.

 — Smooth Cut: A special-purpose transition designed to make short jump cuts in the middle of a 
clip less noticeable. This is done by using optical flow processing to match the same features on 
either side of a cut in order to automatically morph a subject from one position to another over 
the duration of the transition.

A Mode drop-down menu provides two options: Faster and Better. The Better option is default, 
with excellent quality and the capability of preserving the motion of subjects for the duration of 
the transition. The Faster option is the original Smooth Cut method, which morphs between stills 
of the outgoing and incoming frames. In most practical circumstances, the Better mode will give 
you a superior result, but certain cuts or effects may be better addressed with the Faster option. 

The Smooth Cut effect works best on clips such as sit-down interviews and close-up head shots 
with a minimum of background and subject motion, and where the subject’s position on either 
side of the cut is not significantly different. A good example of when Smooth Cut is effective is 
when you’re cutting pauses, partial repeats, filler sounds such as “um” or “you know,” or other 
speech disfluencies out of an interview clip to tighten the dialog, and you want to eliminate the 
little “jump” that occurs at the cut without having to cut away to B-roll. Applying a short two or 
four frame Smooth Cut transition to the edit can make this kind of edit invisible, as long as the 
speaker doesn’t change position significantly during the cut. The more motion there is in the 
background of the shot, and the more the speaker changes position, the harder it will be to get 
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a useful result using Smooth Cut. Although the default duration for any transition is one second, 
you’ll find that Smooth Cut transitions work much better when they’re short; 2- to 6-frame Smooth 
Cut transitions often work best to disguise jump cuts.

Iris
Irises are directional transitions that are commonly used to both call attention to a specific part of the 
frame and indicate to the audience that one scene has ended and another begun. Irises were widely 
used in the silent film era instead of the more technically complicated dissolve.

 — Arrow Iris: Color sets the color of the border, if there is one. Border sets the width of the border, 
in pixels, with 0 creating no border. Aspect Ratio allows you to change the proportions of the 
shape. Offset to center lets you alter the center point at which this transition is positioned. 
Rotation changes the angle of the iris. Feather is a checkbox that, when turned on, uses the 
Border slider to determine the amount of feathering at the edge of the transition. The Reverse 
checkbox reverses the direction of the transition. 

Preset lets you choose one of the following presets:

 — Arrow Up

 — Arrow Down

 — Arrow Left

 — Arrow Right

 — Cross Iris: Color sets the color of the border, if there is one. Border sets the width of the border, 
in pixels, with 0 creating no border. Offset to Center identifies the center point at which the cross 
wipe begins, as X and Y coordinates on the screen. Feather is a checkbox that, when turned on, 
uses the Border slider to determine the amount of feathering at the edge of the transition. The 
Reverse checkbox reverses the direction of the transition.

 — Diamond Iris: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Offset to Center identifies the center point at which 
the diamond-shaped wipe begins, as X and Y coordinates on the screen. Feather is a checkbox 
that, when turned on, uses the Border slider to determine the amount of feathering at the edge of 
the transition. The Reverse checkbox reverses the direction of the transition.

 — Eye Iris: Color sets the color of the border, if there is one. Border sets the width of the border, 
in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the Border 
slider to determine the amount of feathering at the edge of the transition. The Reverse checkbox 
reverses the direction of the transition.

 — Hexagon Iris: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Aspect Ratio allows you to change the proportions 
of the shape. Offset to center lets you alter the center point at which this transition is positioned. 
Rotation changes the angle of the iris. Feather is a checkbox that, when turned on, uses 
the Border slider to determine the amount of feathering at the edge of the transition. The 
Reverse checkbox reverses the direction of the transition. Preset lets you choose one of the 
following presets:

 — Hexagon

 — Hexagon Vertical
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 — Oval Iris: Color sets the color of the border, if there is one. Border sets the width of the border, in 
pixels, with 0 creating no border. Offset to Center identifies the center point at which this circular 
wipe begins, as X and Y coordinates on the screen. Oval Ratio changes the aspect ratio of the 
oval, making it either wider or taller. Feather is a checkbox that, when turned on, uses the Border 
slider to determine the amount of feathering at the edge of the transition. The Reverse checkbox 
reverses the direction of the transition.

 — Pentagon Iris: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Aspect Ratio allows you to change the proportions 
of the shape. Offset to center lets you alter the center point at which this transition is positioned. 
Rotation changes the angle of the iris. Feather is a checkbox that, when turned on, uses the 
Border slider to determine the amount of feathering at the edge of the transition. The Reverse 
checkbox reverses the direction of the transition. Preset mode lets you choose one of the 
following presets:

 — Pentagon Up

 — Pentagon Down

 — Square Iris: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Aspect Ratio allows you to change the proportions 
of the shape. Offset to center lets you alter the center point at which this transition is positioned. 
Rotation changes the angle of the iris. Feather is a checkbox that, when turned on, uses the 
Border slider to determine the amount of feathering at the edge of the transition. The Reverse 
checkbox reverses the direction of the transition. Preset mode lets you choose one of the 
following presets:

 — Square Flat

 — Square Point

 — Triangle Iris: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Aspect Ratio allows you to change the proportions 
of the shape. Offset to center lets you alter the center point at which this transition is positioned. 
Rotation changes the angle of the iris. Feather is a checkbox that, when turned on, uses the 
Border slider to determine the amount of feathering at the edge of the transition. The Reverse 
checkbox reverses the direction of the transition. Preset mode lets you choose one of the 
following presets:

 — Triangle Up

 — Triangle Bottom

 — Triangle Left

 — Triangle Right

Motion
Motion transitions use the movement of the frames to impart simulated physical momentum to the 
transition between the outgoing and incoming clips.

 — Barn Door: Color sets the color of the border, if there is one. Border sets the width of the border, 
in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the Border 
slider to determine the amount of feathering at the edge of the transition. Motion Blur smooths 
out the motion of the transition between frames. The Reverse checkbox reverses the direction of 
the transition. Preset mode lets you choose one of the following presets:
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 — Barn Door Vertical

 — Barn Door Horizontal

 — Push: Color sets the color of the border, if there is one. Border sets the width of the border, 
in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the 
Border slider to determine the amount of feathering at the edge of the transition. Motion Blur 
smooths out the motion of the transition between frames. Preset mode lets you choose one of 
the following presets:

 — Push Left

 — Push Right

 — Push Up

 — Push Down

 — Slide: Direction determines whether or not the incoming clip slides in or the outgoing clip 
slides out. Color sets the color of the border, if there is one. Border sets the width of the border, 
in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the 
Border slider to determine the amount of feathering at the edge of the transition. Motion Blur 
smooths out the motion of the transition between frames. Preset mode lets you choose one of 
the following presets:

 — Slide, Left-Right

 — Slide, Right-Left

 — Slide, Bottom-Up

 — Slide, Top-Down

 — Slide, Top-Left

 — Slide, Bottom-Right

 — Split: Color sets the color of the border, if there is one. Border sets the width of the border, 
in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the 
Border slider to determine the amount of feathering at the edge of the transition. Motion Blur 
smooths out the motion of the transition between frames.

Shape
Shape transitions use geometrical outlines to define the transition from the outgoing to the incoming 
clip. Ideally the shape used will be motivated by the content of the scenes involved.

 — Box: Color sets the color of the border, if there is one. Border sets the width of the border, in 
pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the Border 
slider to determine the amount of feathering at the edge of the transition. The Reverse checkbox 
reverses the direction of the transition. Box mode lets you choose one of the following options:

 — Upper Left

 — Upper Right

 — Lower Left

 — Lower Right

 — Left Center

 — Top Center
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 — Right Center

 — Bottom Center

 — Heart: Color sets the color of the border, if there is one. Border sets the width of the border, 
in pixels, with 0 creating no border. Aspect Ratio allows you to change the proportions of the 
shape. Offset to Center identifies the center point at which this circular wipe begins, as X and Y 
coordinates on the screen. Rotation changes the angle of the shape. Feather is a checkbox that, 
when turned on, uses the Border slider to determine the amount of feathering at the edge of the 
transition. The Reverse checkbox reverses the direction of the transition.

 — Star: Color sets the color of the border, if there is one. Border sets the width of the border, 
in pixels, with 0 creating no border. Aspect Ratio allows you to change the proportions of the 
shape. Offset to Center identifies the center point at which this circular wipe begins, as X and Y 
coordinates on the screen. Rotation changes the angle of the shape. Feather is a checkbox that, 
when turned on, uses the Border slider to determine the amount of feathering at the edge of the 
transition. The Reverse checkbox reverses the direction of the transition. Preset lets you choose 
one of the following options:

 — 4-Point Star

 — 5-Point Star

 — 6-Point Star

 — Triangle Left: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the 
Border slider to determine the amount of feathering at the edge of the transition. The Reverse 
checkbox reverses the direction of the transition.

 — Triangle Right: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the 
Border slider to determine the amount of feathering at the edge of the transition. The Reverse 
checkbox reverses the direction of the transition.

Wipe
Wipe transitions are intended to preserve the continuity of motion between two clips. They do this by 
matching the overall movement and direction of the subjects across the outgoing and incoming clips.

 — Band Wipe: Color sets the color of the border, if there is one. Border sets the width of the border, 
in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the Border 
slider to determine the amount of feathering at the edge of the transition. The Reverse checkbox 
reverses the direction of the transition. Preset lets you choose one of the following presets:

 — Horizontal

 — Vertical

 — Horizontal Bilinear

 — Vertical Bilinear

 — Center Wipe: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Angle specifies the angle of the wipe as it emerges 
from the middle of the screen. Feather is a checkbox that, when turned on, uses the Border 
slider to determine the amount of feathering at the edge of the transition. The Reverse checkbox 
reverses the direction of the transition.
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 — Clock Wipe: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Angle specifies the starting angle of the wipe as it 
spins around the center of the screen. The Clockwise checkbox sets the direction of the clock 
wipe. Feather is a checkbox that, when turned on, uses the Border slider to determine the 
amount of feathering at the edge of the transition. The Reverse checkbox reverses the direction 
of the transition.

 — Edge Wipe: Color sets the color of the border, if there is one. Border sets the width of the border, 
in pixels, with 0 creating no border. Angle specifies the angle of the wipe as it moves across the 
screen. Feather is a checkbox that, when turned on, uses the Border slider to determine the 
amount of feathering at the edge of the transition. The Reverse checkbox reverses the direction of 
the transition.

 — Radial Wipe: Color sets the color of the border, if there is one. Border sets the width of the 
border, in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the 
Border slider to determine the amount of feathering at the edge of the transition. The Reverse 
checkbox reverses the direction of the transition.

 — Spiral Wipe: Color sets the color of the border, if there is one. Border sets the width of the border, 
in pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the Border 
slider to determine the amount of feathering at the edge of the transition. The Reverse checkbox 
reverses the direction of the transition.

 — Venetian Blind Wipe: Color sets the color of the border, if there is one. Border sets the width of 
the border, in pixels, with 0 creating no border. Repeat specifies how many “blinds” appear within 
the wipe effect. Angle specifies the angle of this multi-wipe effect. Feather is a checkbox that, 
when turned on, uses the Border slider to determine the amount of feathering at the edge of the 
transition. The Reverse checkbox reverses the direction of the transition.

 — X Wipe: Color sets the color of the border, if there is one. Border sets the width of the border, in 
pixels, with 0 creating no border. Feather is a checkbox that, when turned on, uses the Border 
slider to determine the amount of feathering at the edge of the transition. The Reverse checkbox 
reverses the direction of the transition.

User Transitions
Any transition presets you’ve created are stored in the User category. These are the only transitions 
that can be deleted.

Fusion Transitions
The Fusion Transitions section of the Transitions panel contains Fusion effects that have been made 
into reusable transitions. Fusion Transitions work like any other transition. Once edited into the 
Timeline, they can be edited like any other transition, and when selected, they expose customizable 
parameters in the Inspector that let you tailor their effect to meet your needs.

However, Fusion Transitions are highly customizable. Simply right-click a Fusion Transition and choose 
Open in Fusion Page to expose all of the Fusion nodes that create that transition’s effect, enabling 
you to rebuild it to do whatever you need. When you go back to the Edit page, that transition is 
automatically saved.
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Furthermore, if you know how to create effects in Fusion, you can create your own Transitions by 
making Fusion Macros and saving them to the Effects Library, so they appear in the Fusion Transitions 
section of the Effects Library. For more information on how to do this, see Chapter 68, “Node Groups, 
Macros, and Fusion Templates.”

 — Brightness Flash: Ramps up brightness as it transitions between the two clips. Brightness 
controls the luminance level of the flash. Saturation controls the saturation of the flash. 

 — Camera Shake: Performs a shaking of the frames with color channel separation as a transition. 
Shake Speed controls how fast the shaking is. Shake Strength controls how large the shakes are. 
Contrast, Brightness and Saturation control their respective parameters on the transition.

 — Circles: Transitions between two frames using concentric circles. Circle Color chooses the 
transition color. Red, Green, Blue, and Alpha control the relative strengths of each channel. Circle 
Thickness lets you adjust the width of the circles.

 — Crash Zoom: Performs two rapid zoom-ins on the clips as a transition. 

 — Cross Dissolve: Dissolves between two clips. This is the base Fusion transition to use if you want 
to create your own custom transition in Fusion.

 — Drop Warp: Creates a virtual water drop to transition between the two clips. Warp Scale adjusts 
the amount of image warping to the drop.

 — Fall and Bounce: The trailing clip falls into the frame and bounces as a transition. Fall Angle 
controls the direction of the fall-in.

 — Film Strip: Performs a zoom of a moving virtual film strip as a transition between the two clips. 
Color selects the color of the film base. Red, Green, Blue, and Alpha control the relative strengths 
of each channel.

 — Flip 3D: Performs a simple rotation between the sides of a plane as a transition.

 — Foreground Wipe: Performs a zoomed-in column wiping across the frame as a transition. Invert 
Wipe changes the direction of the wipe. Shadow Softness controls the “depth” of the column. 
Border Width controls the width of the column.

 — Glitch: Performs a digital breakup of the image as a transition. Best used in very short durations 
of a few frames.

 — Noise Dissolve: Uses Fusion’s FastNoise tool as a transition. You can store up to 6 versions of 
this transition. Mix controls the dissolve’s progress through the frame. Type controls the direction 
the noise emanates from. Softness controls the feathering of the border between the two clips. 
Animation controls the speed of the noise changes. Border allows you to set a colored border on 
the boundary of the noise between the two clips.

 — Paint On: This performs virtual paint brush strokes as a transition. Shadow Blend controls the 
“depth” of the strokes. This transition is best used in longer durations.

 — Pan (Down, Left, Right, Up): This performs mirrored images in motion as a transition. 
The direction of the motion is respective of which transition you choose.

 — Rotate: This performs a combination of counterclockwise 180 degree rotation and 
dissolve as a transition.

 — Rotate 90: This performs a combination of counterclockwise 90 degree rotation and 
dissolve as a transition.

 — Round and Down: This performs a counterclockwise rotation around a central pivot point as it 
dissolves between two clips.
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 — Slice Push: Performs a transition consisting of several columns sliding out and pushing across 
the two clips. Slices control the number of columns. Angle lets you set the angle of the columns. 
Shadow sets the strength of the column’s drop shadow. Shadow Softness controls the spread of 
the drop shadow. Shadow Offset controls the angle of the shadow.

 — Slide (Down, Left, Right, Up): Performs a mirrored slide in the direction indicated. The Curve 
control lets you set the following animation curve options:

 — Linear

 — Easing

 — Custom

 — Tunnel of Light: Performs a glowing transition where the first clip is sucked into a point, then the 
second clip expands from that same point. Contrast lets you determine the contrast of the light 
rays. Glow Gain controls the glow’s brightness. Glow Size controls the amount of glow. Glow Red, 
Green, and Blue allow you to change the color of the glow.

 — Warp: Performs a warping transition like a water circling a drain between the two clips.

 — Zoom In: Performs a transition that zooms in and blends the two clips together. Zoom Scale 
controls the strength of the zoom (a negative value zooms out instead of in). Zoom Center allows 
you to set the point around which the zoom occurs. The Curve control lets you set the following 
animation curve options:

 — Linear

 — Easing

 — Custom

 — Zoom In and Out: Performs a transition that zooms in on the first clip blended with a zoom out 
on the second clip. Zoom Scale controls the strength of the zoom. Zoom Center allows you to set 
the point around which the zoom occurs.

Resolve FX Transitions
Resolve FX Transitions are stylized graphical transitions that are more computationally intensive than 
the standard wipes and dissolves.

Burn Away Transition
This transition replicates the visual of a film print burning up in the projector. Use this transition to 
achieve a classically retro effect, or to strike terror into the hearts of projectionists everywhere. 
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Burn Away transition showing two pirates concerned about the state of their release print

The Burn Away effect has the following parameters:

Progression 
This set of controls affects the type of movement the burn takes as it passes through the frame.

 — Motion: Allows you to pick a type of burning effect. Each option reveals different parameters.

 — Directional: The burn moves linearly from one edge of the frame to another. This setting 
replicates the film being torn away by the take-up reel as it burns. In this mode, the OFX 
overlay in the Viewer lets you choose the direction.

 — Hotspots: The burn erupts from one or more central points. This setting replicates the film 
jamming in front of a projector bulb and melting away. In this mode, the OFX overlay in the 
Viewer lets you move the burn points directly in the Viewer.

 — Path: Creates a curved path that the burn follows. This setting allows you to specify the burn 
direction precisely, to account for elements in the frame that you want to burn first. In this 
mode, the OFX overlay in the Viewer lets you add points to a spline with which to create any 
curved motion path you want the effect to use.

 — Angle: (Directional Only) The angle that the burn moves along. You can also change this in the 
Viewer directly in Open FX Overlay mode.

 — Number of Hotspots: (Hotspots Only) The number of points that the burn erupts from. 
The possible values are from 1 to 8.

 — Randomize Hotspots: (Hotspots Only) Will pick a random distribution of the hotspots 
in the frame.

 — Number of Points: (Path Only) The number of points on the onscreen curve control. The range is 
from 2 to 5. These points can be manipulated directly in the Viewer in Open FX Overlay mode.
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Adjust Timing
This set of parameters allows you to control the start and end progression of the burn. 

 — Adjust Start: Adjusts how far along in the transition the effect starts. Values are 
from -1.000 to 1.000.

 — Adjust End: Adjusts how far along in the transition the effect ends. Values are 
from 0.000 to 2.000. 

Edge
These controls let you adjust the qualities of the edge of the film as it burns.

 — Raggedness: How rough the edge of the burn is. Values are from 0.000 (perfectly flat) 
to 1.000 (extremely rough). 

 — Scale: The scale of the raggedness. Values are from 1.00 to 10.00. 

Appearance
These controls adjust the look and color of the burn as it moves through the transition.

 — Melt: Controls the amount of distortion in the image as it burns away. Values are 
from 0.000 to 1.000.

 — Char: Controls the amount of darkened charring along the edge. Values are from 0.000 to 1.000.

 — Char Color: Lets you select the color of the Char effect.

 — Burn: Lets you set the thickness of the burn effect. Values are from 0.000 (no burn) 
to 1.000 (maximum thickness).

 — Burn Hue: Lets you select the hue of the Burn effect.

 — Burn Sat: Lets you select the intensity of the color of the Burn effect.

 — Burn Brightness: Lets you set the brightness of the Burn effect. At lower values, the burning 
edge assumes a motley, irregular effect. Values are from 0.000 to 1.000.

 — Glow Brightness: Lets you control the intensity of a glow effect emanating from the Burn effect. 
Values are from 0.000 to 2.000.

 — Glow Spread: Lets you control the width of the glow effect. Values are from 0.000 to 2.000.

 — Ash: Controls how much ash trails behind the burn as it moves through the frame. 
Values are from 0.000 to 1.000.

 — Ash Color: The color of the Ash parameter.

DCTL Transition
DCTL (DaVinci Color Transform Language)-based transitions are now supported in DaVinci Resolve. 
See the DaVinci Resolve Developer Documentation in the help menu for more details.
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Audio Transitions
A single audio transition handles all of your crossfade needs.

 — Cross Fade +3/–3/0 dB: An audio-only transition that lets you fade from one audio clip to 
another. Three different crossfades let you choose the power of the actual transition from one 
level to the other.

OpenFX Transitions
If you’ve installed one or more sets of OpenFX plug-ins on your DaVinci Resolve workstation, any 
transitions within those sets will appear in the OpenFX panel of the Effects Library.

 

OpenFX transitions in the Effects Library
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Chapter 48

Titles, Generators, 
and Stills
Using the Edit page, you can add titles, effects generators, and stills 
to your timelines. You can also save customized titles, generators, 
and stills back to the Media Pool for future use.
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Adding Titles
There’s a collection of titles and generators in the Toolbox that you can use to create leader 
when outputting to tape, add slates, create subtitles, and otherwise fulfill any textual needs your 
program has.

To select and audition titles before you place them into the Timeline, ensure that “Hover Scrub 
Preview” is checked in the Titles option menu, then simply hover your pointer over any thumbnail 
in the Titles tab. If the title is animated  (i.e., Fusion titles), moving the pointer across the thumbnail 
will preview the animation. Once you’ve chosen your title, you can drag it from the Titles tab to your 
Timeline in the Edit page or in the Cut page to either the upper or lower Timelines, or use the editing 
selection modes at the bottom of the tab.

Scrubbing over a Title Thumbnail previews the title in the Viewer.

Titles and generators can be edited much like any other clip. Furthermore, when selected, both titles 
and generators expose the same Composite, Transform, and Cropping parameter groups as any other 
clip; these parameters can be used to composite titles and fly them around in order to create different 
text effects.

Methods of adding and editing generators and titles:

 — To drag and drop a generator directly into the Timeline: If you simply drag and drop titles or 
generators into the Timeline, the default duration of the resulting clip is 5 seconds. This duration 
can be customized in the Edit panel of the User Preferences.

 — To edit a generator using the edit overlays of the Timeline Viewer: Click the destination 
control of the clip you want to edit a generator into, then set Timeline In and Out points to define 
the duration of the resulting edit, and drag the generator you want to edit onto the edit overlay of 
the Timeline Viewer that corresponds to the type of edit you want to perform.

 — To reposition the text of a title in the Timeline Viewer: Select the title generator you want to 
edit in the Timeline, then click the visible text in the Timeline Viewer so that its bounding box is 
selected; in this state you can reposition, scale, and rotate the text item. As you reposition text, it 
will snap to key regions of the frame such as the vertical and horizontal center of the Viewer; hold 
the Option key down to suspend snapping if you want to freely position the text.
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 — To edit the text of a title in the Timeline Viewer: Select the title generator you want to edit 
in the Timeline, then double-click the visible text in the Timeline Viewer to insert a text editing 
cursor. At this point, you can select, delete, or add any text you want by typing directly in the 
Timeline Viewer.

 — To edit the parameters of a generator or title: Open the Inspector, and select the generator or 
title you want to edit to open it into the Inspector.

Using Safe Area Overlays
If you’re working on a broadcast program and you want to adhere to guidelines for title safe and 
broadcast safe, you can choose to display overlays that indicate where these regions are in the Edit page. 

To do so, choose View > Safe Area > On. 

The available safe area overlays

If necessary, there are a number of ways you can customize this overlay by choosing one of the other 
options in the View > Safe Area submenu to toggle specific parts of the safe area overlay on and off. 
These options include:

 — Extents: An outline showing the exact outer edge of the frame. Especially useful when the safe 
markers are set to an aspect ratio other than that currently used by the Viewer.

 — Action: An outline showing the outer 90% action safe area of the frame.

 — Title: An outline showing the outer 80% title safe area of the frame.

 — Center: A crosshairs showing the center of the frame.

 — Aspect: Enables use of the View > Select Aspect Ratio submenu to change the aspect ratio of the 
safe area markers. You can choose among the following aspect ratios: 1.33 (a.k.a. 4:3), 1.66, 1.77 
(a.k.a. 16:9), 1.85, and 2.35.
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Custom Action and Title Safe Areas
The Editing panel of the User Preferences has a new “Use custom safe area overlays” checkbox that, 
when turned on, displays Action Area and Title Area fields that let you set a custom percentage for 
each. The default values are 93% for Action Area and 90% for Title Area. 

Types of Title Generators
When opened into the Inspector, titles expose a set of text parameters that allow you to style the 
contents of that clip’s Text field within the Inspector. Each of the titles supports rich text, so you can 
individually style words, lines, or paragraphs of text using the available parameters including Color, 
Font, and Size. Other attributes such as Alignment, Anchor, Position, and Shadow affect the entire title.

The following titles are available:

 — L Lower 3rd: (supports rich text) Automatically positions two lines of text at the bottom left 
corner of title safe, each with a different set of rich text and Position/Zoom/Rotation controls for 
independent sizing and animating.

 — M Lower 3rd: (supports rich text) Automatically positions two lines of text at the bottom middle 
of title safe, each with a different set of rich text and Position/Zoom/Rotation controls for 
independent sizing and animating.

 — R Lower 3rd: (supports rich text) Automatically positions two lines of text at the bottom right 
corner of title safe, each with a different set of rich text and Position/Zoom/Rotation controls for 
independent sizing and animating.

 — Scroll: (supports rich text) Automatically automates a scrolling title sequence from the bottom to 
the top of the screen. The duration of the generator clip in the Timeline determines the speed of 
the scroll. Identical parameters as the Simple title.

 — Text: (supports rich text) Useful for creating titles consisting of a word, line, or paragraph of text. 
A single body of text shares one set of rich text controls that let you style selected parts of the title 
text differently.

 — Text+: (does not support rich text) An advanced title generator based on the title generation 
tools on the Fusion page. This generator has significantly more options for styling, rendering, and 
animating than the simple title generator above, but all title text shares a single style.

 — Fusion Titles: A variety of pre-built title templates assembled in Fusion. DaVinci Resolve comes 
with a library of pre-assembled Fusion titles, but you can also create your own to appear in this 
category of the Effects browser.
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DaVinci Resolve Title Generators
The original title generators that shipped with DaVinci Resolve all share similar controls, and they all 
share the ability to support rich text styling.

Editing Titles Within the Timeline Viewer
Once you add a title generator to the Timeline, the original title generators that shipped with 
DaVinci Resolve have onscreen controls that let you edit text and transform and position blocks of text 
directly within the Timeline Viewer.

Positioning and Transforming Text
So long as the Timeline playhead is positioned over a text generator that’s on top of one or more 
background clips, clicking on the text in the Timeline Viewer reveals onscreen transform controls that 
correspond to the Position, Zoom, and Rotation parameters in the Inspector.

Drag the text to position it in the Viewer

While dragging text to reposition it, snapping occurs at the X and Y center of the frame, as well 
as around the outer third of the frame. Holding the Shift key down while dragging a text object 
constrains movement to just the X or Y axes.

Editing Text
Double-clicking on text in the Timeline Viewer puts that text into an editable state, wherein you can 
insert a text cursor or select characters to edit the text as you would in any text editor.

Double-click on the text to edit it in the Viewer
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Title Generator Panels
The parameters of text generators are divided into two panels in the Video Inspector: the Title panel 
and the Settings panel. 

 — The Title panel contains all of the text editing, styling, and sizing controls used to edit the contents 
and look of a title in your project, including the Rich Text, Drop Shadow, Stroke, and Background 
parameters.

 — The Settings panel contains the same Composite, Transform, and Cropping parameters that 
all other clips in DaVinci Resolve have. These parameters are intended for compositing and 
animating a title.

Shared Title Generator Parameters
With the exception of the Text+ generator, all other title generators in DaVinci Resolve are capable of 
rich text styling. This means you can select any portion of a generator’s text and style it differently. 
For example, you could have three lines of text within a single generator and style each line 
individually to create a particular design.

A single generator with three lines of differently styled text

Each title generator shares the same parameters in the Video Title panel of the Inspector for editing 
and styling text:

 — Rich Text: A control group consisting of a text entry field and parameters that can be used to 
style different parts of the text independently.

 — Text: A text entry field for editing the title being generated. If no characters are selected, the 
styling controls affect the entire block of text. If you select a specific set of characters, the 
styling controls only affect the selection. Text in this field can also be edited directly in the 
Timeline Viewer.

 — Font family: A pop-up for choosing one of the font families installed on your workstation.

 — Font face: A pop-up for choosing which face of the font family currently selected to use.

 — Color: Opens the standard color picker for choosing a font color.

 — Size: Slider for choosing the text size.

 — Tracking: Slider that sets the spacing between characters.
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 — Line spacing: Slider for setting the spacing between the selected line of text and the 
next one below.

 — Font style: Buttons to apply underline, overhead line, strikethrough, superscript, 
and subscript styling.

 — Font case: A pop-up for forcing the text selection to be Mixed Case (the default),  All Caps, All 
Lowercase, Small Caps, or Title Caps.

 — Alignment: Buttons to select the method of alignment: left, centered, right, or justified.

 — Anchor: Buttons for selecting how text is anchored to the current position, both horizontally 
(top, centered, bottom) and vertically (right, centered, left).

 — Position: X and Y parameters determining the bottom left-hand corner (the default Anchor 
settings) of the rich text block being generated. Corresponds to the act of dragging a selected 
text box in the Timeline Viewer.

 — Zoom: X and Y parameters determining the scale of the text. A link button lets you keep the 
X and Y parameters locked together. Corresponds to the act of resizing a selected text box in 
the Timeline Viewer from either the corners (to resize proportionally), or the top/bottom/sides 
(to stretch or squeeze the text).

 — Rotation Angle: A slider for rotating the orientation of the text. Corresponds to the act of 
rotating a selected text box in the Timeline Viewer using the rotation handle.

 — Drop Shadow: A group of controls that lets you apply a customizable drop shadow to every 
character of text being generated.

 — Color: Opens the standard color picker for choosing a drop shadow color.

 — Offset: X and Y parameters determining how offset the drop shadow is from the original text.

 — Blur: A slider for blurring the drop shadow.

 — Opacity: A slider determining how transparent the drop shadow is.

 — Stroke: Lets you add an outline to every character of text being generated.

 — Color: Opens the standard color picker for choosing the stroke color.

 — Size: A slider lets you choose the thickness of the stroke, in pixels.

 — Background: This group of controls provides an extremely flexible rectangle or rounded 
rectangle shape that you can use to add a background, bar, outline, or other intersecting shape to 
use when designing a title.

 — Color: Opens the standard color picker for choosing the interior color of the 
background shape.

 — Outline color: Opens the standard color picker for choosing outline color of the 
background shape.

 — Outline width: A slider lets you choose the thickness of the background shape outline, in pixels.

 — Width: A slider lets you choose how wide to make the background shape.

 — Height: A slider lets you choose how tall to make the background shape.

 — Corner radius: A slider lets you choose the roundness of the rectangle edges.

 — Center: X and Y parameters you can use to offset the background shape from the text 
being generated.

 — Opacity: A slider lets you set the transparency of the background shape.
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Title Generator Settings Parameters
Additionally, each generator has Composite, Transform, and Cropping parameters in the Settings 
panel of the Video Inspector that let you composite, resize, and animate titles against other clips in the 
Timeline for motion graphics effects. These parameters are the same as those available for every clip, 
as described later in this chapter.

The Text+ Title Generator
A new kind of title generator, named Text+, is available in the Titles category of the Effects Library’s 
toolbox. This is the exceptionally fully-featured 2D text generator from Fusion, available for editing 
and customizing right in the Edit page. It’s capable of most of what the Text generator can do, with the 
exception of rich text editing and a lack of on-screen controls in the Timeline Viewer. However, it also 
has many more styling and animation controls than the Text generator has.

TIP: At the time of this writing, the Text generator is still very useful for quickly creating 
text pages with multiple styles, whereas the Text+ generator excels at creating text for 
animated motion graphics.

The new Text+ title generator, along with new Fusion titles below

You can use the Text+ generator the same way you use any generator in the Edit page. Simply 
edit it into a video track of the Timeline, select it, and open the Inspector to edit and keyframe its 
numerous properties to create whatever kind of title you need. 

In addition to having many more styling options, the origin of the Text+ generator in a 
compositing tool means that it offers many more panels worth of keyframable parameters, along 
with advanced animation controls built-in. These include keyframable Write On/Write Off controls, 
layout and animation using shapes (options include point, frame, circle, and path), character, word, 
and line transforms and animation, advanced shading, and full interlacing support.
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Four panels of the Text+ title generator, including Text,  
Layout, Transform, and Shading
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Better yet, with the playhead parked on your new Text+ “Fusion Title,” you can open the Fusion page 
and access its parameters there too, if you want to start building upon this single generator to create 
a multi-layered motion graphics extravaganza.

Opening the Text+ node in the Fusion page reveals it as an actual Fusion page operation

For more information about the extensive capabilities of the Text+ generator, see Chapter 103, 
“Generator Nodes.”

Fusion Titles and Fusion Templates
The abundance of other Fusion titles in the Effects Library are custom-built text compositions with 
built-in animation that expose custom controls in the Inspector.

In actuality, these text generators are Fusion templates, which are Fusion compositions that have 
been turned into macros and come installed with DaVinci Resolve to be used from within the Edit page 
like any other generator. 

A Fusion title creating an animated lower third, with controls open in the Inspector

It’s possible to make all kinds of Fusion title compositions in the Fusion page, and save them for 
use in the Edit page by creating a macro and placing it within the /Library/Application Support/
Blackmagic Design/DaVinci Resolve/Fusion/Templates/Edit/Titles directory, but this is a topic for 
another day.

There’s one other benefit to Text+ generators and that is they can be graded like any other clip, 
without needing to create a compound clip first.
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Saving Titles in the Media Pool 
for Future Use
If you’ve created a title in a style that you want to later reuse, for example, a particularly formatted 
lower third that will be the basis for every lower-third in your program, you can drag any title from 
the Timeline to the Media Pool, and it will be saved as a separate clip. Title clips in the Media Pool are 
shown with a thumbnail showing a preview of the text they contain. If you’ve keyframed any animated 
text or video adjustments, those keyframes are also saved with this clip.

A text generator saved as a clip in the Media Pool

Once saved in the Media Pool, text generators can be opened in the Source Viewer and edited just like 
any other clip.

Using Generators
Generators, with the exception of Solid Color, lack editable parameters other than the Composite, 
Transform, Cropping, and Dynamic Zoom parameters that are standard for every clip. Additionally, 
generators have a Display Name field in the Inspector that lets you give a particular clip a custom 
name that appears in the Timeline.

The various video generators included in DaVinci Resolve can be previewed by hovering your pointer 
over any thumbnail in the Generators tab. To edit a generator into your timeline, simply grab the 
thumbnail of the generator you wish to use, and place it in your Timeline in the Edit page, or in either 
the upper or lower Timelines in the Cut page.

The following generators are available:

 — 10 Step: A grayscale ramp segmented into 10 steps from black to white.

 — 100mV Steps: A grayscale ramp segmented into segments of exactly 100mV each.

 — BT.2111 Color Bar HLG Narrow: Use these bars if your HDR timeline is using a Hybrid Log 
Gamma curve (HLG). This is most commonly used in broadcast for its simple backward 
compatibility with SDR televisions.

 — BT.2111 Color Bar PQ Full: While PQ Full is a part of the Rec. 2100 (BT.2100) specification, it is not 
commonly in use at this time. Use this setting only if you know you need it.
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 — BT.2111 Color Bar PQ Narrow: Use these bars if your HDR timeline is using a format with a 
PQ gamma curve (i.e., DolbyVision or HDR10). This is most commonly used for video streaming 
services and Blu-ray discs.

 — EBU Color Bar: A 1.77:1 aspect ratio set of color bars for PAL-using countries.

 — Four Color Gradient: A gradient that blends four different colors at each corner of the frame. You 
can adjust the Center X and Center Y parameters to move the center at which all four colors blend 
together, and you can change the four colors that appear at each corner using corresponding 
color parameters.

 — Grey Scale: A simple grayscale ramp from black to white.

 — SMPTE Color Bar: An updated 1.77:1 aspect ratio set of color bars for NTSC-using countries.

 — Solid Color: A simple fullscreen color generator. A Color parameter lets you choose what 
color this generator outputs.

 — Window: A simple white-on-black shape generator, defaulting to a white rectangle against a 
black background.

 — YCbCr Ramp: A gradient designed to test the Y’CbCr signal.

ITU-R BT.2111-1 Color Bar Generators
DaVinci Resolve now includes a ITU-R BT.2111-1 specification Color Bar Generator for HDR video. 
These are the color bars to use when calibrating, analyzing, or mastering a Rec. 2100 (BT.2100) 
HDR signal.

These new color bars have saturation levels set at 100% at the top, and 75% in the middle 
section. They also contain Rec. 709 (BT.709) color bars in the lower corners for compatibility with 
HD SDR signals. Commonly referenced levels are indicated on the image below. The full color bar 
specification can be found on the ITU’s web site: https://www.itu.int/rec/R-REC-BT.2111/en.

The BT.2111-1 color bars and some of the more commonly used levels
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The BT.2111-1 color bars on the Vectorscope, hitting their targets at 100% levels on the 
outside, 75% levels in the middle, and with the Rec. 709 bars represented in the interior 

Fusion Generators
The Fusion Generators section of the Generators panel contains Fusion effects that have been made 
into reusable generators. By default, a single generator, Noise Gradient, appears as an example of 
how these work. Fusion Generators work like any other generator. Once edited into the Timeline, they 
act like any other clip, and when selected, they expose customizable parameters in the Inspector that 
let you tailor their effect to meet your needs.

However, Fusion Generators are highly customizable. Simply opening the Fusion page while the 
playhead intersects a Fusion Generator on the topmost track of the Timeline exposes all of the Fusion 
nodes that create that generator’s effect, enabling you to rebuild the effect to do whatever you need. 
Furthermore, if you know how to create effects in Fusion, you can create your own generators by 
making Fusion Macros and saving them to the Effects Library, so they appear in the Fusion Generators 
section of the Effects Library. For more information on how to do this, see Chapter 68, “Node Groups, 
Macros, and Fusion Templates.” 
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Using Stills
You can import still images into the Media Pool, and edit them into the Timeline as clips with custom 
durations. By default, imported stills are 10 seconds long, but you can extend a still image’s Out point 
to a maximum of 17 hours and 40 minutes in length, which ought to cover just about any project 
you’re planning on working on, so long as you’re not Andy Warhol. DaVinci Resolve is correspondingly 
capable of importing still image clips referenced by XML or AAF project files, so long as they’re in a 
supported format. 

DaVinci Resolve supports the use of stills in the following formats:

File Format Alpha Channel Support

.tif Yes

.png Yes

.jpg No

.dpx No

.exr Yes

.dng No

.psd No

.tga Yes

.heif No

.NEF No

.CR2 No

Once edited into the Timeline, still image clips have the same Composite, Transform, Cropping, Retime, 
and Scaling attributes as any other clip.

Photoshop File Support
Photoshop (.psd) files appear as a single clip displaying only the bitmapped layers within the Edit page 
and Color page of DaVinci Resolve. Photoshop text layers and layer effects are not supported at the 
time of this writing.

Fusion Page PSD Support
The Fusion page has support for multi-layered Photoshop files. You can use the Fusion > 
Import > .PSD command to import Photoshop files such that each individual layer appears 
as a separate MediaIn node connected to a cascading series of Merge nodes, ready for you 
to work on.
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Chapter 49

Using the 
DaVinci Resolve 
Speed Editor and 
Editor Keyboard
The DaVinci Resolve Speed Editor is an edit controller designed 
specifically to work hand-in-hand with the Cut page, while the 
DaVinci Resolve Editor Keyboard increases efficiency in both 
the Cut and Edit pages.
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Introducing the 
DaVinci Resolve Speed Editor 
The DaVinci Resolve Speed Editor is specifically designed for custom integration with the Cut page. 
It efficiently combines transport control, editing functions, and multi-camera support into a powerful 
edit controller with a small footprint. Almost all the Speed Editor functions also work the Edit Page, 
where they differ will be noted in the text.

The DaVinci Resolve Speed Editor
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Connecting the Speed Editor 
via USB-C
Connecting the DaVinci Resolve Speed Editor directly via USB-C is the simplest and most reliable 
way to use the Speed Editor on your Windows or Mac computer. Simply connect the Speed Editor to 
your computer’s USB type C port, using a USB-C cable. No additional configuration is required. The 
Speed Editor will show up automatically in DaVinci Resolve, and the DaVinci Control Panels Setup 
applications, ready for use.

Charging the Speed Editor
Connecting the DaVinci Resolve Speed Editor via USB-C will also charge the unit’s internal battery 
allowing it to be used wirelessly via Bluetooth. You can check the current Battery Level of the Speed 
Editor by going to the Control Panels section of the System Preferences.

 

The Speed Editor Battery Level indicator in the System Preferences.

Updating the Speed Editor Firmware
From time to time, Blackmagic updates the functionality of the Speed Editor through firmware 
changes. New firmware can be checked for and installed by opening the separate DaVinci Control 
Panels Setup utility through the menu Help > DaVinci Control Panels Setup. The speed editor must be 
connected via USB to update the firmware.

Troubleshooting the Speed Editor via USB
If you are having difficulty using the DaVinci Resolve Speed Editor via direct USB connection, try the 
following troubleshooting tips:

 — Make sure you are using DaVinci Resolve 17 or higher. The Speed Editor is not compatible with any 
Resolve version lower than 17.

 — Check whether the USB-C cable is properly connected on both ends.

 — If the Speed Editor is connected to a USB-C Hub, try bypassing the hub and directly connect it to 
the computer.

 — Try bypassing any USB Type-C to Type-A adapters if possible.

 — Try using a different USB-C cable.

 — Make sure you are using the correct USB-3 ports on your computer. The DaVinci Resolve Speed 
Editor does not work on USB 2 ports or below.
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Connecting the Speed Editor 
via Bluetooth
You can also connect the DaVinci Resolve Speed Editor wirelessly via Bluetooth for more flexible 
installation options.

To Connect the Speed Editor to MacOS via Bluetooth:

1 Ensure that your Speed Editor’s battery is ready by first connecting it via USB-C as described 
above, and allowing it to charge.

2 Open the Bluetooth Preference Pane in the MacOS System Preferences. Find the device named 
DaVinci Keyboard, and press the Connect key.

The MacOS Bluetooth Preference Pane

3 If MacOS asks you if you would like to Pair the device, click the Connect key.

4 Once the Speed Editor is Connected, open DaVinci Resolve. The LEDs on the Snap and Jog keys will 
illuminate to confirm that the Speed Editor is connected properly.

To Connect the Speed Editor to Windows via Bluetooth:

1 Ensure that your Speed Editor’s battery is ready by first connecting it via USB-C as described 
above, and allowing it to charge.

2 In the Windows Settings, select Devices > Bluetooth & other devices. Make sure the Bluetooth 
slider is set to on.

The Windows 10 Bluetooth Settings
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3 Click on Add Bluetooth or other device, and select Bluetooth from the Add a Device window.

4 Select DaVinci Keyboard from the list of devices, and press the Done key once connected.

The Windows 10 Bluetooth 
Device Selection window

5 If Windows asks you if you would like to Pair the device, click the Allow key.

6 Once the Speed Editor is Connected, open DaVinci Resolve. The LEDs on the Snap and Jog keys will 
illuminate to confirm that the Speed Editor is connected properly.

Troubleshooting the Speed Editor via Bluetooth
If you are having difficulty using the DaVinci Resolve Speed Editor via Bluetooth, try the following 
troubleshooting tips:

 — Make sure you are using DaVinci Resolve 17 or higher. The Speed Editor is not compatible with any 
Resolve version lower than 17.

 — Make sure that the DaVinci Resolve Speed Editor’s battery is charged.

 — First connect the Speed Editor via USB-C to confirm that the hardware is working.

 — If you are having connection problems, systematically disable other nearby connected bluetooth 
devices to check for interference.

 — If you are having bluetooth pairing problems, try resetting the Speed Editor as described below.

Resetting the Speed Editor
Occasionally it may become necessary to perform a factory reset on your DaVinci Resolve Speed 
editor, this will remove any current pairing information stored on the device, and let you set it up again 
from scratch.
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To Reset the Speed Editor to its defaults:

1 Plug the Speed Editor into the computer via USB-C

2 Hold down both the CUT and SMTH CUT keys until the LEDs cycle off then on.

3 Or open the DaVinci Resolve Speed Editor Control Panels app, and press the Factory Reset key in 
the Setup options.

TIP: Multiple DaVinci Resolve Speed Editors and Editor Keyboards can  
be connected and used on the same system.

Using the Speed Editor Keys
To maximize the functionality of all the keys on this reduced-sized edit controller, there are four 
different finger actions used to modify a key’s commands:

 — Press: A short tap to the key and release, as if you were typing.

 — Double Press: Two short taps to the key and release. The double press triggers the secondary 
function of the key that is written on the lower side of the keycap.

 — Press and Hold: Tap the key and hold it down.

 — Double Press and Hold: One short tap, and then tap again and hold the key down.

Navigation Using the Search Dial
The most prominent feature of the DaVinci Resolve Speed Editor is the large Search Dial on its right 
hand side. Primarily used for navigation, in certain circumstances this dial can also be used for 
parameter selection and the direct manipulation of the clips, providing an alternative to click and drag 
mouse input.

DAVINCI RESOLVE SPEED EDITOR

The search dial and 
navigation keys

DAVINCI RESOLVE SPEED EDITOR

Since navigation of the Timeline is where most editors spend the majority of their time, you will want 
to decide on how the playhead reacts on the Timeline. In the Cut page you have two options: Lock or 
Free Playhead.
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 — When set to Locked, the playhead is fixed in the center of the Timeline, and your edited clips scroll 
past it as you play (press the Spacebar), jog, or shuttle with the Search Dial in either direction. 
Locked mode is preferred while using the DaVinci Resolve Speed Editor.

 — When set to Free, the playhead moves across the clips as you play (press the Stop/Play bar), jog, or 
shuttle using the Search Dial in either direction; the clips stay still. Once the playhead gets to the 
right or left edge of the Timeline, the Timeline pages over to reveal the next part of your edit.

Playhead Lock controls

SOURCE
Pressing this key instantly brings the Source Tape into focus, allowing you to navigate through all the 
source media in your bin.

In the Edit Page, this key brings the Source Viewer into focus.

TIMELINE
Pressing this key instantly brings the Timeline Viewer into focus, allowing you to navigate through 
the Timeline.

SHTL (Shuttle)
Puts the Search Dial into Shuttle mode. Used to quickly navigate long clips or sync bins. Rotating the 
dial left of center “rewinds” through the clip or timeline, rotating it right “fast forwards” through them. 
The greater the rotation from center, the faster the Shuttle goes. A LED on the keyboard will illuminate 
to show you that this mode is selected.

JOG
Puts the search dial into Jog mode. Used to navigate to specific frames with accuracy and precision. 
Traditionally, you place your finger the search dial dimple, and rotate it to the left to go frame-by-
frame reverse, and to the right to go frame-by-frame forward. The faster you rotate the search dial, 
the faster the navigation. A LED on the keyboard will illuminate to show you that this mode is selected.

SCRL (Scroll)
Puts the search dial into Scroll mode. Scroll mode is essentially a “higher geared” Jog mode. Rotating 
the wheel left reverses the play direction, while rotating it right moves forward. Scroll works in terms 
of seconds, rather than frames. The speed at which you rotate the search dial determines how fast 
the playhead moves through the footage. A LED on the keyboard will illuminate to show you that this 
mode is selected.

TIP: As a rule of thumb, Shuttle is most effective at the scene level, Jog the clip level, and 
Scroll at the timeline level.
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Intelligent Keyboard Edit Modes
The DaVinci Resolve Speed Editor has dedicated keys to perform common editing functions. 

DAVINCI RESOLVE SPEED EDITORDAVINCI RESOLVE SPEED EDITOR

In and Out point

The Cut page Editing tool

IN / CLR
This key selects the In Point of a clip or timeline. Double press this key (CLR) to clear the In point.

OUT / CLR
This key selects the Out point of a clip or timeline. Double press this key (CLR) to clear the Out point.

If you are viewing a bin in the Source tape, you can use the In and Out keys to limit the Source tape 
between the two points. This allows you to quickly reduce the Source tape to a specific section, 
regardless of how many clips are in your bin.

To reduce the Source tape based on In and Out points:

1 In the Source tape, set the newly desired duration using the In and Out keys on the Speed Editor.

2 Press the “Source” key.

3 The Source tape is now limited to the duration between the two points.

4 If you wish top return to the original full Source tape, press the “Esc” key.

SMART INSRT (Smart Insert) / CLIP
Automatically inserts an incoming clip at the closest edit point to the playhead (as shown by the Smart 
Indicator) on the selected track, pushing all clips to the right of the edit point forward to make room 
for the incoming clip you’ve inserted to Track 1. Because this is a smart operation, you are prevented 
from inserting a clip at any arbitrary frame; incoming clips are only inserted at the closest previously 
existing edit point.
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Double Press this key (CLIP) to Smart Insert the entire source clip, ignoring any In and Out points 
previously set on the clip.

In the Edit page, it automatically inserts an incoming clip at the playhead or selected In point on 
the selected track, pushing all clips to the right of the edit point forward to make room for the 
incoming clip.

(Top) Before doing a 
Smart Insert, (Bottom) 
After inserting clip DD 
between clips AA and BB

APPND (Append) / CLIP
The position of the playhead is ignored; incoming clips are always placed after the last clip in 
the Timeline.

Double Press this key (CLIP) to append the entire source clip, ignoring any In and Out points previously 
set on the clip.

Performing an 
Append edit of clip 
DD to the Timeline

RIPL O/WR (Ripple Overwrite)
At its simplest, Ripple Overwrite substitutes a clip in the Timeline with an incoming clip. If you use 
Ripple Overwrite on a clip on Track 1, this will automatically move all clips that are to the right of the 
affected clip in the Timeline either forward to make room, if the incoming clip is longer, or back to 
eliminate gaps, if the incoming clip is shorter. 
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Performing a Ripple 
Overwrite to substitute 
an entire clip at the 
playhead (BB) with the 
incoming clip (DD)

TIP: Using Ripple Overwrite is an efficient way to audition different takes of the same shot 
without disrupting the narrative flow of the entire scene.

CLOSE UP / YPOS
Pressing this key reframes a clip as a zoomed-in close up to make up for a lack of actual close ups that 
would have been shot with either longer lenses, or by moving the camera closer to the subject. This 
function is particularly useful when you’re working with 4K media in a 1080 timeline, or 8K media in 
a 4K timeline, which enables you zoom into existing wide shots to create medium shots, or medium 
shots to create close up shots, with no loss of quality. 

Performing this edit adds the incoming clip as an approximate 20% to 40% zoomed close up and also 
performs a face detection. If a face or faces are found, it automatically re-positions the face top center 
in the frame. You can always reposition the close up manually using the Sizing controls in the Inspector.

Press and Hold this key (YPOS) to adjust the Y position of the Clip using the search dial.

How this key works depends on the mode that is active in the Cut page.

Source mode:

 — The selected clip in the Source Tape view is edited into the Timeline as a close up, duration based 
on the In and Out points set in the clip, and the Smart Indicator on the Timeline.

Timeline mode:

 — The clip under the playhead has a Close Up applied to it, and is copied to the track above it, with a 
5 second duration starting from the playhead position.

Live Overwrite mode:

 — This will perform a Close Up on the selected camera as it’s overwritten into the Timeline.

 — The LED on this key will then illuminate, to show you that this mode is armed.

In the Edit page, how this key works depends on if you are in the Source or Timeline Viewers.

Source Viewer:

 — The selected clip in the Source Viewer is edited into the Timeline as a close up, on the next highest 
track. The duration is based on the In and Out points set in the clip and inserted at the playhead 
position on the Timeline.
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Timeline Viewer:

 — The clip under the playhead has a Close Up applied to it and is copied to the track above it, with a 
five second duration starting from the playhead position.

PLACE ON TOP
This key lets you edit the incoming clip as a superimposition above whatever other clips are in the 
Timeline; the incoming clip is always placed on top, so if there are clips in Tracks 1, 2, and 3, the 
incoming clip is automatically placed on Track 4, regardless of which track is selected. The frame the 
incoming clip aligns with depends on the following:

 — When the playhead is near an edit point (within five frames), the incoming clip aligns with the 
closest timeline edit point in proximity to the playhead (as shown by the Smart Indicator) if no 
timeline In or Out points have been defined.

 — When the playhead is not near an edit point, the incoming clip aligns with the playhead if no 
timeline In or Out points have been defined.

 — The incoming clip aligns with a Timeline In point if one has been set.

 — The incoming clip’s Out point will align with a timeline Out point if one has been set without an In 
point. This “backtimes” the clip.

(Top) Before placing a 
clip on top, (Bottom) 
After editing clip DD 
into the Timeline with 
a Place on Top edit

SRC O/WR (Source Overwrite)
This edit requires overlapping timecode in multiple clips and Track 1 of the Timeline to work properly, 
such as when recording synced timecode to multiple cameras during a multi-cam shoot. If there is no 
overlapping timecode, this edit does nothing.

If you are working with footage from multiple cameras that have synced timecode, then the easiest 
way to use this edit type is to set In and Out points over a clip in the Timeline where you want to cut 
away to another angle. In the following example, a wide shot of a cooking show covers the moment 
when the chef starts slicing a chili.

 

Setting timeline In and Out points to identify a cutaway
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You can then select a clip in the Media Pool that corresponds to the desired angle you want to add as a 
cutaway, which has synced timecode that overlaps with the clip on Track 1 in the Timeline. Don’t set In 
and Out points; if necessary, you can clear previously set In and Out points by pressing Option-X.

 

Choosing a Media Pool clip from another camera that has overlapping timecode 

When you click the Source Overwrite key, a synced section of the selected Media Pool clip will be 
edited into the Timeline between the In and Out points you placed, superimposed on top. The result is 
a perfectly timed cutaway.

Using Source Overwrite to edit a superimposed and synced section of 
the source clip into the Timeline between the In/Out points

Alternatively, you can also use Source Overwrite to automatically place a source clip with a marked 
In/Out region on top of a clip in the Timeline so that its timecode syncs with the timecode of the 
Timeline clip, when you don’t know exactly how much of the incoming source clip you want to edit into 
the Timeline, and you just want it synced appropriately.
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Search Dial Live Trimming Tools
Several of the most powerful features of the DaVinci Resolve Speed Editor involve the intuitive 
trimming controls afforded by the search dial.

DAVINCI RESOLVE SPEED EDITORDAVINCI RESOLVE SPEED EDITOR

The Trimming tools

TRIM IN
When this key is pressed and held, it lets the user trim the nearest In point on the Timeline (as shown 
by the Smart Indicator), by simply rotating the search dial back and forth. The trim point is highlighted 
in green. Release the key to confirm the edit.

In the Edit page, the target clip for the trim is prioritized by selection first, then by track order under 
the playhead.

In Source mode, holding this key and rotating the search dial adjusts the In Point of the clip in the Viewer.

TRIM OUT
When this key is pressed and held, it lets the user trim the nearest Out point on the Timeline (as 
shown by the Smart Indicator), by simply rotating the search dial back and forth. The trim point is 
highlighted in green. Release the key to confirm the edit.

In the Edit page, the target clip for the trim is prioritized by selection first, then by track order under 
the playhead.

In Source mode, holding this key and rotating the search dial adjusts the Out Point of the clip in 
the Viewer.

ROLL / SLIDE
When this key is pressed and held, it lets the user trim the nearest transition point (as shown by the 
Smart Indicator), and roll the edit point back and forth between the clips by simply rotating the search 
dial. The trim point is highlighted in green. Release the key to confirm the edit.

Double Press and Hold this key (SLIDE) to Slide the entire clip back and forth in the Timeline. A four-
way multiview will show the In and Out points for both source and destination clips as you slide.
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SLIP SRC (Slip Source)
When this key is pressed and held, it allows the user to slip in place the footage of the clip to the 
left of the Smart Indicator back and forth by moving the search dial. A four-way multiview will show 
the In and Out points for both source and destination clips as you slip. The clip that will slip will be 
highlighted in orange. Release the key to confirm the edit.

In the Edit page, the target clip for the slip is always the clip nearest to the left of the 
playhead position.

SLIP DEST (Slip Destination)
When this key is pressed and held, it allows the user to slip in place the footage of the clip to the 
right of the Smart Indicator back and forth by moving the search dial. A four-way multiview will show 
the In and Out points for both source and destination clips as you slip. The clip that will slip will be 
highlighted in orange. Release the key to confirm the edit.

In the Edit page, the target clip for the slip is always the clip nearest to the right of the 
playhead position.

TRANS DUR (Transition Duration)/SET
Holding down this key when a transition is under the Smart Indicator or playhead will allow you 
to change the duration of the transition using the search dial. Turning the dial left will shorten the 
transition, and right will lengthen it. Once the duration is correct, release the key.

Double Pressing this key (SET) allows you to set the current transition length as the default 
transition duration.

TIP: Multiple transitions can be changed at the same time by holding down Command and 
selecting the transitions on the Upper Timeline, then pressing the appropriate transition 
key (CUT, DIS, SMTH CUT).

Transition Keys
This set of keys provide immediate shortcuts to the most commonly used transition commands.

CUT
This key will change any existing transition to a simple cut at the Timeline edit point, as shown by 
the Smart Indicator. It will not add a new cut at the playhead position. To do this use the Split Clip 
(Command-\) function instead.
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The LED on this key will illuminate to show you the Cut Transition is armed in Live Overwrite mode.

In the Edit page, this key will change any existing transition to a simple cut at the edit closest to (either 
before or after) the playhead.

DAVINCI RESOLVE SPEED EDITORDAVINCI RESOLVE SPEED EDITOR

Transition keys for Cut, Dissolve, and Smooth Cut

DIS (Dissolve)
This key will add a one second dissolve centered between the two shots at the Timeline edit point, as 
shown by the Smart Indicator. If there is another transition already present there, it will replace it.

The LED on this key will illuminate to show you the Dissolve transition is armed in Live Overwrite mode.

In the Edit page, this key will change any existing transition to a dissolve at the edit closest to (either 
before or after) the playhead.

SMTH CUT (Smooth Cut)
This key will add a Smooth Cut transition centered between the two shots at the Timeline edit point, as 
shown by the Smart Indicator. If there is another transition already present there, it will replace it.

The LED on this key will illuminate in Live Overwrite mode to show you the Smooth Cut 
transition is armed.

In the Edit page, this key will change any existing transition to a Smooth Cut at the edit closest to 
(either before or after) the playhead.

Smooth Cuts are special-purpose transitions designed to make short jump cuts in the middle of a 
clip unnoticeable. This is done by using optical flow processing to match the same features on either 
side of a cut in order to automatically morph a subject from one position to another over the duration 
of the transition. 

The Smooth Cut effect works best on clips such as sit-down interviews and close-up head shots with 
a minimum of background and subject motion, and where the subject’s position on either side of 
the cut is not significantly different. A good example of when Smooth Cut is effective is when you’re 
cutting pauses, partial repeats, filler sounds such as “um” or “you know,” or other speech disfluencies 
out of an interview clip to tighten the dialog, and you want to eliminate the little “jump” that occurs at 
the cut without having to cut away to B-roll. Applying a short two- or four-frame Smooth Cut transition 
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to the edit can make this kind of edit invisible, as long as the speaker doesn’t change position 
significantly during the cut. The more motion there is in the background of the shot, and the more 
the speaker changes position, the harder it will be to get a useful result using Smooth Cut. Although 
the default duration for any transition is one second, you’ll find that Smooth Cut transitions may work 
much better when they’re short; 2- to 6-frame Smooth Cut transitions often work best to disguise 
jump cuts.

Function Keys 

DAVINCI RESOLVE SPEED EDITORDAVINCI RESOLVE SPEED EDITOR

Top Center keys

ESC / UNDO
This key functions the same way as the escape key on your keyboard, but in the Cut page it is also 
used to clear a selected camera in the Sync Bin.

Double press this key (UNDO) to undo your last action. Multiple double-presses take you back through 
the Undo history. 

SYNC BIN 
This key will open up the Sync Bin for easy multi-camera editing. For more information on using the 
Sync Bin see Chapter 28, “Fast Editing in the Cut Page.” 

This key will open up a Multicam clip in the Multicam Viewer in the Edit page. For more information on 
using the Multicam Viewer see Chapter 41, “Multicam Editing.”

Distance Indicators to Adjacent Edits 
When using the Speed Editor’s search dial while using the Sync Bin, the Cut page playhead in the lower 
timeline now has two small windows to either side showing the distance to the nearest edit. The left 
window shows the time to the nearest previous edit, and the right window shows the time to the next 
previous edit. Both windows are in seconds:frames (SS:FF) format. This feature allows you to quickly 
jump to, or modify an edit point using the direct timecode entry method.
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The Distance Indicators when 
using the Search Dial in the Sync 
Bin. The left window is showing 
one second and ten frames 
to the previous edit, and the 
right window is showing thirty 
three frames to the next edit as 
shown by the smart indicator.

AUDIO LEVEL / MARK
Press and holding the Audio Level key allows you to adjust the selected clip’s Volume parameter 
by rotating the Search dial. If no clip is selected it will modify the clip on the highest track under 
the playhead.

In the Edit page, the target clip for the audio level adjustment is prioritized by selection first, then by 
track order under the playhead.

Double pressing this key (MARK) adds a marker placed at the playhead’s current position. Double 
press again to enter the marker’s editing dialog box to add comments, durations, etc.

Double press and holding this key in the Cut page allows you to set the color of the marker before you 
add it, by rotating the search dial. The double press and hold has no effect in the Edit page.

Double pressing and holding 
down the Audio level/Mark 
key brings up a rotary marker 
color selector that you can 
navigate with the search dial

FULL VIEW / RVW
Pressing this key expands the Viewer to Full View mode on the interface monitor. Pressing this key 
again returns the Viewer to its normal mode.

Double press this key (RVW) to review your edit in the Cut Page. This function plays back a pre-roll 
before and post-roll after the last edit in Full View mode. The pre- and post-roll time durations can be 
set in the Editing section of the User tab in the DaVinci Resolve preferences.

TRANS / TITLE
Press and hold this key to bring up a drop-down menu of your available transitions in alphabetical 
order and an icon describing their shape. Rotating the search dial left and right will navigate you 
through the list. When you find the transition that you want, simply release this key and it will be 
placed at the Timeline edit point as shown by the Smart Indicator.

Double press and hold this key (TITLE) to modify the font of an existing title. If the playhead is over a 
basic title and this key is held, you can rotate the search dial to change the font of the title. This only 
modifies the last text element in a title. Once you’ve selected your font, release the key to set it.
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The LED on this key will illuminate to show you the Standard Transition is armed in Live 
Overwrite mode.

This key is inactive in the Edit Page.

Drop-down Transition menu

SPLIT / MOVE
Press this key to create a new cut in a clip at the playhead position. The cut will affect all clips under 
the playhead if more than one track is being used.

If the playhead is over an existing split, pressing this key will remove the split and join the two parts of 
the clip back together.

Double press this key (MOVE) to move your selected clip in the Timeline. Using the search dial, you 
can move the clip backwards and forwards in the Timeline from edit to edit. The Timeline will reflow to 
adapt to your clip placement. When you find the place you want to move your clip to, release the key 
to set it.

SNAP / (Viewer Resize)
Press this key to enable the Snapping mode designed specifically for the search dial. With snap turned 
on in Jog mode, and when the search dial is rotated very slowly, the playhead will briefly pause at each 
edit point in the Timeline in the Cut page. This key has an LED to show you when this mode is active.

Double press and hold this key (Three Lines) to dynamically resize the Viewer window using the search 
dial. Rotating the dial to the left increases the Viewer size, and to the right decreases it.

RIPL DEL (Ripple Delete)
Pressing this key will delete the selected clip or clips, and then close any gaps that occur by rippling 
the Timeline to the left. If no clip is selected, this key will ripple delete the clip under the playhead.
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Sync Bin Multi Camera Selection
DAVINCI RESOLVE SPEED EDITORDAVINCI RESOLVE SPEED EDITOR

The Camera and 
Live Overwrite keys 
along with the play bar

VIDEO ONLY
Press this key to only allow the video from your source clip into a video track on the Timeline. This key 
has an LED to tell you when it is active. Press this key again to deactivate.

This key is inactive in the Edit Page.

AUDIO ONLY
Press this key to only allow the audio from your source clip into an audio track the Timeline. This key 
has an LED to tell you when it is active. Press this key again to deactivate.

This key is inactive in the Edit Page.

STOP/PLAY
This key starts and stops playback on your Timeline or source media. It’s conveniently arranged for 
using your thumb, while your fingers are on the search dial.

CAM 1-9
In the Cut Page, these keys only function in Sync Bin view. Each camera key allows you to choose 
its corresponding camera angle as active in the Sync Bin. Pressing any Camera key will expand that 
camera angle into the Source Clip view, making it easy to set specific In and Out points and perform 
edit functions. You can change camera angles instantly in the Source Clip view by simply pressing 
another Camera key. If you wish to return to the Sync Bin view, press the Escape key.

These keys illuminate and have a switcher-like function in Live Overwrite mode, as explained below.

In the Edit Page, these keys can switch camera angles in a multi-cam clip. For more information on 
Multicam in the edit page, see Chapter 41, “Multicam Editing.”
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Live Overwrite Mode
The Live Overwrite mode in the Speed Editor can be thought of as switching a live Multicam shoot 
without all the annoying constraints of linear time. With all the camera angles locked together in the 
Sync Bin, you can perform and trim all the edits, transitions, and camera switches, you want and never 
go out of sync. Every edit you make will be perfectly synchronized to the Timeline automatically.

DAVINCI RESOLVE SPEED EDITORDAVINCI RESOLVE SPEED EDITOR

Live Overwrite key

LIVE O/WR (Live Overwrite Mode) / RND (Random)
Press this key to enter Live Overwrite mode. An LED will illuminate to tell you this mode is active. It 
immediately activates the Sync Bin and the Multicam Viewer, and switches the Speed Editor into a 
different mode, slightly changing the functionality of several keys to accommodate the Live Overwrite 
workflow. A key that is in Live Overwrite mode has an LED light illuminate to let you know that the key’s 
function is currently active.

Double Press this key (RND) to edit a Random camera angle with a random duration into the Timeline 
from the Sync Bin.

This key is inactive in the Edit Page.

Using Live Overwrite Mode
Editing Multicamera shoots in Live Overwrite mode starts with the base layer on track V1. The clip 
you put here has two additional functions other than its video content. First, it provides a continuous 
timecode track that is the foundation of all the Sync Bin functionality. Second, it provides content to 
measure all of the ripple functions against.

NOTE: Live Overwrite Mode only works with clips in the Sync Bin. If there are no clips set in 
the Sync Bin, this mode will not function. For more information on setting up the Sync Bin, 
see Chapter 28, “Fast Editing in the Cut Page.” 

A good starting point is to place your master camera angle, uninterrupted from beginning to end on 
track V1. You will be able to edit this track, remove whole sections, and re-arrange it as necessary later 
in the process, but for now, this master clip on V1 will serve as the backbone of the edit.
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Live Overwrite mode, with the master camera angle (Cam 4) edited in on track V1

Once the master clip of the Sync Bin is on V1, you can start using the Live Overwrite mode in earnest. 
The concept to understand about Live Overwrite is that this method of editing bypasses traditional 
In and Out points all together, and edits are performed with the Camera keys working in conjunction 
with the Search Dial.

Performing a Live Overwrite edit:

1 Press the Live O/WR key to activate the mode. The LED on the key will illuminate.

2 Use the search dial to navigate the Sync Bin to where you want to make an edit (switch camera 
angles). You will notice all cameras and the Timeline will move together in sync.

3 Select a camera angle in the Multicam Viewer you wish to edit in, and press and hold the 
corresponding Camera key on the Speed Editor, while rotating the search dial forward. This 
will edit in a new clip on top of the V1 track, and you can use the search dial to immediately set 
its duration.

4 Release the Camera key to set the edit.

Performing a Live Overwrite by holding down the 
Camera 5 key and rotating the search dial to the right
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From here you can immediately press and hold another Camera key and rotate the search dial to 
continue the Multicam edit. You can think of this method as “painting-on” clips to the Timeline, 
rather than inserting them. Clips edited in this fashion will never overwrite other clips on the same 
track. Live Overwrite will always add the clip to the next highest track, and create a new track 
automatically if necessary.

”Painting-on” the next edit by holding down the Camera 7 key and rotating the search dial to the right

Continuing the edit from here does not require working in a linear fashion. Because the master 
track is on V1, you can skip ahead anywhere on the Timeline and start “painting-in” camera angles 
wherever you wish, and because the Timeline and Source clips are locked together in the Sync Bin, 
whatever edit you add will always be in perfect sync.

Live Overwrite Mode Key Modifiers: 
Selecting Live Overwrite mode subtly changes the functions of many keys on the Speed Editor, so 
they work in conjunction with this mode. Each of these keys has an LED that illuminates to tell you the 
function is active before you perform a Live Overwrite edit.

 — CUT: Automatically adds a simple cut to the beginning of each clip edited to the Timeline. This 
option is also effectively no transition added.

 — DIS: Automatically adds a Cross Dissolve transition to the beginning of each clip edited to the 
Timeline. If the edited clip is immediately adjacent to another clip on the same track, the dissolve 
will be centered on the cut. If there is no clip immediately adjacent, the dissolve will start on the 
edit instead, and dissolve from the video on the track underneath the clip.

 — SMTH CUT: Automatically adds a Smooth Cut transition to the beginning of each clip edited to the 
Timeline. If the edited clip is immediately adjacent to another clip on the same track, the Smooth 
Cut will be centered on the cut. If there is no clip immediately adjacent, the Smooth Cut will start 
on the edit instead, and Smooth Cut from the video on the track underneath the clip.

 — TRANS: Automatically adds whatever transition is set as the “Standard Transition” in the 
Transitions panel to the beginning of each clip edited to the Timeline. If the edited clip is 
immediately adjacent to another clip on the same track, the transition will be centered on the cut. 
If there is no clip immediately adjacent, the transition will start on the edit instead, and transition 
from the video on the track underneath the clip.

 — CLOSE UP: Automatically performs a Close Up action on the camera as its edited into 
the Timeline.
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Introducing the 
DaVinci Resolve Editor Keyboard
Using a traditional keyboard and mouse to edit with is necessary for modern computers, as the 
interface and operating system dictate the use of these input tools. However the mouse can 
sometimes feel like an abstraction in the editing process, and the DaVinci Resolve Editor Keyboard has 
been designed to bring back a more “hands on” feel. This keyboard allows the convenience and power 
of non-linear editing with the tactile nature of the tape-based edit controllers of the past.

The DaVinci Resolve Editor Keyboard has been designed to greatly accelerate Edit Page timeline 
navigation and to use a two-handed workflow with dedicated keys for common functions in order to 
keep your mouse use to a minimum.

The main difference between using the DaVinci Resolve Editor Keyboard in the Edit page versus the 
Cut page is that in the Edit page the edit point is either selected manually or is set at the playhead 
position, not automatically set at the nearest edit point shown by the Smart Indicator, as in the Cut 
page. Some functions will work differently in the Cut Page, and are noted in the text.

The DaVinci Resolve Editor Keyboard

TIP: Multiple DaVinci Resolve Speed Editors and Editor Keyboards can be connected and 
used on the same system.

Connecting the Editor 
Keyboard via USB-C
Connecting the DaVinci Resolve Editor Keyboard directly via USB-C is the simplest and most reliable 
way to use the Editor Keyboard on your Windows or Mac computer. Simply connect the Editor 
Keyboard to your computer’s USB type C port, using a USB-C cable. No additional configuration is 
required. The Editor Keyboard will show up automatically in DaVinci Resolve, and the DaVinci Control 
Panels Setup applications, ready for use. The Editor Keyboard also includes two USB 3 type A ports 
that activate automatically for attaching external peripherals like dongles or mice.
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Updating the Editor 
Keyboard Firmware
From time to time, Blackmagic updates the functionality of the Editor Keyboard through firmware 
changes. New firmware can be checked for and installed by opening the separate DaVinci Control 
Panels Setup utility that is installed by default with DaVinci Resolve.

Navigation Using the Search Dial
The most prominent feature of the DaVinci Resolve Editor Keyboard is the large Search dial on its right 
hand side. Primarily used for navigation, in certain circumstances this dial can also be used for the 
manipulation of the clips, providing an alternative to click and drag mouse input.
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The Search Dial

Navigation keys

SOURCE
In the Cut page, pressing this key instantly brings the Source Tape into focus, allowing you to navigate 
through all the source media in your bin.

In the Edit page, this key brings the Source Viewer into focus. 

TIMELINE
Pressing this key instantly brings the Timeline Viewer into focus, allowing you to navigate through 
the Timeline.

SHTL (Shuttle)
Puts the Search dial into Shuttle mode. Used to quickly navigate long clips or timelines. Rotating 
the dial left of center “rewinds” through the clip or timeline, rotating it right “fast forwards” through 
them. The greater the rotation from center, the faster the shuttle goes. There are hard end stops on 
the Search dial in Shuttle mode that indicate the maximum speed in either direction. A LED on the 
keyboard will illuminate to show you that this mode is selected.
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JOG
Puts the Search dial into Jog mode. Used to navigate to specific frames with accuracy and precision. 
Traditionally, you place your finger on the Search dial dimple, and rotate it to the left to go frame 
by frame reverse, and to the right to go frame by frame forward. In Jog mode the hard stops are 
released, and the wheel rotates freely in a complete circle. A LED on the keyboard will illuminate to 
show you that this mode is selected.

SCRL (Scroll)
Puts the Search dial into Scroll mode. Scroll mode is essentially a “higher geared” jog mode. Rotating 
the wheel left reverses the play direction, while rotating it right moves forward. Scroll works in terms 
of seconds, rather than frames. The speed at which you rotate the Scroll dial determines how fast 
the playhead moves through the footage. A LED on the keyboard will illuminate to show you that this 
mode is selected.

Sort Media Pool Keys
These keys allow you to instantly re-configure the Media Pool view to arrange your clips in a 
specific order.
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The Media Pool Sort keys

TIMECODE
Pressing this key will instantly sort all of the clips in the Media Pool by Timecode. Pressing this key 
again will toggle between ascending and descending order.

CAM (Camera)
Pressing this key will instantly sort all of the clips in the Media Pool by Camera Number order. The 
camera numbers can be set in the Clips Metadata Editor Field “Camera #”. This field can either be a 
number or a letter. Pressing this key again will toggle between ascending and descending order.
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DATE/TIME
Pressing this key will instantly sort all of the clips in the Media Pool by the Date and Time that the clip 
was created. Pressing this key again will toggle between ascending and descending order.

CLIP NAME
Pressing this key will instantly sort all of the clips in the Media Pool by Clip Name. Please note this sorts 
media by the user selected Clip Name, not the media’s File Name that is recorded in camera. Pressing 
this key again will toggle between ascending and descending order.

Editorial Tools
The DaVinci Resolve Editor Keyboard has dedicated keys to perform common editing functions, in 
addition to the standard QWERTY keyboard. Using the keyboard in the Edit page will also give you 
access to the Cut page’s custom editing tools without having to switch pages back and forth.
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The Cut page  
Editing tools

IN
This key selects the In point of a clip or timeline. Double press this key to clear the In point.

OUT
This key selects the Out point of a clip or timeline. Double press this key to clear the Out point.

SMART INSRT
Automatically inserts an incoming clip at the playhead or selected In point on the selected track, 
pushing all clips to the right of the edit point forward to make room for the incoming clip.

In the Cut page, it automatically inserts an incoming clip at the closest edit point to the playhead 
(as shown by the Smart Indicator) on the selected track, pushing all clips to the right of the edit 
point forward to make room for the incoming clip you’ve inserted to Track 1. Because this is a smart 
operation, you are prevented from inserting a clip at any arbitrary frame; incoming clips are only 
inserted at the closest previously existing edit point.
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(Top) Before doing a 
Smart Insert, (Bottom) 
After inserting clip DD 
between clips AA and BB

APPND (Append)
The position of the playhead is ignored; incoming clips are always placed after the last clip of the 
selected track in the Timeline.

Performing an 
Append edit of clip 
DD to the Timeline

RIPL O/WR (Ripple Overwrite)
At its simplest, Ripple Overwrite substitutes a clip in the Timeline with an incoming clip on the selected 
track. Place the playhead over the clip in the Timeline you wish to substitute with the one in the Source 
Viewer and press this key. This will automatically move all clips that are to the right of the affected clip 
in the Timeline either forward to make room, if the incoming clip is longer, or back to eliminate gaps, if 
the incoming clip is shorter.

Performing a Ripple 
Overwrite to substitute 
an entire clip at the 
playhead (BB) with the 
incoming clip (DD)
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CLOSE UP
Lets you edit a clip into the Timeline as a zoomed-in close up to make up for a lack of actual close ups 
that would have been shot with either longer lenses or by moving the camera closer to the subject. 
This function is particularly useful when you’re working with 4K media in a 1080 timeline, or 8K media 
in a 4K timeline, which enables you zoom into existing wide shots to create medium shots, or medium 
shots to create close up shots, with no loss of quality. 

Performing this edit adds the incoming clip as an approximate 20% to 40% zoomed close up and 
also performs a face detection. If a face or faces are found, it automatically re-positions the face top 
center in the frame. You can always reposition the close up manually using the Sizing controls in the 
Inspector.

How this key works depends on the mode that is active in the Cut page.

Source mode:

 — The selected clip in the Source Tape view is edited into the Timeline as a close up, with duration 
based on the In and Out points set in the clip and the Smart Indicator on the Timeline.

Timeline mode:

 — The clip under the playhead has a Close Up applied to it and is copied to the track above it, with a 
5 second duration starting from the playhead position.

Live Overwrite mode:

 — This will perform a Close Up on the selected camera as it’s overwritten into the Timeline.

 — The LED on this key will then illuminate to show you that this mode is armed.

In the Edit page, how this key works depends on if you are in the Source or Timeline Viewers.

Source Viewer:

 — The selected clip in the Source Viewer is edited into the Timeline as a close up on the next highest 
track. The duration is based on the In and Out points set in the clip, and inserted at the playhead 
position on the Timeline.

Timeline Viewer:

 — The clip under the playhead has a Close Up applied to it and is copied to the track above it, with a 
5 second duration starting from the playhead position.

(Top) Before a Close 
Up edit, (Bottom) After 
editing clip DD into the 
Timeline with a Close 
Up edit Place on Top
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PLACE ON TOP
Lets you edit the incoming clip as a superimposition above whatever other clips are in the Timeline; 
the incoming clip is always placed on top, so if there are clips in Tracks 1, 2, and 3, the incoming clip 
is automatically placed on Track 4, regardless of which track is selected. The frame the incoming clip 
aligns with depends on the following:

 — The incoming clip aligns to the playhead if no timeline In or Out points have been defined.

 — The incoming clip aligns with a timeline In point if one has been set.

 — The incoming clip’s Out point will align with a timeline Out point if one has been set without an 
In point. This “backtimes” the clip.

(Top) Before placing a 
clip on top, (Bottom) 
After editing clip DD 
into the Timeline with 
a Place on Top edit

SRC O/WR (Source Overwrite)
This edit requires overlapping timecode in multiple clips to work properly, such as when recording 
synced timecode to multiple cameras during a multi-cam shoot. If there is no overlapping timecode, 
this edit does nothing.

Press this key to automatically place a source clip with a marked In/Out region on top of a clip in 
the Timeline so that its timecode syncs with the timecode of the timeline clip, when you don’t know 
exactly how much of the incoming source clip you want to edit into the Timeline, and you just want it 
synced appropriately.

Search Dial Live Trimming Tools
Several of the most powerful features of the DaVinci Resolve Editor Keyboard involve the intuitive 
trimming controls afforded by the Search dial.

TRIM IN
When this key is pressed and held, it lets the user trim the In point of the clip in the Timeline under 
the playhead by simply rotating the Search dial back and forth. The trim point is highlighted in green. 
Release the key to confirm the edit.

In the Edit page, the target clip for the trim is prioritized by selection first, then by track order under 
the playhead.

In Source mode, holding this key and rotating the search dial adjusts the In Point of the clip in the Viewer.
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The Trimming tools

TRIM OUT
When this key is pressed and held, it lets the user trim the Out point of the clip in the Timeline under 
the playhead, by simply rotating the Search dial back and forth. The trim point is highlighted in green. 
Release the key to confirm the edit.

In the Edit page, the target clip for the trim is prioritized by selection first, then by track order under 
the playhead.

In Source mode, holding this key and rotating the search dial adjusts the Out Point of the clip in 
the Viewer.

ROLL
When this key is pressed and held, it lets the user trim the nearest edit point to the clip under the 
playhead, and roll the edit point back and forth between the clips by simply rotating the Search dial. 
The trim point is highlighted in green. Release the key to confirm the edit.

SLIP SRC (Slip Source)
When this key is pressed and held, it allows the user to slip the footage of the clip to the left of the 
nearest edit point to the playhead back and forth by moving the Search dial. A four way multiview will 
show the In and Out points for both source and destination clips as you slip. The clip that will slip will 
be highlighted in orange. Release the key to confirm the edit.

SLIP DEST (Slip Destination)
When this key is pressed and held, it allows the user to slip the footage of the clip to the right of the 
nearest edit point to the playhead back and forth by moving the Search dial. A four way multiview will 
show the In and Out points for both source and destination clips as you slip. The clip that will slip will 
be highlighted in orange. Release the key to confirm the edit. This operation will work on audio only 
edits in the Edit page, but no video multivew will be shown.

TRANS DUR (Transition Duration)
Holding down this key when a transition is under the Smart Indicator or playhead will allow you 
to change the duration of the transition using the search dial. Turning the dial left will shorten the 
transition and right will lengthen it. Once the duration is correct, release the key.

976Editing Effects and Transitions | Chapter 49 Using the DaVinci Resolve Speed Editor and Editor Keyboard



Transition Keys
This set of keys provide immediate shortcuts to the most commonly used transition commands.
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Transition keys

CUT
This key will change any existing transition to a simple cut at the Timeline edit point under the 
playhead. It will not add a new cut at the playhead position. To do this use the Split Clip (Command-\) 
function instead.

DIS (Dissolve)
This key will add a one second dissolve centered between the two shots at the Timeline edit point 
under the playhead. If there is another transition already present there, it will replace it.

SMTH CUT (Smooth Cut)
This key will add a Smooth Cut transition centered between the two shots at the Timeline edit point 
under the playhead. If there is another transition already present there, it will replace it.

Smooth Cuts are special-purpose transitions designed to make short jump cuts in the middle of 
a clip unnoticeable. This is done by using optical flow processing to match the same features on 
either side of a cut in order to automatically morph a subject from one position to another over the 
duration of the transition. 

The Smooth Cut effect works best on clips such as sit-down interviews and close-up head shots with 
a minimum of background and subject motion, and where the subject’s position on either side of 
the cut is not significantly different. A good example of when Smooth Cut is effective is when you’re 
cutting pauses, partial repeats, filler sounds such as “um” or “you know,” or other speech disfluencies 
out of an interview clip to tighten the dialog, and you want to eliminate the little “jump” that occurs at 
the cut without having to cut away to B-roll. Applying a short two or four frame Smooth Cut transition 
to the edit can make this kind of edit invisible, as long as the speaker doesn’t change position 
significantly during the cut. The more motion there is in the background of the shot, and the more 
the speaker changes position, the harder it will be to get a useful result using Smooth Cut. Although 
the default duration for any transition is one second, you’ll find that Smooth Cut transitions may work 
much better when they’re short; 2- to 6-frame Smooth Cut transitions often work best to disguise 
jump cuts. 
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Function Keys
The function keys of the DaVinci Resolve Editing Keyboard are by default mapped directly to their 
DaVinci Resolve commands. If you wish to use them as regular function keys (f1, f2, f3, etc.) you can 
hold the Fn key down and press the appropriate function key.
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The mapped Function keys

SYNC BIN (F1)
This key opens the Sync Bin in the Cut Page. This key does not function in the Edit page.

INSRT BLACK (Insert Black) (F2)
Pressing this key will add two seconds of black (via the solid color generator) to the selected track. This 
is used as filler for transitions where you want to replace the “nothing” of the empty timeline with an 
actual media clip. 

FREEZ (Freeze Frame) (F3)
Pressing this key will freeze the exact frame of the clip that is under the playhead for the remaining 
duration of that clip.

TRANS (Transition) (F4)
In the Cut Page, holding down this key brings up a drop-down menu of your available transitions 
in alphabetical order and an icon describing their shape. Rotating the Search dial left and right will 
navigate you through the list. When you find the transition that you want, simply release this key and it 
will be placed at the Timeline edit point as shown by the Smart Indicator.

This key does not function in the Edit page.

978Editing Effects and Transitions | Chapter 49 Using the DaVinci Resolve Speed Editor and Editor Keyboard



  

Drop-down Transition menu Picture-in-Picture options

PIC IN PIC (Picture in Picture) (F5)
In the Cut Page, holding this button down will open a drop-down menu that displays four picture-
in-picture placement options that you can navigate using the Search dial or numeric keyboard. This 
function will take the media that is in the Source Viewer, scale it to 1/8 size and place it on top of the 
original clip in the position that was selected in the drop-down menu. If you wish to change the drop-
down position, navigate over the clips, hold down this button and select another position.

SWAP (F6)
Press and hold the Swap key, and using the Search dial, move the clip under the playhead earlier or 
later in the Timeline, effectively swapping the moving clip with the one you are scrolling over.

TIP You can easily move entire scenes back and forth in your timeline by Command 
Selecting the all clips in the scene, holding down the Swap key (f6), and rotating the Search 
Dial. When the scene is in its correct place, release the key. (Edit page only).

VIDEO ONLY (F7)
In the Cut Page, press this key to only allow the video from your source clip into a video track on the 
Timeline. Press this key again to deactivate.

This key is inactive in the Edit Page.

AUDIO ONLY (F8)
In the Cut Page press this key to only allow the audio from your source clip into an audio track the 
Timeline. Press this key again to deactivate.

This key is inactive in the Edit Page.
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INSERT (F9)
An Insert edit splits whatever media is already in the Timeline at the position of the playhead and 
pushes that media to the right to make room for the incoming clip.

O/WR (Overwrite) (F10)
You can use the F10 key to perform an Overwrite edit, which overwrites a section of the Timeline 
with the incoming clip, without moving other clips in any way. The frame the incoming clip aligns with 
depends on the following:

 — The incoming clip aligns with the playhead if no timeline In or Out points have been defined.

 — The incoming clip aligns with a timeline In point if one has been set.

 — The incoming clip’s Out point will align with a timeline Out point if one has been set without an In 
point. This “backtimes” the clip.

REPL (Replace) (F11)
Replace edits are a unique three-point edit type that aligns the frame at the Source Viewer playhead 
with the frame at the Timeline playhead when the edit is executed. This is the fastest edit type to use 
when you need to align an action at a specific frame of video, or a sound at a specific frame of audio, 
to a particular frame’s action or sound in the video or audio of the Timeline.

The fastest way of using the Replace edit is to not bother setting either In or Out points in the Source 
Viewer, and to either use the duration of an existing clip intersecting the Timeline to define the edit, or 
a pair of timeline In/Out points specifying either a section of a clip you want to overwrite, or an empty 
section of the Timeline to which you want to edit.

Replace edits do not ripple the Timeline.

FIT TO FILL (F12)
Fit to fill edits are the only edit type that actually use all four edit points, and it’s the only edit type that 
retimes clips at the same time as they’re being edited. By setting In and Out points in the incoming 
source clip, and another pair of In and Out points in the Timeline, you can stretch or compress the 
timing of the specified range of source media to cover the entire specified range of the Timeline. In 
the process, the speed ratio of the clip changes so the clip plays in either fast or slow motion.

Fit to fill edits are especially valuable when you have a source clip in which the action is slightly slow, 
and you just want to speed it up by squeezing it into a shorter duration of the Timeline. They’re also 
incredibly handy in situations when you have a gap in an edited sequence of clips to fill with a source 
clip that’s just not long enough, but in which slightly slower motion won’t be noticeable.

Fit to fill edits do not ripple the Timeline.

RIPL DEL (Ripple Delete)
Pressing this key will delete the selected clip or clips, and then close any gaps that occur by rippling 
the Timeline to the left.

980Editing Effects and Transitions | Chapter 49 Using the DaVinci Resolve Speed Editor and Editor Keyboard



Timecode Entry
This numerical keypad has many timecode-specific keys that allow you to input these values directly 
into DaVinci Resolve to navigate to specific points in the Timeline, or move forward and backward in 
the Timeline by specific increments.

F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11 F12

Q W E R T Y U I O P [ ]{ } \ |

A S D F G H J K L ; : ‘ “

Z X C V B N M , . / ?><

!~ @ # $ % ^ & * ( ) – +

SMART
INSRT APPND RIPL

O/WR ESC

UNDO

TAB

CAPS LOCK

SHIFT

SYNC
BIN

INSRT
BLACK FREEZ TRANS PIC IN

PIC SWAP VIDEO
ONLY

AUDIO
ONLY INSERT O/WR REPL FIT TO 

FILL
RIPL
DEL

SRC/
TL

DYNAM
TRIM

EXTND
EDIT RETIME TRIM S/CLP

AFTER
EDT PT
TYPE IN OUT FULL

VIEW

NORML SLIP
SLIDE ENABL MATCH

FRAME FLAG HAND REV STOP FWD FIRST
FRAME

LAST
FRAME

PREV
KEY

NEXT
KEY

ZOOM MARK
CLIP

AUTO
COLOR

NRST
EDIT BLADE SNAP MARKR NUDGE

LEFT
NUDGE
RIGHT

PLAY
ARND

CLOSE
UP

PLACE
ON TOP

SRC
O/WR

SLIP
SRC

SLIP
SEXT

TRANS
DUR

TRIM
IN

TRIM
OUT ROLL

CRTLFn OPT
ALT

COMMAND CMD
STOP PLAY

RETURN

SHIFT

1 2 3 4 5 6 7 8 9 0 - = DELETE TRIM
EDITOR

DUR
ENTERHOME F/TC

TIME
CODE

CLIP
NAMECAM SOURCE

SHTL JOG SCRL

TIMELINEDATE
TIME

OUTIN

ENTER

DAVINCI RESOLVE EDITOR KEYBOARD

987

6 +

–

54

321

.000CUT DIS SMTH
CUT

F1 F2 F3 F4 F5 F6 F7 F8 F9 F10 F11 F12

Q W E R T Y U I O P [ ]{ } \ |

A S D F G H J K L ; : ‘ “

Z X C V B N M , . / ?><

!~ @ # $ % ^ & * ( ) – +

SMART
INSRT APPND RIPL

O/WR ESC

UNDO

TAB

CAPS LOCK

SHIFT

SYNC
BIN

INSRT
BLACK FREEZ TRANS PIC IN

PIC SWAP VIDEO
ONLY

AUDIO
ONLY INSERT O/WR REPL FIT TO 

FILL
RIPL
DEL

SRC/
TL

DYNAM
TRIM

EXTND
EDIT RETIME TRIM S/CLP

AFTER
EDT PT
TYPE IN OUT FULL

VIEW

NORML SLIP
SLIDE ENABL MATCH

FRAME FLAG HAND REV STOP FWD FIRST
FRAME

LAST
FRAME

PREV
KEY

NEXT
KEY

ZOOM MARK
CLIP

AUTO
COLOR

NRST
EDIT BLADE SNAP MARKR NUDGE

LEFT
NUDGE
RIGHT

PLAY
ARND

CLOSE
UP

PLACE
ON TOP

SRC
O/WR

SLIP
SRC

SLIP
SEXT

TRANS
DUR

CUT DIS SMTH
CUT

TRIM
IN

TRIM
OUT ROLL

CRTLFn OPT
ALT

COMMAND CMD
STOP PLAY

RETURN

SHIFT

1 2 3 4 5 6 7 8 9 0 - = DELETE TRIM
EDITOR

DUR
ENTERHOME F/TC

TIME
CODE

CLIP
NAMECAM SOURCE

SHTL JOG SCRL

TIMELINEDATE
TIME

OUTIN

ENTER

DAVINCI RESOLVE EDITOR KEYBOARD

987

6 +54

321

.000

–

The Numeric keypad and Timecode keys

How to Enter Timecode Values
When entering timecode, type each pair of hour, minute, second, and frame values from left to 
right, with a period representing a pair of zeros for fast entry. The numbers you enter appear in the 
timecode field at the upper right-hand corner of the Viewer with focus. When you’re finished typing, 
press the Return key to execute the Timecode command. The rules for timecode entry are as follows:

 — The right-most pair of timecode values (or period) you enter is always the frame number.

 — A period to the left or to the right of any number you type is considered to be a pair of zeroes. 

 — A single period between two numbers is considered to either be a single zero, or ignored if it’s 
between two pairs of numbers.

 — Any untyped pairs of values to the left of what you enter are assumed to be whatever those values 
were prior to the timecode you entered; this makes it easy to type partial timecode values even 
when the Timeline starts at hour one. 

 — It’s not necessary to enter colons or semicolons. 

Absolute Timecode Entry
Absolute timecode is entered simply by typing in a timecode value. So long as no clips or edit points 
are selected when you press the Return key, the playhead will move to that timecode value. If an 
edit point or clip is selected, those will be moved or trimmed to the corresponding timecode value, 
if possible.
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Here are some examples of absolute timecode entry using this method:

Original TC Value User-Typed Value New TC Value

01:10:10:10 15245218 15:24:52:18

01:10:10:10 2.. 01:02:00:00

01:10:10:10 15 01:10:10:15

01:10:10:10 12 01:10:10:12

01:10:10:10 1.2 01:10:01:02

01:10:10:10 1115.. 11:15:00:00

01:10:10:10 23... 23:00:00:00

Relative Timecode Entry
Relative timecode is entered by starting the timecode value with a plus (+) or minus (–). Adding a plus 
results in the value you type being added to the current timecode value for purposes of offsetting 
the playhead or moving a selection. Adding a minus will subtract the value you type from the current 
timecode value.

User-Typed Value Result

+20. 00:00:20:00 is added to the current timecode value.

+3.. 00:03:00:00 is added to the current timecode value.

-5 00:00:00:05 is subtracted from the current timecode value.

TRIM EDITOR
This key opens the Trim Editor on the Cut page at the edit point shown by the Smart Indicator and 
does not function in the Edit page.

HOME
This key functions like the standard home key. Hold down Fn+Home for the End Key.

F/TC (Frames/Timecode)
This key toggles between timecode (HH:MM:SS:FF) and frame count (23, 48, etc.) entry using the 
numerical keypad. For example, if you wanted to move forward 200 frames, you can press this key and 
then enter +200 and press the Enter key.

DUR ENTER (Duration Enter)
Press this key to quickly change the duration of a transition or a clip’s length by the exact number that 
you typed in. For example selecting a transition, typing -15, and pressing the Dur Enter key, decreases 
the length of the transition by 15 frames.

00
This key adds two zeros to the timecode input rather than a single zero, to make numerical 
entry faster.
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QWERTY Keyboard Commands
The standard QWERTY shortcut keys have been modified slightly. 
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QWERTY Keboard Commands

RETIME (R)
The Retime controls have been mapped to the letter R on the keyboard. This works both in the Cut 
and Edit pages.

FULL VIEW (P)
The full screen Viewer has been mapped to the letter P on the keyboard, and works in the Cut, Edit, 
Color and Fusion pages.

HAND (H)
This key allows you to select Hand or Pointer mode on the Viewer for repositioning of titles. This works 
on the Edit page only.  (At the time of this writing, this feature had not been implemented yet.)

ZOOM (Z)
This key will zoom to fit your media clip in the Viewer. This works in the Cut, Edit, and Color pages.

AUTOCOLOR (C)
This key will perform the Autocolor function on the clip that is underneath the playhead, or the 
selected timeline clip.

Using the Function (Fn) Key on the Editor Keyboard
There are three types of key actions mapped to the DaVinci Resolve Editor Keyboard. The Function 
(Fn) key in the lower left of the keyboard toggles these modes and each type of key action modifies 
the resulting commands. These key actions give you access to standard computer functions in your 
native OS.

 — Key Press: Simply pressing the key once. 

 — Fn + Key Press: Holding down the Fn key and then pressing another key. 

 — Tap Fn + Hold: Pressing the Fn Key once, then pressing Fn again and holding it down, then 
pressing another key. This is a total of three key presses.
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Editor Keyboard Function (Fn) 
Key Map

Key Press Fn + Key Press Tap Fn + Hold

SYNC BIN F1 DECREASE SCREEN BRIGHTNESS

INSERT BLACK F2 INCREASE SCREEN BRIGHTNESS

FREEZ F3 SHOW ALL WINDOWS

TRANS F4 SHOW ALL APPLICATIONS

PIC IN PIC F5 DECREASE KEYBOARD LED BRIGHTNESS

SWAP F6 INCREASE KEYBOARD LED BRIGHTNESS

VIDEO ONLY F7 PREVIOUS TRACK

AUDIO ONLY F8 PLAY/PAUSE

INSERT F9 NEXT TRACK

O/WR F10 MUTE

REPL F11 DECREASE VOLUME

FIT TO FILL F12 INCREASE VOLUME

UP ARROW PAGE UP PAGE UP

DOWN ARROW PAGE DOWN PAGE DOWN

LEFT ARROW HOME HOME

RIGHT ARROW END END

HOME END END

KEYPAD ENTER CALCULATOR CALCULATOR

DELETE FORWARD DELETE FORWARD DELETE

CAM PRINT SCREEN PRINT SCREEN

TIMECODE PAUSE PAUSE

DUR ENTER NUM LOCK NUM LOCK
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Using the Speed Editor and 
Editor Keyboard In Other 
DaVinci Resolve Pages
While primarily designed to be used in the Cut and Edit pages, some of the basic functionality of the 
Speed Editor and Editor Keyboard work in other pages in DaVinci Resolve as well.

Using the Keyboards in the Media Page
The basic transport controls: Shuttle, Jog, and Scroll, as well as the Search Dial work with the Viewer 
in the Media Page, as well as the Full View key. In addition the Editor Keyboard’s Sort Media Pool keys: 
Timecode, Camera, Date, and Clip Name work as expected.

Using the Keyboards in the Fusion Page
The only basic transport controls that work in the Fusion Page are Jog and Scroll, albeit in a limited 
fashion due to the computationally complex nature of Fusion.

Using the Keyboards in the Color Page
The basic transport controls: Shuttle, Jog, and Scroll, as well as the Search Dial work with the Viewer in 
the Color Page, as well as the Full View key.

Using the Keyboards in the Fairlight Page
The basic transport controls: Shuttle, Jog, and Scroll, as well as the Search Dial work with the Viewer in 
the Fairlight Page, as well as the Full View key. In addition the In/Out buttons function as expected.

Using the Keyboards in the Deliver Page
The basic transport controls: Shuttle, Jog, and Scroll, as well as the Search Dial work with the Viewer in 
the Deliver Page. In addition the In/Out buttons function as expected.

985Editing Effects and Transitions | Chapter 49 Using the DaVinci Resolve Speed Editor and Editor Keyboard



Chapter 50

Compositing 
and Transforms 
in the Timeline
The Edit page is also home to many of the compositing and 
transform effects found in DaVinci Resolve. 

Many of these kinds of effects can be imported into DaVinci Resolve, including composite modes, 
opacity settings, and clips using alpha channels. Once in DaVinci Resolve, you can make changes to 
these effects in the Edit page. Alternately, you can also use DaVinci Resolve’s controls to create effects 
from scratch.
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Composite Modes and 
Transparency Effects
Composite modes are effects that use various mathematical operations to combine one 
superimposed clip with another, relying on standard image processing math for each color channel 
whereby black pixels have a value of 0, white pixels have a value of 1, and descending levels of gray are 
represented by decimal point values (for instance, 0.5 represents 50% gray). When using composite 
modes to blend two clips together on the Timeline, the three color channels of each pair of pixels are 
combined using that particular composite mode’s math. The results can create transparency effects, 
increase image exposure, and combine multiple images in many creative and useful ways.

Two source clips combined with the Subtract composite mode

When using composite modes, it’s easy to push parts of the resulting image above the maximum or 
below the minimum values for brightness. However, this image data is not clipped, even through such 
areas of the picture may appear flat white or black. Out-of-range data as a result of a composite mode 
effect is preserved, and may be retrieved by later image processing operations in the Color page.

When you import XML project files, DaVinci Resolve imports whatever composite modes were used by 
clips in the original sequence. If necessary, you can then change a clip’s composite mode to one that 
will work better with whatever grade you’re creating. Of course, you can also add composite modes to 
clips that didn’t originally have them, adding new effects of your own. 

All composite modes interact with the Opacity slider (found below the Composite Mode pop-up 
menu in the Inspector) to make a clip more or less transparent in addition to compositing already 
being done.
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Composite modes can be used on clips that are superimposed over other clips in the Timeline. 
However, these composite modes are also available for use within a grade on the Color page using the 
Layer Mixer node, within which you can combine differently graded versions of an image in creative 
ways. For example, the Add and Overlay composite modes can be useful for creating glow effects, 
while Subtract and Difference can create more surreal effects.

Working with composite modes in the Edit page is simple.

To set or change a composite mode for any clip:

 — Select a clip in the Timeline, then open the Video Inspector and choose one of the options from 
the Composite Mode pop-up menu.

Composite mode and Opacity controls in the Timeline

To turn a clip’s composite mode off:

 — Select a clip in the Timeline, then open the Inspector and choose Normal from the Composite 
Mode pop-up menu.

More About Composite Modes
There are ten composite modes to choose from. For clarity, simple image math is used to help explain 
the available Composite Mode effects.

Normal
No image compositing is done. The topmost image on the Timeline or the bottom input of the Layer 
Mixer node occupies the entire frame.

Add
Each pair of pixels in both superimposed layers is added together. Layer order does not matter. This 
can result in a dramatic brightening of light areas of both images with areas of the picture that are 
blown out to maximum white, and this effect is often used by adding the brighter part of an image 
to itself to create hot glow effects. Image data going above 1.0 is preserved and may be retrieved 
by later color correction operations. On the other hand, black areas of either image do not alter the 
combined image at all (0 + n = n).

Color
Recombines two layers using HSL image components by combining the Luma of the bottom layer with 
the Hue and Saturation of the top layer.

Color Burn
Inverts the bottom layer, which is divided by the top layer, and the end result is itself inverted.
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Color Dodge
The bottom layer pixels are divided by the top layer, which has been inverted.

Darken
Each pair of pixels in each color channel is compared, and the darker of the two is the output. Layer 
order does not matter. Darken is useful when you want the darker features of both layers to take 
precedence, but the output for any given pixel may be a color that doesn’t actually exist for that pixel 
in either of the source layers.

Darker Color
For each pair of pixels, all three color channels from the bottom layer are added together, and all three 
color channels from the top layer are added together. These results are compared, and the darker 
pixel of the two layers is the output. Layer order does not matter. Darker Color is useful when you 
want the darker features of both layers to take precedence. Unlike the Darken composite mode, the 
result will always be a specific color from either the bottom or top layers.

Difference
The absolute value is taken of the top layer minus the bottom layer, and returned as the result, which 
is always a positive number. Layer order does not matter. This Blend mode is often used to compare 
two differently processed versions of the same image to see if there are any alterations, and how 
large they are.

Divide
Divides the bottom layer by the top layer. Any color divided by itself = 1.0, or white, while any color 
divided by white (1.0) = itself.

Exclusion
Similar to the Difference composite mode, but results in lower contrast.

Hard Mix
The R, G, and B channel values of the bottom layer are added to the R, G, and B channel values of the 
top layer. Layer order does not matter. Can result in extreme effects.

Hardlight
Hardlight is the opposite of Overlay. All bottom layer pixels above 50% are Multiplied, while all bottom 
layer pixels 50% and below are Screened.

Hue
Recombines two layers using HSL image components, by combining the Luma and Saturation of the 
bottom layer, with the Hue of the top layer.

Lighten
Each pair of pixels in each color channel is compared, and the lighter of the two is the output. Layer 
order does not matter. Lighten is useful when you want the lightest features of both layers to take 
precedence, but the output for any given pixel may be a color that doesn’t actually exist for that pixel 
in either of the source layers.
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Lighter Color
For each pair of pixels, all three color channels from the bottom layer are added together, and all three 
color channels from the top layer are added together. These results are compared, and the lighter 
pixel of the two layers is the output. Layer order does not matter. Lighten Color is useful when you 
want the lighter features of both layers to take precedence. Unlike the Lighten composite mode, the 
result will always be a specific color from either the bottom or top layers.

Linear Burn
Each pair of pixels is summed, and 1 is subtracted from the total. Layer order does not matter. Regions 
of white in one layer let the other layer show through, while colors and darker tones from both layers 
interact to tint or darken the resulting image.

Linear Dodge
Each pair of pixels is summed. This composite mode is identical to Add.

Linear Light
All regions where the bottom layer is above 50% are Linear Dodged so as to lighten these parts of the 
final result, while all regions where the bottom layer is below 50% are Linear Burned so as to darken 
these parts of the final result. This composite mode intensifies image contrast in the final result.

Luminosity
Recombines two layers using HSL image components by combining the Hue and Saturation of the 
bottom layer with the Luma of the top layer.

Multiply
Each pair of pixels is multiplied together. Layer order does not matter. This generally has the effect 
of emphasizing the darkest parts of both images in the resulting output; in particular black areas of 
either image are preserved (0 * n = 0) while white areas of either image have no effect on the output 
image (1 * n = n). Multiply is good for compositing darker elements in a field of white into an image, 
and can be used to emphasize the darkest parts of a noise, grain, or damage layer you’re blending 
with an image.

Overlay
Overlay combines useful aspects of both the Screen and Multiply composite modes, based on 
the pixel values of the bottom-most image on the Timeline; all bottom layer pixels above 50% are 
Screened, while all bottom layer pixels 50% and below are Multiplied. Overlay is an excellent composite 
mode for combining a layer of noise, grain, or damage imagery with another clip, as it combines both 
images in visually useful ways throughout the tonal range of shadows through highlights.

Pin Light
In regions where bottom layer pixels are below 50% gray, lighter pixels in the top layer are replaced 
by darker pixels from the bottom layer, and darker pixels in the top layer replace lighter pixels in the 
bottom layer, so that the darker half of the final image combines darker pixels from both layers. In 
regions where bottom layer pixels are above 50% gray, darker pixels in the top layer are replaced by 
lighter pixels from the bottom layer, and lighter pixels in the top layer replace darker pixels from the 
bottom layer, so that the brighter half of the final image combines lighter pixels from both layers.
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Saturation
Recombines two layers using HSL image components, by combining the Luma and Hue of the bottom 
layer, with the Saturation of the top layer.

Screen
The pixel values of each layer are inverted, then multiplied, and the result is itself inverted. Layer order 
does not matter. Screen is the inverse of Multiply, as it preserves the lightest parts of both images, 
and is useful when compositing lighter elements in a field of black into an image, and can be used to 
emphasize the lightest parts of a noise, grain, or damage layer you’re blending with an image.

Softlight
A less intense method of applying the Hardlight composite mode that results in a more even blend 
between the two layers.

Subtract
Within each pair of pixels, those of the bottom layer are subtracted from those of the top. This can 
result in dark areas of the image that hit flat black, but image data going below 0 is preserved and may 
be retrieved by later color correction operations.

Vivid Light
All regions where the bottom layer is above 50% are Color Dodged so as to lighten these parts of 
the final result, while all regions where the bottom layer is below 50% are Color Burned so as to 
darken these parts of the final result. This composite mode vastly intensifies both image contrast and 
saturation in the final result, for an extreme effect.

Unknown
When importing XML or AAF project files with composite modes that aren’t available in DaVinci Resolve, 
the Composite Mode pop-up menu is set to Unknown; practically, this is the same as Normal.

TIP: To quickly audition different composite modes, hover your pointer over a mode in the 
Composite Mode drop-down list. That particular composite mode will preview in the viewer.

Opacity
Each clip has an Opacity parameter, available in the Inspector, that lets you make it more transparent, 
in a range from 0 (totally transparent) to 100 (totally opaque). When set to a value less than 100, the 
selected clip is mixed with whatever clip is underneath it on the Timeline, according to the composite 
mode that’s currently used. If no clip appears underneath the Timeline, then the clip is mixed with black.

By keyframing this parameter, you can create more complicated fade to black effects or cross 
dissolves. Keyframing is covered in more detail in Chapter 53, “Keyframing Effects in the Edit Page.”

To change a clip’s opacity:

 — Select the clip you want to adjust, open the Composite controls in the Video Inspector, and set the 
Opacity slider to create the desired amount of transparency.
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Video Fader Handles
If you want to dissolve a clip to or from another clip, or to or from black, the traditional way to do 
so has been to use one of the transitions in the Effects Library. However, you can also use fader 
handles that appear at the beginning and end a clip when you position the pointer right over it. Fader 
handles are a fast, ubiquitous method of creating a fade to or from black. However, they also make 
it easy to fade to or from other clips that are underneath one that’s superimposed, as seen in the 
following screenshot.

Dragging a video fader handle on a clip in track V2

To use a fader handle, move the pointer over the clip you want to adjust, and when small white fader 
handles appear at the upper left and upper right of the video of the clip, drag them to the left or right 
for the duration you want the fade effect to last.

Fade In and Out to Playhead Commands
A pair of commands in the Trim menu let you use the playhead position over a clip to “Fade 
In to Playhead” or “Fade Out to Playhead.” This can be done for a single clip or for multiple 
superimposed clips. 

These commands work for both audio and video items, in both the Edit and Fairlight pages.

Alpha Channel Support
If a superimposed video or still image clip in the Timeline has an embedded alpha channel, that alpha 
channel automatically creates transparency within that clip, compositing it against whatever is in the 
track underneath. There’s no need for you to do anything for this to work. 

Superimposing a clip with an alpha channel above automatically 
composites that clip against the clip beneath it
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However, if you need to disable or alter the interpretation of an alpha channel for any clip, for example 
if a clip is being interpreted as having an alpha channel of the wrong type, you can right-click that clip, 
choose Clip Attributes from the contextual menu, and use the Alpha Mode pop-up menu of the Clip 
Attributes Video panel to correct the problem.

NOTE: If you’ve imported clips with alpha channels, those alpha channels can be rendered 
back out for Round Trip workflows. Choose a Format and Codec combination that supports 
alpha channel output, and turn on the Export Alpha checkbox in the Video panel of the 
Render Settings list.

Keying in the Timeline 
Using Resolve FX
You can pull keys directly in the Timeline using the Resolve FX Key filters. These are found in the 
Resolve FX section of the Open FX category, of the Effects Library. The filter options are 3D Keyer, 
HSL Keyer, and Luma Keyer. For more information about using Resolve FX Key filters, see Chapter 156, 
“Resolve FX Key.” Below is an example of using the Resolve FX 3D Keyer filter in the Timeline.

Setting Up a Green Screen 
(Chroma Key) on the Timeline
To set up a green screen composite, place your background video on a track underneath your 
foreground video, and drag the 3D Keyer onto the foreground clip.

To adjust the key’s parameters, click on the Effects icon in the Inspector to reveal the Keyer’s controls, 
and Select “Open FX Overlay” from the Transform Mode drop-down menu in the lower left of the 
Timeline Viewer, to allow the effect qualifiers to work on the Timeline Viewer.

To pull a Chroma Key in the Timeline using the 3D Keyer.

1 Superimpose your green screened foreground video on a track on top of your background video.

2 Put the Timeline Viewer in Open FX Overlay mode, using the drop-down menu at the lower left of 
the Viewer. This option allows you to use the effect GUI controls directly on the Viewer.

3 Drag the 3D Keyer from the Effects Library onto the foreground video. The 3D Keyer is a fast and 
high-quality keyer that’s easy to use, drawing strokes to identify the background and foreground 
of the image you’re trying to key.

4 Select the foreground video clip, and open the 3D Keyer from the Effects tab in the Inspector.

5 Click the Pick eye dropper icon in the Controls section, and click and drag across the green screen 
in the Timeline Viewer. A blue line will show you where you’ve selected, and the green screen 
should mostly become transparent.

6 Optional) Use the Add eye dropper (drawing blue lines), to click and drag over any parts of the 
green screen that are still not transparent. Use the Subtract eye dropper (drawing red lines) to 
add back any foreground elements that may have gone transparent by mistake.
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7 Turn on the Despill checkbox in the 3D Keyer to remove any green light (spill) that may have 
reflected onto your foreground subject from the green screen.

Applying the 3D Keyer to the News Anchor clip on the V2 Timeline; note that the “Open FX Overlay” 
mode on the Viewer is selected (circled), allowing you to use the Inspector Effect controls in the Viewer.

Using Resolve FX and Open FX Alpha 
for Track Compositing
DaVinci Resolve allows the direct use of the alpha channel from Resolve FX and Open FX plugins for 
compositing on the Timeline. If an effect creates transparency in the image, a “Use alpha” checkbox 
appears at the bottom of the effects parameters in the Effects tab of the Inspector. Checking this 
box immediately applies the alpha channel to the selected clip, compositing it over any background 
elements that appear in lower tracks. If more than one alpha-modifying effect is applied to a single 
clip, the alpha channels are mixed together.

The Use Alpha checkbox at the bottom 
of the Effects tab in the Inspector
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Transform and Cropping in 
the Video Inspector
DaVinci Resolve is a resolution-independent application. This means that, whatever the resolution of 
your source media, it can be output at whatever other resolution you like. This also means that you 
can freely mix clips of any resolution, fitting 4K, HD, and SD clips into the same timeline, and scaling 
each to fit the project resolution as necessary.

Your project’s resolution can be changed at any time, allowing you to work at one resolution, and 
then output at another resolution. This also makes it easy to output multiple versions of a program at 
different resolutions, for example, outputting both HD and 4K sized versions of the same program.

DaVinci Resolve has a powerful toolset for making geometric transforms, using advanced algorithms 
for optical-quality sizing operations. Within the Edit page, each clip has a set of transform parameters, 
principally for use in storing sizing data imported from AAF or XML when you turn on the “Use sizing 
information” checkbox. This has the advantage of keeping these imported Edit Transform settings 
separate from the Input Sizing parameters found on the Color page, which are typically used by the 
colorist to make pan and scan adjustments of various kinds.

Of course, you can also use these controls to create your own adjustments while working in the 
Timeline, zooming into clips, repositioning them to improve the composition, and so on. While there 
is some overlap between these parameters and those in the sizing palette of the Color page, they’re 
both separate sets of parameters, so you can keep each set of adjustments separate. 

When the time comes to output your program, the final resolution of each clip is calculated taking into 
account the original resolution of the source media, the timeline resolution, image scaling settings, 
Edit page transforms, and Color page transforms, so that the final resolution correctly uses the 
cleanest geometric transformation based on the maximum resolution available to each source clip.

Transform
The Video Inspector transform group includes the following parameters, which are also editable in the 
Edit Sizing mode of the Sizing palette in the Color page:

 — Zoom X and Y: Allows you to blow the image up or shrink it down. The X and Y parameters can 
be linked to lock the aspect ratio of the image, or released to stretch or squeeze the image in one 
direction only.

 — Position X and Y: Moves the image within the frame, allowing pan and scan adjustments to be 
made. X moves the image left or right, and Y moves the image up or down.

 — Rotation Angle: Rotates the image around the anchor point.

 — Anchor Point X and Y: Defines the coordinate on that clip about which all transforms 
are centered. 

 — Pitch: Rotates the image toward or away from the camera along an axis running through the 
center of the image, from left to right. Positive values push the top of the image away and bring 
the bottom of the image forward. Negative values bring the top of the image forward and push 
the bottom of the image away. Higher values stretch the image more extremely.
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 — Yaw: Rotates the image toward or away from the camera along an axis running through the 
center of the image from top to bottom. Positive values bring the left of the image forward and 
push the right of the image away. Negative values push the left of the image away and push the 
right of the image forward. Higher values stretch the image more extremely.

 — Flip Image: Two buttons let you flip the image in different dimensions.

 — Flip Horizontal control: Reverses the image along the X axis, left to right.

 — Flip Vertical control: Reverses the clip along the Y axis, turning it upside down.

Smart Reframe (Studio Version Only)
The Smart Reframe feature makes it easier to quickly reframe material across extreme aspect ratio 
changes. It’s useful for situations where you’ve shot a 16:9 horizontal video and find yourself needing 
to create a vertically-oriented 9:16 version for mobile phones and social media deliverables, or 
using 4:3 archival footage in a 2.39:1 widescreen movie. Smart Reframe can be used manually, or 
automatically executed using the DaVinci Resolve Neural Engine.

 — Object of Interest: Tools for selecting the subject that the resize will frame around.

 — Auto: DaVinci Resolve’s Neural Engine will analyze the clip and choose its most representative 
object. This will be the only option if more than one clip is selected for Smart Reframing.

 — Reference Point: Allows you to manually adjust a bounding box around the subject 
to reframe around.

 — Reframe: This button executes the Smart Reframe command. This can take some time depending 
on the length and number of clips.

Cropping
The Video Inspector has an additional set of cropping parameters:

 — Crop Left, Right, Top, and Bottom: Lets you cut off, in pixels, the four sides of the image. 
Cropping a clip creates transparency, so that whatever is underneath shows through.

 — Softness: Lets you blur the edges of a crop. Setting this to a negative value softens the 
edges inside of the crop box, while setting this to a positive value softens the edges outside 
of the crop box.

Dynamic Zoom
The Dynamic Zoom controls, which are off by default, make it fast and easy to do pan and scan 
effects to zoom into or out of a clip. Also, if you import a project from Final Cut Pro X with clips that 
use the Ken Burns effect, then those clip’s effects will populate the Dynamic Zoom parameters in 
DaVinci Resolve. Turning the Dynamic Zoom group on activates two controls in the Inspector that 
work hand-in-hand with the Dynamic Zoom onscreen adjustment controls you can expose in the 
Timeline Viewer (described below):

 — Dynamic Zoom Ease: Lets you choose how the motion created by these controls accelerates. 
You can choose from Linear, Ease In, Ease Out, and Ease In and Out.

 — Swap: This button reverses the start and end transforms that create the dynamic zoom effect.
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Stabilization
Image Stabilization is available for clips right in the Timeline. These controls let you smooth out or 
even steady unwanted camera motion within a clip. The analysis is performed in such a way as to 
preserve the motion of individual subjects within the frame, as well as the overall direction of desirable 
camera motion, while correcting for unsteadiness.

These are the same stabilizer controls found in the Color page’s Tracker palette (minus the tracker 
graph), and the resulting stabilization analysis is mirrored on the Color page, where you can see the 
data visualized on the graph, if necessary.

Stabilization controls found in the Edit 
page Inspector for each clip

A pop-up menu provides three different options that determine how the selected clip is analyzed and 
transformed during stabilization. You must choose an option first, before clicking the Stabilize button 
above, because the option you choose changes how the image analysis is performed. If you choose 
another option, you must click the Stabilize button again to reanalyze the clip.

 — Perspective: Enables perspective, pan, tilt, zoom, and rotation analysis and stabilization.

 — Similarity: Enables pan, tilt, zoom, and rotation analysis and stabilization, for instances where 
perspective analysis results in unwanted motion artifacts.

 — Translation: Enables pan and tilt analysis and stabilization only, for instances where only X and Y 
stabilization gives you acceptable results.

The other controls let you customize how aggressively the selected clip is stabilized.

 — Stabilization Toggle: The toggle control for the Stabilization controls lets you turn stabilization 
off and on to be able to compare the stabilized and unstabilized image.

 — Camera Lock: Turning on this checkbox disables Cropping Ratio and Smooth, and enables 
the stabilizer to focus on eliminating all camera motion from the shot in an effort to 
create a locked shot.

 — Zoom: When this checkbox is turned on, the image is resized by a large enough percentage to 
eliminate the blanking (black edges) that is the result of warping and transforming the image 
to eliminate unwanted camera motion. The lower a value Cropping Ratio is set to, the more 
DaVinci Resolve will need to zoom into an image to eliminate these blanked edges. If you turn 
this off, the image is not zoomed at all, and whatever blanking intrudes into the image is output 
along with the image, on the assumption that you’ll have dedicated compositing artists deal with 
eliminating this blanking by filling in the missing image data in a more sophisticated manner. 
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You may also leave this checkbox turned off if you’re planning on animating the Input Sizing Zoom 
parameter to dynamically zoom into and out of a shot being stabilized to eliminate blanking only 
where it occurs, using only as much zooming as is necessary for each region of the shot.

 — Cropping Ratio: This value limits how hard the stabilizer tries to stabilize, by dictating how much 
blanking or zooming you’re willing to accept in exchange for eliminating unwanted motion. 
A value of 1.0 results in no stabilization being applied. Progressively lower values enable more 
aggressive stabilization. Changing this value requires you to click the Stabilize button again to 
reanalyze the clip.

 — Smooth: Lets you apply mathematical smoothing to the analyzed data used to stabilize the clip, 
allowing camera motion in the shot while eliminating unwanted jittering. Lower values perform 
less smoothing, allowing more of the character of the original camera motion to show through, 
while higher values smooth the shot more aggressively. Changing this value requires you to click 
the Stabilize button again to reanalyze the clip.

 — Strength: This value is a multiplier that lets you choose how tightly you want to use the 
stabilization track to eliminate motion from a shot using the current analysis. With a value of 1, 
stabilization is maximized. Since some clips might look more natural with looser stabilization, 
choosing a number lower than 1 lets a percentage of the original camera motion show through. 
Zero (0) disables stabilization altogether. As an additional tip, you can invert the stabilization by 
choosing –1 when pasting a stabilization analysis from another clip to perform a match move 
based on the overall motion of the scene, and you can use a negative value either lower than 
0 or higher than –1 to under or overcompensate when inverting the stabilization, simulating 
the effects of parallax where foreground and background planes move together but at 
different speeds.

Lens Correction
The Lens Correction group (only available in Resolve Studio) has two controls that let you correct for 
lens distortion in the image, or add lens distortion of your own.

 — Analyze: Automatically analyzes the frame in the Timeline at the position of the playhead 
for edges that are being distorted by wide angle lens. Clicking the Analyze button moves the 
Distortion slider to provide an automatic correction. If you’re analyzing a particularly challenging 
clip, a progress bar will appear to let you know how long this will take.

 — Distortion: Dragging this slider to the right lets you manually apply a warp to the image that lets 
you straighten the bent areas of the picture that can be caused by wide angle lenses. If you clicked 
the Analyze button and the result was an overcorrection, then dragging this slider to the left lets 
you back off of the automatic adjustment until the image looks correct.

Retime and Scaling
The Retime and Scaling group has four parameters that affect retiming quality and clip scale:

 — Retime Process: Lets you choose a default method of processing clips in mixed frame rate 
timelines and those with speed effects (fast forward or slow motion) applied to them, on a clip-by-
clip basis. The default setting is “Project Settings,” so all speed-effected clips are treated the same 
way. There are three options: Nearest, Frame Blend, and Optical Flow, which are explained in more 
detail in the Speed Effect Processing section of Chapter 51, “Speed Effects.”
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 — Motion estimation mode: When using Optical Flow to process speed change effects or clips with 
a different frame rate than that of the Timeline, the Motion Estimation pop-up lets you choose 
the best-looking rendering option for a particular clip. Each method has different artifacts, and 
the highest quality option isn’t always the best choice for a particular clip. The default setting 
is “Project Settings,” so all speed-effected clips are treated the same way. There are several 
options. The “Standard Faster” and “Standard Better” settings are the same options that have 
been available in previous versions of DaVinci Resolve. They’re more processor-efficient and yield 
good quality that are suitable for most situations. However, “Enhanced Faster” and “Enhanced 
Better” should yield superior results in nearly every case where the standard options exhibit 
artifacts, at the expense of being more computationally intensive, and thus slower on most 
systems. The Speed Warp setting is available for even higher-quality slow motion effects using the 
DaVinci Neural Engine. Your results with this setting will vary according to the content of the clip, 
but in ideal circumstances this will yield higher visual quality with fewer artifacts than even the 
Enhanced Better setting. 

 — Scaling: Lets you choose how clips that don’t match the current project resolution are handled on 
a clip-by-clip basis. The default setting is “Project Settings,” so that all mismatched clips use the 
same method of being automatically resized. However, you can also choose an individual method 
of automatic scaling for any clip. The options are Crop, Fit, Fill, and Stretch; for more information 
see the 2D Transforms section of Chapter 149, “Sizing and Image Stabilization.”

 — Resize Filter: For clips that are being resized in any way, this setting lets you choose the filter 
method used to interpolate image pixels when resizing clips. Different settings work better for 
different kinds of resizing. There are four options:

 — Sharper: Usually provides the best quality in projects using clips that must be scaled up to fill 
a larger frame size, or scaled down to HD resolutions.

 — Smoother: May provide higher quality for projects using clips that must be scaled down to fit 
an SD resolution frame size.

 — Bicubic: While the Sharper and Smoother options are slightly higher quality, Bicubic is still an 
exceptionally good resizing filter and is less processor intensive than either of those options.

 — Bilinear: A lower quality setting that is less processor intensive. Useful for previewing your 
work on a low-performance computer before rendering, when you can switch to one of the 
higher quality options.

 — Other Resize Methods: A selection of specific resize algorithms is available if you need to 
match them to other VFX workflows.

Onscreen Controls for Transform, 
Crop, and Dynamic Zoom
You also have the option of transforming, cropping, or adding dynamic zoom effects to clips using 
the Transform/Crop/Dynamic Zoom button at the bottom left of the Timeline Viewer. These on-screen 
controls can also be selected by choosing an option from the View > Viewer Overlay submenu; these 
commands are not mapped to keyboard shortcuts by default, but you can make a manual mapping if 
there’s a mode you find yourself using regularly. The currently selected overlay can be toggled on and 
off by pressing Shift-` (Tilde), or by choosing View > Viewer Overlay > Toggle On/Off.
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Transform controls in 
the Timeline Viewer

Object Snapping in the Viewer
While dragging objects or dynamic zoom outlines to reposition them, snapping occurs at the X and Y 
center of the frame, as well as around the outer third of the frame. Holding the Shift key down while 
dragging a text object constrains movement to just the X or Y axis.

Using Onscreen Controls
For many, the onscreen controls provide a more intuitive experience for manipulating your clips.

To transform a clip using graphical controls in the Timeline Viewer:

1 Click the Transform/Crop button at the bottom left of the Timeline Viewer to turn it on; white is 
enabled, gray is disabled. When enabled, if no clips are selected in the Timeline, then the clip in 
the highest auto-select-enabled track that intersects the playhead will display onscreen transform 
controls. If a clip is selected, that specific clip can be transformed.

2 Do one of the following:

a) Choose the Transform mode from the pop-up menu, if necessary, to change modes. 
The appropriate onscreen controls appear to let you manipulate the clip with the mouse. 
When in Transform mode, you can drag anywhere within the clip’s bounding box to adjust pan 
and tilt, drag any diagonal corner to proportionally resize, drag any side to squeeze or stretch 
just width or height, or drag the center handle to rotate.

Onscreen controls for transforming in the Timeline Viewer
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b) Choose the Cropping mode from the pop-up menu. In this mode, each side has a 
handle for cropping.

Onscreen controls for cropping in the Timeline Viewer

c) Choose the Dynamic Zoom mode from the pop-up menu. In this mode, the green box shows 
the starting size and position of the animated transform, while the red box shows the ending 
size and position of the animated transform. Drag anywhere within either bounding box to 
adjust pan and tilt for either the start or the end of the animated effect, and drag any of the 
corners to adjust the size. A motion path appears to show the motion that’s being created. 
Adjusting the Dynamic Zoom controls automatically enables dynamic zoom in the Inspector.

Onscreen controls for transforming and cropping in the Timeline Viewer

3 If necessary, choose a smaller viewing percentage from the Timeline Viewer scale pop-up to 
better see the onscreen controls if you’re rescaling the image, or use the scroll control of your 
mouse, trackpad, or tablet to zoom out of the image.

4 When you’re finished, turn the Transform/Crop/Dynamic Zoom button off.
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Chapter 51

Speed Effects
You can import both linear and nonlinear speed changes from 
other applications, or you can create these effects from scratch in 
order to speed up or slow down clips in your programs. 

DaVinci Resolve has a comprehensive set of controls for creating these kinds of effects using 
dedicated Retime controls, curves, and specific edit types. Once created, DaVinci Resolve also provides 
different ways of processing these effects to create the smoothest possible playback.
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Speed Effects and Retiming
Speed effects describe any effect that speeds up, slows down, or otherwise changes the 
playback speed of clips in the Timeline. There are four basic ways you can create speed effects in 
DaVinci Resolve.

 — Importing speed effects: DaVinci Resolve is capable of reading linear speed effects from 
imported EDL, AAF, and XML projects, and nonlinear speed effects from XML and AAF project 
files. When speed effects are present, DaVinci Resolve plays clips at the specified speed. 
You can also create speed effects of your own using controls in the Edit page. There are two 
methods of adjusting clip speed: using the Change Speed dialog, and using the Retiming 
effect in the Timeline.

 — Creating speed effects using Fit to Fill edits: You can also change a clip’s speed in the Timeline 
by editing it using the Fit to Fill command, which retimes the clip to fit into an arbitrary duration in 
the Timeline of your choosing. For more information on using Fit to Fill, see Chapter 39, “Three- and 
FourPoint Editing.”

 — Creating freeze frames: You can use the freeze frame command to turn an entire clip into a 
freeze frame of a frame intersecting the playhead.

 — Creating simple linear speed effects: You can create simple fast or slow-motion speed effects 
by using the Change Clip Speed command, or by using the left and right handles of the Retime 
controls in the Timeline. Both of these methods are described in this section.

 — Creating variable speed effects: You can create much more complex variable speed effects, 
where the same clip speeds up or slows down multiple times by different amounts, using either 
the Retime controls, or one of the two different speed curves that are available. These methods 
are also covered later in this section.

Speed Effects and Audio
Any of the methods of creating linear speed effects that are available in DaVinci Resolve, 
including the Change Clip Speed command, the Retime controls, and the Fit to Fill edit, 
will retime a clip’s audio, without pitch correction on Linux and Windows, and with pitch 
correction on Mac OS X (Yosemite and above), along with its video. However, audio that 
accompanies variable speed effects will be muted.

Creating Freeze Frames
There are a few ways you can create a freeze frame, but the fastest is to position the playhead over the 
frame you want to be the freeze frame, and choose Clip > Freeze Frame, or press Shift-R. The entire 
clip becomes a freeze frame of the frame you parked the playhead over. 

If you want to disable the freeze frame effect, you can select the clip and use the Remove Attributes 
dialog to remove the speed effect, or you can simply open the Change Clip Speed dialog and turn the 
Freeze Frame checkbox off.
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Creating Simple Linear Speed Effects
If all you need to do is to make a clip play in slow motion, speed it up, reverse the clip, or create a freeze 
frame, you can apply a simple speed effect using either the browser or the Change Speed dialog.

To change a clip’s speed, do one of the following:

 — Select a clip, choose Clip > Change Clip Speed, and use the controls of the 
Edit Speed Change dialog.

 — Right-click a clip in the Timeline, choose Change Clip Speed, and use the controls of the 
Edit Speed Change dialog.

Change Clip Speed operations have the following options:

 — Change Clip Speed parameters: Changes the speed of the selected clip by whatever percentage, 
frame rate, or duration you like.

 — Ripple Sequence checkbox: If you want the speed change you’re about to make to ripple the 
Timeline, pushing or pulling all clips following the current one to accommodate the clip’s new size, 
then turn on the checkbox.

Speed effect parameters shown in the Speed dialog

 — Reverse Speed checkbox: Clicking this box sets the current speed to a negative value, reversing 
the motion of the clip.

 — Freeze Frame checkbox: Changes the entire clip to a freeze frame of whichever frame is at the 
current position of the playhead.

 — Pitch Correction checkbox: Checking this box will perform pitch correction on the audio 
attached to the clip so that while the audio duration is changed to match the picture speed, it will 
still sound natural. Be aware that pitch correction on large speed adjustments may not sound as 
good as pitch corrections made to small speed adjustments.

 — Maintain Timing/Stretch to fit radio buttons: Choosing Maintain Timing leaves any keyframes 
within the clip locked at their original position, while choosing Stretch Keyframes results in all 
Composite, Transform, and Cropping keyframes being compressed or stretched by the same 
percentage as the clip during a speed change.
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Speed Change Controls 
in the Video Inspector
You can also change the speed of your clip directly in the Video Inspector’s Speed Change controls. 
This method has the benefit of being available in both Cut and Edit pages.

 — Direction: Selects the desired motion of the clip, forward, backward, or freeze frame.

 — Speed %: Adjusting this slider changes the clips motion on a percentage basis. 
This value can be keyframed.

 — Frames Per Second: Adjusting this slider changes the clips motion by increasing or decreasing 
the number of frames per second to play the clip back at. This value can be keyframed.

 — Duration: You can directly select how long you want the clip to be by setting a specific duration 
here in HH:MM:SS:FF format. This will then automatically adjust the speed of the clip to playback all 
frames in that exact amount of time.

 — Ripple Sequence checkbox: If you want the speed change you’re about to make to ripple the 
Timeline, pushing or pulling all clips following the current one to accommodate the clip’s new size, 
then turn on the checkbox.

 — Pitch Correction checkbox: Checking this box will perform pitch correction on the audio 
attached to the clip so that while the audio duration is changed to match the picture speed, it will 
still sound natural. Be aware that pitch correction on large speed adjustments may not sound as 
good as pitch corrections made to small speed adjustments. 

The Speed Change controls in the Video Inspector

Clip Retiming Controls
Another method of altering clip speed in the Timeline is to apply the Retime effect. This method of 
clip retiming provides a convenient control overlay that you can use to adjust clip speed directly in the 
Timeline, and it also provides the controls that are needed for creating variable-speed effects.

To expose the Retime controls on a clip:

 — Select a clip, and choose Clip > Retime Controls (Command-R).

 — Right-click a clip and choose Retime Clip from the contextual menu.
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The Retime controls appear over that clip in the Timeline. They consist of a Retime control track 
running along the top of the clip with arrows that indicate the speed and direction of playback 
(the default blue right-facing arrows indicate normal 100% playback) and a Clip Speed pop-up menu at 
the bottom center of the clip, which also shows the current speed of the clip.

The Speed effect controls in the Timeline

Retiming an Entire Clip
The simplest way of using the Retiming effect is to change the playback speed of the entire clip, in the 
process rippling the rest of the Timeline to the right of the retimed clip as you increase its duration by 
stretching or compressing its duration.

To retime a clip by dragging:

 — Move the pointer to the left or right edge of the Speed Change name bar on top of the clip, and 
when it turns into a Retime cursor, drag either side to stretch or squeeze the clip to retime it.

To retime a clip by specific amounts:

1 Select a clip and press Command-R.

2 Click the pop-up next to the speed percentage text at the bottom of the clip.

3 Do one of the following:

 — Choose a new playback speed from the Change Speed submenu.

 — Choose reverse segment to make the clip play in reverse. Reverse speed is shown in the 
Retime control track as arrows facing left, instead of right.

To return a clip to its original speed:

 — Click the pop-up next to the speed percentage text at the bottom of the clip, 
and choose Reset to 100%.

Rippling or Overwriting the Timeline 
When Using Retime
Whether or not clips to the right in the Timeline will ripple to accommodate the change in duration 
resulting in speed changes you make with the Retime controls depends on whether you’re using 
the Selection tool/mode (in which case the Timeline won’t ripple), or the Trim tool/mode (in which 
case the Timeline will).
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Reading Clip Speed Arrows
When you retime a clip, the Clip Speed pop-up menu displays the current speed of the entire clip. 
Additionally, the arrows in the Retime control track show you the speed and direction of playback. 
When clip speed is slowed down below 100%, the Retime control track shows yellow playback triangles 
that are spaced farther apart. When clip speed is sped up above 100%, the Retime control track shows 
blue triangles that are bunched closer together. At 100% normal speed, the Retime control track 
shows blue, evenly spaced triangles, while left-facing blue arrows indicates reverse playback.

Three clips set to different speeds. From left to right, 100% speed, slow 
motion, and fast forward are indicated by the yellow arrows.

Creating Variable Speed Effects 
Using the Retime Controls
You can also use the Retime controls to insert freeze frames within the middle of a clip, and create 
other custom variable speed effects using speed points. Additional variable speed options include 
rewind and speed ramp effects, which automatically place speed points to create preset effects.

To create a freeze frame at a particular moment in time:

1 With the Retime controls exposed, move the playhead to the frame you want to freeze, within that 
clip. Ideally, this will be for an effect where you want a character in motion to suddenly stop at a 
particular frame.

2 Open the Clip Speed pop-up menu (the pop-up next to the speed percentage text at the bottom 
of the clip), and choose Freeze Frame. Two new speed points are added to the clip, defining a 
range within which the clip is frozen at that frame. This can be seen by the vertical red bars in 
the Retime control track. Past the second speed point, the clip resumes playback from the next 
frame forward.

Speed effect controls set to insert a momentary freeze frame within the clip
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3 Drag the second speed point forward or back to define the duration of the freeze frame. The 
result is that the clip plays normally up until the first speed point, then freezes on that frame until 
the second speed point, at which playback resumes.

To create variable-speed effects:

1 With the Retime controls exposed, move the playhead to the frame at which you want to change 
the speed of the clip, and choose Add Speed Point from the Clip Speed pop-up menu.

2 Move the playhead forward to the next frame at which you want the clip speed to change again, 
and add another speed point. It takes a minimum of two speed points to create a speed effect.

3 To alter the speed of the clip segment appearing between these two speed points, 
do one of the following:

 — Using the pointer, drag the top handle of the second speed point to the right to slow down clip 
playback, or to the left to speed up clip playback within just that segment. Doing this either 
shortens or lengthens the clip, and either overwrites or ripples neighboring clips depending 
on whether you’re using the Selection or Trim modes.

 — Also using the pointer, you can drag the bottom handle of any speed point to widen the range 
of the clip that plays at that particular speed. Doing this reallocates frames from before and 
after the speed segment being adjusted to keep all speed segments playing at the same 
speed, and this also shortens or lengthens the clip, but by a different amount.

 — Using the Clip Speed pop-up menu, choose a new speed for that segment from the 
Change Speed pop-up menu. You can also set any segment to play in reverse by choosing 
Reverse Segment.

4 To clear a speed point and eliminate that particular clip’s speed segment from the effect, choose 
Clear Speed Point from any Clip Speed pop-up menu to eliminate whichever speed point appears 
to its left.

When you create variable-speed effects, the arrows in the Retime control track can help you keep 
track of what you’re doing, and each segment’s speed pop-up shows you the actual numeric speed. 
The change in speed from each speed segment to the next is automatically eased, for a smooth 
transition from one speed to another.

Speed controls set to ramp among three different playback speeds; arrow spacing shows the timing

There are two additional sets of commands for creating preset speed effects that use multiple 
speed points.
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To add a rewind effect:

With a clip’s Retime controls exposed, open any Clip Speed pop-up menu and choose a preset 
percentage from the Rewind submenu. This results in two additional speed points being added after 
the rightmost speed point in the current segment, which creates the effect of the current segment 
playing in fast reverse for the chosen percentage, and then playing a second time from the beginning.

Speed effect controls before and after creating a “rewind” effect

To add a speed ramp:

With a clip’s Retime controls exposed, open any Clip Speed pop-up menu and choose one of the 
two options from the Speed Ramp submenu to replace the current speed effect with a series of 
five speed segments that start at 10% and increase progressively to 30%, 50%, 70%, and then 90%. 
Once created, you can drag the speed points to customize this effect to create whatever durations 
you require.

Speed effect controls set to create a gradual ramp from 0 to 100 percent playback speed
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Closing Retime Controls
When you’re finished creating your Retime effect, you can close the Retime controls so that clip 
assumes a normal appearance again. Closing the Retime controls has no effect on the timing of the 
clip, it just ensures you cannot accidentally modify the speed of the clip with the mouse.

To close the Retime controls in the Timeline:

 — Click the X button at the upper left-hand corner of the Retime control box.

 — Press the escape key.

 — Select the retimed clip, and either choose Clip > Retime Controls, or press Command-R.

When a retimed clip has its Retime controls hidden, a Retime badge appears to the left of that 
clip’s name in the Timeline. You can reopen the Retime controls whenever you need to make 
further changes.

The Speed Effect badge that 
shows a clip is being retimed

To reopen the Retime controls in the Timeline:

 — Select the retimed clip, and either choose Clip > Retime Controls, or press Command-R.

Once you’ve retimed a clip using the Retime effect, you can use that clip’s Retime Process parameter 
in the Inspector to define how that clip’s retiming is processed, using the low quality Nearest option, 
using Frame Blending, or using Optical Flow. 

Using Retime Curves
You can also optionally use curves to retime clips, either in conjunction with the Retime controls, or by 
themselves. For example, you can use the simpler retiming controls first to create the overall speed 
effect you need, and then use either of the available Retime Curves to create further refinements by 
adjusting Bezier curve handles to adjust the transition of one speed to another, or you can expose 
either of the Retime Curves first and use it to create your speed effect from scratch by adding and 
adjusting control points and curve segments. 
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The Retime Curves let you adjust the transition from one speed to another using handles

No matter how you like to work, the control points of each of the speed curves have a 1:1 
correspondence to the speed points that are exposed in the Retime controls, and curve segment 
modifications are mirrored by speed point adjustments in the Retime controls if you have both 
exposed at the same time. This means that, when creating complex variable retiming effects, it’s easy 
to drag whichever control most easily adjusts the quality of speed you require.

In addition, there are two kinds of Retime curves you can use for maximum flexibility. Which is best 
depends on what you’re more comfortable with, and on which will handle the type of motion you want 
to create more easily:

 — The Retime Frame curve exposes a diagonal line that represents a time graph. This is a type of 
curve found in many other post-production applications, in which the vertical axis represents 
each frame of that clip’s source media, and the horizontal axis represents each frame of playback 
in the Timeline. With the default diagonal graph, there is a one-to-one correspondence between 
each frame of source media and each frame of timeline playback; this represents 100% speed. 
However, adding control points lets you alter how source frames are mapped to the Timeline. 
For any two control points on the Retime Frame curve, so long as the control point at the left is 
lower than the control point at the right of a curve segment, there will be forward motion, with 
longer shallow curve segments creating slower motion, and steeper shorter curve segments 
creating faster motion in the clip. 

A diagonal Retime Frame curve with two segments: a long shallow segment to the left that 
creates slow motion, and a short steep segment to the right that creates fast motion
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 — If a curve segment has a left control point that’s higher than the right control point, then the 
motion will be reversed and that segment will play backward.

A Retime Frame curve with an inverted curve that creates reverse motion

 — The Retime Speed curve (seen below) exposes a flat line that represents 100% speed. Adding 
pairs of control points and dragging each segment to raise or lower it alters speed; you must drag 
the segments, not the control points themselves. Raising a curve segment shortens that segment 
and speeds up that portion of the clip, while lowering a curve segment lengthens that segment 
and slows down that portion of the clip. As you adjust each curve segment, a tooltip shows you 
the exact speed percentage that segment represents. You should note that it’s impossible to 
create reverse motion using the Retime Position curve; you need to use either the Retime controls 
or the Retime Speed curve described above.

A Retime Speed curve with two segments: a shorter one that creates 
fast motion, and a longer segment that creates slow motion
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Methods of working with speed curves:

 — To expose speed curves for a clip in the Timeline: Right-click a clip in the Timeline, and choose 
Retime Curve. The Curve Editor is exposed for that clip, and you can edit it as you would any other 
curve, adding moving, and deleting control points.

 — To switch between editing Retime Speed and Retime Frame curves: Use the Curve pop-up 
at the upper left-hand corner of the Curve Editor to check or uncheck the curves you want to be 
visible. Clicking on a curve within the editor makes that curve the currently edited one.

 — To close a speed curve: Clicking the Curve button at the right-hand side of the clip’s title bar in 
the Timeline toggles the curve open and closed.

As far as adding, removing, and smoothing control points on speed curves and adjusting curve 
segments, they work identically to any other curve in the Timeline. For more information, see 
“Keyframing in the Timeline and Curve Editor” in Chapter 53, “Keyframing Effects in the Edit Page.”

Speed Effect Processing
Once you’ve retimed a clip, you have the additional ability to change how the retimed clip is processed 
in order to improve its visual playback quality, especially in the case of clips that are slowed down. 
There are two ways you can set this. First, there’s a project-wide setting available in the Master 
Settings of the Project Settings. Secondly, you can change how clips are retimed via a per-clip setting 
available in the Inspector.

To change the Retime Process setting of an entire project:

1 Open the Project Settings and click to open the Master Settings panel.

2 Choose an option from the Frame Interpolation group Retime Process pop-up menu.

To change an individual clip’s Retime Process setting:

 — Select a clip, then open the Inspector and choose an option from the Retime Process pop-up in 
the Retime and Scaling group. If you choose Optical Flow, you can also choose an option from the 
Motion Estimation pop-up.

Here are the different options you have for processing speed effects:

 — Retime Process: Lets you choose a default method of processing clips in mixed frame rate 
timelines and those with speed effects (fast forward or slow motion) applied to them, on a clip-by-
clip basis. The default setting is “Project Settings,” so all speed effected clips are treated the same 
way. There are three options: Nearest, Frame Blend, and Optical Flow, which are explained in more 
detail in the Frame Interpolation section of Chapter 4, “System and User Preferences.”

 — Nearest: The most processor efficient and least sophisticated method of processing; frames 
are either dropped for fast motion, or duplicated for slow motion.

 — Frame Blend: Also processor efficient, but can produce smoother results; adjacent duplicated 
frames are dissolved together to smooth out slow or fast motion effects. This option can 
provide better results when Optical Flow displays unwanted artifacts.

 — Optical Flow: The most processor intensive but highest quality method of speed effect 
processing. Using motion estimation, new frames are generated from the original source 
frames to create slow or fast motion effects. The result can be exceptionally smooth when 
motion in a clip is linear. However, two moving elements crossing in different directions or 
unpredictable camera movement can cause unwanted artifacts.
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 — Motion estimation mode: When using Optical Flow to process speed change effects or clips with 
a different frame rate than that of the Timeline, the Motion Estimation pop-up lets you choose 
the best-looking rendering option for a particular clip. Each method has different artifacts, and 
the highest quality option isn’t always the best choice for a particular clip. The default setting is 
“Project Settings,” so all speed effected clips are treated the same way. There are several options. 

 — “Standard Faster” and “Standard Better” are the same options that have been available in 
previous versions of DaVinci Resolve. They’re more processor-efficient and yield good quality 
that are suitable for most situations. 

 — “Enhanced Faster” and “Enhanced Better” should yield superior results in nearly every case 
where the standard options exhibit artifacts, at the expense of being more computationally 
intensive, and thus slower on most systems. 

 — “Speed Warp” is available for even higher-quality slow motion effects using the DaVinci 
Neural Engine. Your results with this setting will vary according to the content of the clip, but 
in ideal circumstances this will yield higher visual quality with fewer artifacts than even the 
Enhanced Better setting. This setting is only available on a clip-by-clip basis; it’s not available 
in the Project Settings.

Optical Flow Quality Settings 
Affecting Speed Effects
The “Motion estimation mode” pop-up in the Master Settings panel of the Project Settings let you 
choose the tradeoff between quality and processing speed to use when processing optical flow-based 
slow motion and frame rate retiming effects. The “Standard Faster” and “Standard Better” settings 
are the same options that have been available in previous versions of DaVinci Resolve. They’re more 
processor-efficient and yield good quality that are suitable for most situations. However, “Enhanced 
Faster” and “Enhanced Better” should yield superior results in nearly every case where the standard 
options exhibit artifacts, at the expense of being more computationally intensive, and thus slower on 
most systems.

1014Editing Effects and Transitions | Chapter 51 Speed Effects



Chapter 52

Subtitles and 
Closed Captioning 
DaVinci Resolve supports subtitles and closed captioning in 
sophisticated ways, and the inclusion of automatic subtitling tools 
dramatically reduces the time and effort required to build accurate 
subtitle tracks.

With dedicated subtitle/closed caption tracks that can be shown or hidden, subtitle file import 
and export, sophisticated subtitle editing and styling at the track and clip level, and comprehensive 
export options, adding subtitles and closed captions to finish your project is a clear and 
straightforward workflow.
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Subtitles and Closed 
Captioning Support
Subtitles are supported in DaVinci Resolve using specially typed subtitle tracks containing specifically 
designed subtitle generators to add and edit subtitles for a program. Typically each subtitle track 
corresponds to a single language or use, and you can change the name of a subtitle track to 
reflect its contents. 

Subtitle tracks can be locked, have Auto Select controls, and can be enabled or disabled like any other 
track. Additionally, a special subtitle-only destination control lets you choose which subtitle track 
to edit subtitle clips into. Furthermore, subtitle generator clips can be resized, moved, edited, and 
overwritten like most other clips.

Subtitle track with lock, Auto Select, 
and enable/disable controls

Viewing Subtitle/Caption Tracks
One important difference between subtitle tracks and other kinds of tracks is that only one subtitle 
track can be visible at any given time. That means if you have multiple subtitle tracks, each for a 
different language, clicking the Enable control for one subtitle track disables all others.

Viewing one subtitle track at a time

Adjusting QC Thresholds For Subtitle/Caption Timing
To help you adhere to guidelines that specify the recommended duration, line length, and speed 
of captions and subtitles, the Subtitles panel of the Project Settings has parameters you can set to 
warn you when a particular subtitle clip exceeds thresholds of Characters Per Line, Minimum Caption 
Duration, and Maximum Characters Per Second.
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The Subtitles Setup parameters in the Subtitles panel of the Project Settings

As you edit a subtitle clip, these thresholds are used to automatically calculate how many lines and 
characters are allowable for a particular subtitle clip given its duration. For example, if you exceed the 
calculated threshold, the CPS value of that caption turns red to warn you.

 

The CPS value of a subtitle has turned red 
because it exceeds the current QC threshold

Adjusting QC Thresholds for Individual Subtitle Tracks
While setting the QC thresholds for subtitles in the Project Settings is usually fine for a single 
deliverable, those deliverables with multiple subtitle tracks in different languages may need different 
parameters for each track, allowing longer line lengths, time on the screen, etc. for the unique 
characteristics of each language.

To individually adjust the subtitle settings per track:

1 Select the subtitle track you want to change in the Timeline.

2 Open the Inspector, and select the Track tab.

3  In the Subtitle Settings pane, uncheck Use Project Settings.

4  Make any necessary adjustments to the Max Line Length, Min Duration, and Max CPS controls.

These settings will now override the Subtitle Project Settings for the selected track only. 
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The Subtitle Settings in the Track pane 
of the Inspector lets you customize 
parameters for individual subtitle tracks.

Importing Subtitles and Captions
Oftentimes, adding subtitles or closed captions to a DaVinci Resolve timeline will involve importing 
a subtitle file that’s been prepared elsewhere. Currently, DaVinci Resolve supports subtitle files in 
multiple formats such as .srt, .vtt, .xml, and .ttml.

To import a subtitle or closed captioning file using the Media Pool:

1 Open the Media Pool.

2 Navigate to the folder containing your subtitles. Compatible subtitles will show up as a blank clip 
icon with a subtitle icon in the lower left corner.

3 Add the subtitle to the Media Pool by dragging, importing via the contextual menu, or any other 
method identical to adding video clips into the Media Pool.

To import a subtitle or closed captioning file using the Import Subtitle function:

1 Open the Media Pool.

2 Right-click on any bin in the Bin list, or anywhere in the background of the Media Pool browser, 
and choose Import Subtitle.

3 In the resulting file dialog, find and select the subtitle file you want to import, and click Open.

4 The subtitle file appears as a subtitle clip in the Media Pool, ready for editing into a subtitle track. A 
badge indicates that it’s a subtitle clip.

An imported .srt subtitle file

TIP: Subtitle files can be relinked in the Media Pool, just like video clips.
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To add a subtitle clip to the Timeline:

1 To add a subtitle clip to a timeline automatically and match its position via timecode:

 — Right click on the subtitle and select “Insert Selected Subtitles to Timeline Using Timecode.”

The subtitle clip will decompose into individual subtitles appearing in the subtitle track, and each 
subtitle will be aligned with the timeline’s timecode.

2 To add a subtitle clip to a timeline manually if you don’t have matching timecode, 
do one of the following:

 — Drag a subtitle file you’ve imported into the unused gray area at the top of your video tracks, 
and a subtitle track will automatically be created for adding those subtitles into

 — Drag a subtitle file you’ve imported into a pre-existing subtitle track

As you drag the subtitle clip, it’ll immediately be decomposed so that each title is added to the 
Timeline as an individual subtitle clip, with its timing offset relative to the position of the first 
frame of the first subtitle in that file. 

The original Timeline

The Timeline after dragging a subtitle file has created a new subtitle track

3 Position the imported subtitles so that they align with the first frame of your program that they’re 
supposed to, and drop the titles into the track. If you inadvertently misplace the subtitles, don’t 
worry, you can always select them all and slide them earlier or later, just like any other clips.

4 If you’ve added a new subtitle track, you can rename it to identify what language and country that 
track corresponds to. Please note that subtitle track names are used when exporting or encoding 
subtitles, so please make sure your tracks are named appropriately prior to export/delivery.

5 If you want to restyle all of the subtitles you’ve just added, for example to make them smaller or 
change the font, then click on the header of the subtitle track you’ll be working on, open the Track 
panel of the Inspector, and select the formatting you want that track to use.

To see a list of every subtitle clip you’ve added, you can select the header of the subtitle track you’ve 
just added and open the Captions panel in the Inspector. A list at the bottom of the Captions panel 
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gives you a convenient way of navigating the subtitles in a given track (using the Prev and Next 
buttons) and making selections. If you set the Inspector to be full height, you’ll have even more room 
for browsing the subtitle list.

The Captions list shows you every caption or subtitle on a track, 
for selecting, editing, deleting, or navigating

Adding Subtitles and 
Captions Manually
Other times, you may need to create subtitles on your own. Before doing so, you’ll need to add one 
or more subtitle tracks. Once those tracks are created, you can add subtitle generators to them in a 
variety of ways. You can add as many subtitle tracks as you need, one for each language you require.

To add new subtitle tracks:

 — Right-click in any track header of the currently open timeline, and choose Add Subtitle Track. 
An empty subtitle track will appear at the top of the Timeline, named “Subtitle 1,” and if Subtitle 
Tracks were hidden, they’re now shown. Once you’ve added a new subtitle track, you can rename 
it to identify what language and country that track corresponds to. Please note that subtitle 
track names are used when exporting or encoding subtitles, so please make sure your tracks are 
named appropriately prior to export/delivery.

You can show and hide subtitle tracks in case you need to free up room in the Timeline for 
working on other tracks. Subtitles on the currently selected subtitle track continue to be visible, 
however, regardless of whether or not the subtitle tracks are shown.
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Showing and hiding subtitles tracks:

 — Open the Timeline View options, and click on the Subtitle button to toggle the visibility of subtitles 
tracks on and off.

The show/hide subtitle tracks button 
in the Timeline View Options

To add individual subtitles to a subtitle track:

1 If you want to adjust the default style of a particular subtitle track before you start adding 
subtitles, then click on the header of the subtitle track you’ll be working on, open the Track panel 
of the Inspector, and select the formatting you want that track to use.

2 If you have multiple subtitle tracks, click the destination control of the subtitle track you want to 
add titles to. They’re labeled ST1, ST2, ST3, etc.

3 Move the playhead to the frame where you want the new subtitle to begin.

Positioning the playhead where you want a new subtitle to begin

4 To add a new subtitle clip, do one of the following:

 — Open the Inspector and click Create Caption in the Captions panel of the Inspector. If there’s 
already one or more captions in that subtitle track, click the Add New button above the 
caption list, instead.

 — Right-click anywhere on the subtitle track and choose Add Subtitle to add a subtitle clip 
starting at the position of the playhead

 — Open the Effects Library, click the Titles category, and drag a Subtitle generator to the Subtitle 
track you want it to appear on.

Manually adding a subtitle
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5 If necessary, you can now edit the clip to better fit the dialog that’s being spoken or the sound 
that’s being described, by dragging the clip to the left or right, or dragging the beginning or end 
of the clip to resize it.

6 While the new subtitle clip you’ve created is selected, use the Captions panel in the Inspector to 
type the text for that particular subtitle. The text appears on the subtitle clip as you type it.

Editing the text of the subtitle we just created

Every time you add a subtitle, an entry is added to the subtitle list at the bottom of the Captions panel 
in the Inspector. This list gives you another convenient way of navigating the subtitles in a given track 
(using the Prev and Next buttons) and making selections.

Create Subtitles from Audio  
(Studio Version Only)
Due to recent advances in AI and expert system technologies, it’s become possible to get remarkably 
accurate and perfectly timed subtitles of spoken text using DaVinci Resolve’s Create Subtitles from 
Audio function. Create Subtitles from Audio will analyze the speech in a timeline and automatically 
create a subtitle track with all the spoken dialog converted into text subtitle clips.

Create Subtitles from Audio just doesn’t directly translate phonetic speech to text. It will also correctly 
analyze the context of that speech and translate that into proper punctuation and grammar for the 
subtitle. For example, Create Subtitles from Audio will pick out proper names and capitalize them, 
it will add a question mark to the end of sentence if your subject is asking a question, it will add 
quotation marks in the correct locations if your subject is quoting something, and if it detects music 
in the background, it will add a [Music Playing] subtitle. It handles accents and knows when there are 
multiple people speaking in the same scene. You may find it surprising just how accurate the Create 
Subtitles from Audio tool can be.
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Create Subtitles from Audio fully automates the subtitling process.

To Create Subtitles from Audio for a timeline:

1 Open the Timeline you want to Create Subtitles from Audio in the Edit page.

2 Select an In-Out range for the subtitles on the Timeline, or leave blank to Create Subtitles from 
Audio  for the entire Timeline.

3 Select Timeline > Create Subtitles from Audio.

4 In the Create Subtitles from Audio dialog, select the following options:

 — Language: The language of the spoken text. Auto lets DaVinci Resolve detect the language 
automatically.

 — Caption Preset: The Caption Preset style you wish the subtitles to be formatted to.

 — Max Characters per Line: The maximum number of characters per line in the subtitle. Larger 
numbers create longer lines of text on the screen. Smaller numbers create shorter lines of text.

 — Lines: Sets the choice between a single line or double lines of text for the subtitle. 

 — Gap Between Subtitles: The amount of frames inserted between subtitle clips. 0 is the default.

5 Click the Create button.
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The Create 
Subtitles from 
Audio options

Create Subtitles from Audio will then start to transcribe the spoken text, and a dialog box will show 
you its progress. When it’s finished, the resulting subtitles will be added to the Subtitle track. If there 
is no Subtitle track on your Timeline, it will automatically make one for you. If there is more than 
one subtitle track on your Timeline, Create Subtitles from Audio will always use the highest track 
to write to.

The one area where the Create Subtitles from Audio tool will still commonly fail is having overlapping 
dialog clips on multiple tracks. To work around this, you can mute any audio track on the Timeline you 
don’t want used in the subtitle analysis.

Once the Create Subtitles from Audio is complete, you can manually edit the captions to fix any minor 
errors using the tools described above in the Adding Subtitles and Captions Manually section.

Create Subtitles from Audio Language Support
As of this writing, Create Subtitles from Audio supports the following languages:

 — Chinese (Simplified Mandarin), Danish, Dutch, English, French, German, Italian, Japanese, Korean, 
Norwegian, Portuguese, Russian, Spanish, and Swedish.

Editing Subtitles and Captions
Subtitle clips can be selected singly or together, and slipped, slid, resized, rolled, and rippled just 
like any other clip in the Timeline, using the mouse or using keyboard commands, with either the 
Selection, Trim, or Razor tools. You can select subtitle clips in their entirety, or just their edit points, in 
preparation for nudging or dynamic trimming. In short, subtitle clips can be edited, in most ways, just 
like any other clips.

Styling Subtitles and Captions
When it comes to styling subtitle text, there are a wealth of styling controls in the Track Style panel 
of the Inspector.

To modify the styling of all titles on a particular subtitle track:

1 Click on the header of the subtitle track you’ll be working on, or select a clip on a particular subtitle 
track either in the subtitle track or in the subtitle list of the Captions panel in the Inspector.

2 Open the Inspector, and then open the Track panel that appears within.
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3 Edit whatever parameters you need to set the default style of all subtitles and closed captions that 
appear on that track. The Track panel has many more options than the Captions panel, including 
a group of Style and Position controls over Font and Font Face, Color, Size, Line Spacing, and 
Kerning, Alignment, Position X and Y, Zoom X and Y, Opacity, and Text Anchoring.

The Track Style panel of the Inspector sets 
styling for every subtitle on that track

Keep in mind that there are additional groups of controls that let you add a Drop Shadow, Stroke, 
and/or Background to all text on that track, which can be found at the bottom of the Track panel of 
the Inspector.

You can also modify the look of each subtitle clip individually, even down to changing a single 
word or letter, regardless of the settings in the Track panel.

To modify the styling of a single subtitle on a particular subtitle track:

1 Select a clip on a particular subtitle track, either in the subtitle track or in the subtitle list of the 
Captions panel in the Inspector.

2 Select the Customize Caption check box under the Caption.

3 Edit whatever parameters you need to set the style of only this single subtitle. All other titles in the 
track will remain in the original track style.

To modify the styling of a single word or words in a particular subtitle:

1 Select a clip on a particular subtitle track, either in the subtitle track or in the subtitle list of the 
Captions panel in the Inspector.

2 Select the Customize Caption check box under the Caption.

3 Highlight the text that you want to change in the Caption panel.
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4 Edit whatever parameters you need to set the style of the highlighted text on this subtitle. 
All other titles in the track will remain in the original track style.

Checking the Customize Caption box reveals the tools for 
changing the look of an individual subtitle or text.

Using Subtitle Track Style Presets
If you want to save and re-use a specific subtitle style, you can add it to the Subtitle Style Preset menu, 
accessed by clicking on the Subtitle option menu (3 dots) in the upper right corner of the Subtitle 
Inspector. You can also export and import presets to share a subtitle style between systems.

To add a new subtitle style preset:

1 Create a subtitle track and adjust its style in terms of fonts, position, colors, etc. 

2 Click on the option menu (3 dots) in the upper right corner of the Subtitle Inspector.

3 Select Save Track as Preset from the drop-down menu.

4 Give your preset a new name.

Your subtitle style preset will now appear in the Subtitle Inspector’s option menu.

To change a subtitle track to another style preset:

1 Select an existing subtitle track that you want to change. 

2 Click on the option menu (3 dots) in the upper right corner of the Subtitle Inspector.

3 Select the subtitle style preset from the drop-down menu.

4 Select Load Preset from the submenu.

Your subtitle track will instantly be updated to the new style preset. This command is undoable.
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To update a subtitle style preset:

1 Load a subtitle style preset from the Subtitle Inspector option menu. 

2 Make any changes you need to the style in terms of fonts, position, colors, etc. 

3 Click on the option menu (3 dots) in the upper right corner of the Subtitle Inspector.

4 Select the subtitle style preset you wish to update from the drop-down menu.

5 Select Update Preset in the submenu.

6 Select Update from the dialog box.

Your subtitle style preset will replace the existing preset of the same name. There is no undo for 
this action.

To delete a subtitle style preset:

1 Click on the option menu (3 dots) in the upper right corner of the Subtitle Inspector.

2 Select the subtitle style preset you wish to delete from the drop-down menu.

3 Select Delete Preset in the submenu.

4 Select Delete from the dialog box.

The subtitle style preset will be removed from the Subtitle Inspector’s option menu. There is no 
undo for this action.

To export a subtitle style preset:

1 Click on the option menu (3 dots) in the upper right corner of the Subtitle Inspector.

2 Select the subtitle style preset you wish to export from the drop-down menu.

3 Select Export Preset in the submenu.

4 Choose the location to save the “.preset” file from the file browser.

5 Press Save.

The subtitle style preset file will be saved to the user’s computer. The file will have the name of the 
preset with a .preset extension.

To import a subtitle style preset:

1 Click on the option menu (3 dots) in the upper right corner of the Subtitle Inspector.

2 Select Import Preset in the submenu.

3 Choose the location of the “.preset” file from the file browser.

4 Press Open.

The subtitle style preset will be added to the Subtitle Inspector’s option menu.

The Subtitle Style Preset menu, found in the 
option menu of the Subtitle Inspector
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Linking Subtitles to Clips
If you like, you can link one or more subtitles to their accompanying clip, so that if you re-edit 
a subtitled scene, each clip’s subtitles move along with the clips. This arrangement doesn’t always 
work the way you’d expect when trimming, but it works great when you’re rearranging clips.

To link a subtitle to another clip:

1 Select a clip and its subtitles all at once.

Selecting a video clip and its 
accompanying subtitle to link them

2 Choose Clip > Linked Clips (Option-Command-L). A Link icon appears to show 
that the subtitle clips are linked to the video/audio clip.

The now linked clip and subtitle have 
link badges to show their state

Using Subtitles in Nested Timelines
Subtitles will come across with their original timelines as part of a nested timeline. Simply drag one 
subtitled timeline either from the Media Pool or Source Viewer into a new timeline. If you want to add 
the subtitles of the original timeline to the new timeline’s caption list, you must Decompose in Place 
the nested timeline.
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Subtitle Regions
Occasionally you will need to display multiple subtitles on the screen at the same time. A common 
example of this is having two characters on screen with overlapping dialog. By arranging the subtitles 
appropriately, their position on the screen can indicate which person is speaking each subtitle.

Subtitle regions allow you to have multiple subtitle clips active and overlapping at the same time, while 
still being contained in a single overall subtitle track.

Adding and Deleting Subtitle Regions
By default, all subtitles created in a subtitle track are in Region 1 (R1) at the base layer of the track. If 
you wish to add another subtitle region you must create a new subtitle region in the subtitle track. You 
can have a maximum of three subtitle regions (R1, R2, R3) for any subtitle track, meaning you can have 
up to three separate subtitles on screen concurrently.

To add a new subtitle region:

1 Right click inside the current subtitle track (not the track header, but timeline track itself).

2 Select Add Subtitle Region. This will split the subtitle track horizontally and create a new region.

To delete a subtitle region:

1 Right click inside the current subtitle track (not the track header, but timeline track itself).

2 Select Delete Subtitle Region, and select the region you want to delete from the submenu.

  

Adding and deleting subtitle regions from the subtitle track

Using Subtitle Regions
Once multiple regions are created, you can treat the subtitle track like a separate mini-timeline with 
four layers. Each subtitle region has its own Captions list and Style settings, including font choice, 
and most importantly, text position. This allows you to set up, say, the default region as your normal 
subtitle layout, Region 2 for characters on the left hand side of the screen, and Region 3 for characters 
on the right. 

When more than one region overlaps each other in the subtitle track, all subtitles at that position will 
be visible. You can move a caption from region to region by dragging the subtitle clip up or down 
inside the subtitle track.
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For the example below there are two subtitles on a standard subtitle track. However, these two lines 
are delivered in the same two-shot with both actors slightly overlapping each other, so it makes more 
sense to see both subtitles at the same time rather than sequentially.

By adding an additional subtitle region and positioning the subtitle clip in the timeline exactly where 
the actress steps on the actors line, you can link the timing of the caption to better reflect the 
performance in the scene. Additionally, the new subtitle region’s text position was changed to appear 
on the right hand side of the frame where the actress delivering the line is located. This helps indicate 
which of the two actors is saying each line.

The initial sequential subtitle track

The same subtitle track but with a new region added, allowing both subtitles to be show concurrently
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Naming Subtitle Tracks
If necessary, you can double-click the name of any subtitle track to rename it to something more 
descriptive of what that subtitle track will contain, such as the language, and whether a particular track 
is for subtitles or closed captions.

Depending on your workflow and delivery specifications, there are existing conventions for identifying 
languages, such as ISO-639-1 (governing 2-letter codes) or ISO-639-2/B (governing 3-letter codes). 
These codes can be found at the International Organization for Standardization website, at  
http://www.loc.gov/standards/iso639-2/php/code_list.php. 

Some naming conventions require both language code and country code. For example, Facebook 
requires SubRip (.srt) files with the naming format “VideoFilename.[language code]_[country code].srt” 
for proper embedding.

If you want to use these codes for subtitle track identification and output, here’s a representative list 
of standardized language and country codes from around the world, in alphabetical order:

Language
ISO 639-1  
Language Code

ISO 639-2  
Language Code

ISO 3166-1  
Country Code

Amharic am amh ET (Ethiopia)

Arabic ar ara

EG (Egypt)

AE (United Arab Emirates)

LB (Lebanon)

Bengali bn ben IN (India)

Chinese zh
chi (B)

zho (T

CN (China)

HK (Hong Kong)

TW (Taiwan)

Danish da dan DK (Denmark)

Dutch nl
dut (B)

nld (T)
NL (Netherlands)

English en eng

GB (UK)

IN (India)

US (US)

Finnish fi fin FI (Finland)

French fr
fre (B)

fra (T)

CA (Canada)

FR (France)

German de
ger (B)

deu (T)
DE (Germany)

Greek Modern el
gre (B)

ell (T)
GR (Greece)

Hausa ha hau
NG (Nigeria)

TD (Chad)

Hebrew he heb IL (Israel)

Hindi hi hin IN (India)

Indonesian id ind ID (Indonesia)
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Language
ISO 639-1  
Language Code

ISO 639-2  
Language Code

ISO 3166-1  
Country Code

Italian it ita IT (Italy)

Japanese ja jpn JP ( Japan)

Malay ms
may (B)

msa (T)
MY (Malaysia)

Maori mi
mao (B)

mri (T)
NZ (New Zealand)

Norwegian no nor NO (Norway)

Polish pl pol PL (Poland)

Portuguese pt por
BR (Brazil)

PT (Portugal)

Punjabi pa pan IN (India)

Russian ru rus RU (Russia)

Spanish Castilian es spa

CO (Columbia)

ES (Spain)

MX (Mexico)

Swahili sw swa KE (Kenya)

Swedish sv swe SE (Sweden)

Tagalog tl tgl PH (Philippines)

Thai th tha TH (Thailand)

Turkish tr tur TR (Turkey)

Urdu ur urd PK (Pakistan)

Vietnamese vi vie VN (Vietnam)

Exporting Subtitles and 
Closed Captions
Once you’ve created one or more subtitle tracks filled with subtitles or captions, there are a few 
different ways you can export subtitles once you’ve created them.

Exporting Subtitles Via the File Menu
Choose File > Export Subtitle, and use the export dialog to choose a location and file type for the 
exported subtitle file. You can export subtitles in the .srt and .vtt formats.

Exporting Subtitles Via the Subtitle Track Header
Right-click on the track header of a subtitle track, and choose Export Subtitle from the contextual 
menu. Use the export dialog to choose a location and file type for the exported subtitle file. You can 
export subtitles in the .srt and .vtt formats.
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Exporting, Burning, or Embedding 
Subtitles During Delivery
When you’ve set up one or more subtitle tracks in a program, the Deliver page exposes a group of 
Subtitle Settings at the bottom of the Video panel of the Render Settings that control if and how 
subtitles or closed captions are output along with that timeline.

Available options for exporting subtitles can be found at 
the bottom of the Video panel of the Render Settings

This panel has the following controls:

 — Export Subtitle checkbox: Lets you enable or disable subtitle/closed caption output.

 — Format pop-up: Provides four options for outputting subtitles/closed captions.

 — As a separate file: Outputs each subtitle track you select as a separate file using the format 
specified by the Export As pop-up. A set of checkboxes lets you choose which subtitle tracks 
you want to output.

 — Burn into video: Renders all video with the currently selected subtitle track 
burned into the video.

 — As embedded captions: Outputs the currently selected subtitle track as an embedded 
metadata layer within supported media formats. There is currently support for CEA-608 
closed captions within MXF OP1A and QuickTime files. You can choose the subtitle format 
from the Codec pop-up that appears.

 — Export As: (only available when Format is set to “As a separate file”) Lets you choose the subtitle/
closed captioning format to output to. Options include IMSC1, DFXP, SRT, and WebVTT.

 — Include the following subtitle tracks in the export: (only available when Format is set to 
“As a separate file”) A series of checkboxes lets you turn on which subtitle tracks to output.

 — Codec: (only available when Format is set to “As embedded captions”) Lets you choose how to 
format embedded closed captions; choices include Text and CEA-608.

NOTE: Neither analog (Line 21) nor digital (CEA-708) closed caption output via Decklink or 
UltraStudio is supported at this time.
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Chapter 53

Keyframing Effects 
in the Edit Page
The Edit page also provides controls for keyframing effects that 
you add to your timeline, as well as a curve editor to fine-tuning the 
motion effects you create right in the Editing Timeline.
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Keyframing Effects in the Edit Page
Most parameters in the Inspector of the Edit page can be keyframed, in order to create animated 
effects such as zooming in via the Zoom parameter, fading out via the Opacity parameter, or cropping 
from one side to reveal a clip underneath via the Cropping parameters. Additionally, if you import 
a project from an NLE that has keyframed sizing settings, those keyframes will be imported and 
exposed within the Edit page of DaVinci Resolve.

The primary controls for keyframing are within the Video Inspector. Any parameter that can be 
keyframed has a gray keyframe button to the right of its slider. If the playhead is on a keyframe, this 
button turns orange and small  navigation arrows appear to its right and left, otherwise it stays gray.

Orange buttons in the Inspector show keyframe usage. 
Zoom shows the playhead parked on the current keyframe with 
additional keyframes set before and after this one as indicated 
by the gray navigation arrows. Position shows the playhead 
parked on the only keyframe set (orange diamond, no arrows), 
and Rotation Angle shows no keyframe set (gray diamond).

Once you’ve keyframed one or more parameters within a particular group in the Inspector, that 
clip displays a pair of small buttons at the far right of its name bar in the Timeline, a Curve button 
and a Keyframe button. Only keyframed clips have these buttons.

The Keyframe track button 
in the Timeline appearing 
on a keyframed clip

To expose a clip’s keyframe tracks, do one of the following:

 — Click the Keyframe button for that clip, at the bottom right corner of the clip. 

 — Choose Clip > Show Keyframe Editor (Shift-Command-C)

Each group of parameters in the Inspector reveals a single, aggregated keyframe track, that holds all 
the keyframes of all the parameters within that group, and makes it easy to move, delete, cut, copy, 
and paste keyframes for each clip. For example, the Pan, Tilt, Zoom, Rotation Angle, and Anchor Point 
keyframes all appear within the Transform track.

1035Editing Effects and Transitions | Chapter 53 Keyframing Effects in the Edit Page



A keyframe track for all of the Transform group parameters

If you want to edit each parameter independently, a small disclosure control at the right of each 
keyframe track lets you open up an aggregated keyframe track into individual keyframe tracks, 
one for each parameter that’s been keyframed within that group of Inspector controls.

Clicking a keyframe track’s disclosure control reveals individual keyframe 
tracks for each keyframed parameter in the Inspector

Additionally, each keyframed clip has a Curve button that, when clicked, exposes that parameter 
within a Curve Editor that’s attached to the clip in the Timeline. 

A clip’s Curve button, used 
to open the Curve Editor 
for that particular clip

To expose a clip’s Curve Editor:

 — Click a clip’s Curve button, at the bottom right corner of the clip.

 — Choose Clip > Show Curve Editor (Shift-C).

Multiple parameters can be opened within the Curve Editor at the same time, and you can choose 
which curve to work on by clicking it in the Curve Editor, or clicking one of that parameter’s keyframes 
in the keyframe track above. Selected control points can be moved, and their Bezier interpolation 
changed using one of the four buttons located at the top of the Curve Editor.
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Keyframing in the Video Inspector
Keyframing in the Cut and Edit pages works slightly differently than when using the Keyframe Editor in 
the Color page. Most simple keyframing tasks can be performed in the Inspector using three buttons 
that appear to the right of any parameter that’s capable of being keyframed. It takes two keyframes at 
minimum to create an animated effect.

The three keyframe controls that 
appear in the Inspector, from left 
to right: Previous keyframe, Create/
Delete keyframe, Next keyframe

Methods of keyframing parameters in the Inspector:

 — To add a keyframe: Select a clip, open the Inspector, then move the Timeline playhead to 
the frame where you want to place a keyframe, and click the Keyframe button next to the 
parameter of the Inspector you want to animate. Once you’ve added at least one keyframe to a 
parameter, all other adjustments you make to parameters in the Inspector, or using the onscreen 
Transform/Crop controls in the Timeline Viewer add new keyframes automatically if the playhead 
is at another frame.

 — To move the playhead to the next or previous keyframe: Click the small left- or right-
hand arrow to either side of a parameter’s keyframe control to jump the playhead to the next 
or previous keyframe. You can also press Right-Bracket ( [ ) and Left-Bracket ( ] ) to go from 
keyframe to keyframe.

 — To edit an existing keyframe of a parameter: Move the playhead to be on top of the keyframe 
you want to edit, and then change that parameter, either in the Inspector, or using the onscreen 
controls of the Timeline Viewer.

Methods of changing keyframe interpolation in the Inspector:

 — To change a keyframe to Ease In or Ease Out: Eased keyframes create animated changes that 
begin slowly and accelerate to full speed, or slow down gradually to decelerate to a stop. This only 
works when you have two or more keyframes creating an animated effect. Move the playhead to 
a frame with a keyframe using the next/previous keyframe controls, then right-click the orange 
keyframe button and choose Ease In, Ease Out, or Ease In and Out, depending on which keyframe 
you’re editing and the effect you want to create.

 — To change a keyframe to Linear: Move the playhead to a frame with a keyframe using the next/
previous keyframe controls, then right-click the orange keyframe button and choose Linear.

Methods of deleting keyframes and disabling keyframed effects:

 — To delete a single keyframe: Open the Inspector, move the Timeline playhead to a frame with a 
keyframe, and click the orange Keyframe button in the Inspector to delete it.

 — To delete all keyframes for one parameter: Click the reset button to the right of a parameter’s 
keyframe control in the Inspector.
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 — To delete all keyframes in a group of parameters in the Inspector: Click the reset button to 
the right of a parameter group’s title bar in the Inspector.

 — To disable or enable a single parameter’s keyframed effect: In the Timeline, click the 
toggle control at the left of a parameter’s keyframe track. White means that track’s enabled. 
Gray is disabled.

 — To disable or enable a group of parameters in the Inspector: Click the toggle control at 
the left of a parameter group’s title bar in the Inspector. Orange means that group is enabled. 
Gray is disabled.

Keyframing Motion Paths 
in the Timeline Viewer
If you’re keyframing a clip’s transform controls to create motion, a motion path appears when you turn 
on the onscreen transform controls using the button to the left of the transport controls.

A visible motion path resulting from animated Position X and Y parameters

Each keyframed change to the Position X and Y parameters creates a control point on the surface of 
the motion path, which is linear by default, creating a sharp edge. However, you can right-click any 
control point and choose Smooth from the contextual menu to add Bezier handles to that control 
point, which let you change the sharp angle to an adjustable curve.

Changing the linear control 
point into a Bezier curve

1038Editing Effects and Transitions | Chapter 53 Keyframing Effects in the Edit Page



The control points making up any motion path can be dragged around at will to change the path 
the selected clip will travel. Dots on the surface of the motion path indicate the velocity of motion; 
dots that are closer together indicate slower motion, while dots that are farther apart indicate 
faster motion. Dragging a motion path control point farther away from another one will speed up 
the animation between both points, while dragging it closer will slow the animation down, as you’re 
setting up the selected clip to travel a longer or shorter distance within the same keyframed time.

Dots on the motion path show that the left half has 
slow motion, while the right half has faster motion

You can also adjust the shape of any control point’s curve by clicking to select that control point, 
which exposes its Bezier handles, and then dragging the handles to adjust its curve. Once handles 
have been exposed, there are a variety of methods you can use to adjust them and manipulate the 
motion path.

Finally, you can adjust the acceleration of motion by adjusting the Acceleration handle on the stem 
of any Bezier curve. Dragging an acceleration handle towards a control point creates an eased 
keyframe, where motion slows to a stop, or begins from a stop. Dragging an acceleration handle away 
from a control point creates more linear motion, where the object moves continuously through that 
control point.

An acceleration handle on the Bezier handle of a curve lets you create eased 
motion by dragging it in towards the control point being adjusted
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Methods of adjusting the Bezier handles of motion paths:

 — Drag any control point to reshape the motion path.

 — Drag any Bezier handle to change the shape of the curve.

 — Command-drag any Bezier handle to break the tangent between it and the opposite Bezier 
handle. When you release the Command key, the two Bezier handles become locked together 
again at whatever angle you created.

To eliminate a control point on a motion path, along with its keyframe:

 — Right-click any control point and choose Delete Keyframe.

To switch a control point between sharp and curved angles:

 — Right-click any control point and choose Linear (for a sharp angle) or Smooth (for a curve).

Keyframing in the Edit Timeline 
and Curve Editor
You can use keyframes directly in the the Timeline, or if you need to do more complicated keyframe 
editing than the relatively simple controls of the Inspector and Timeline allow, you can use the 
Keyframe tracks and Curve Editor found in the Edit Timeline. When one or more clip parameters are 
keyframed, two small buttons appear at the far right of a clip’s name bar in the Timeline, a Curve 
button and a Keyframe button. These buttons let you access specialized keyframe editors that serve 
different purposes.

Keyframe Directly in the Timeline During Playback
Keyframes can be added directly on clips in the Timeline while playing back. You can add and delete 
keyframes to a clip using keyboard shortcuts, and DaVinci Resolve will try to intelligently predict the 
context of the clip to set the appropriate key frame.

This method allows you to quickly and precisely add retime and audio gain Keyframes during playback 
and then come back and manipulate the points you specified.

To Add a Keyframe to a Clip in the Timeline:

 — Playback the clip on the Timeline and when the playhead is over the frame of the clip where 
you want to add the keyframe.

 — Choose Mark > Add Keyframe (Command-[).

To Delete a Keyframe in a Clip in the Timeline:

 — Select the keyframe or keyframes you want to delete from the clip.

 — Choose Mark > Delete Keyframe (Option-]).

While adding a keyframe on the timeline clip is a simple keyboard press, how does DaVinci Resolve 
know what specific parameter from all the options available in the inspector you wanted to 
keyframe? Essentially the keyframes are now context aware, meaning which keyframable attribute 
(Zoom, Position, Volume, etc.) is selected by DaVinci Resolve depends largely on the last item you 
manipulated, or falling back to the most commonly used.
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The keyframe selection hierarchy in DaVinci Resolve runs through the keyframable options from top to 
bottom; if no keyframe makes sense in the context of the top entry, it automatically chooses the next 
one down the list, and so on.

The DaVinci Resolve Keyframe Selection Order:

 — The Retime Controls (if already active)

 — The active effect curve in the Keyframe Editor (if already open)

 — The last Inspector control that was manipulated

 — Audio Gain

For example, if you previously adjusted the Zoom parameter on a clip, then added a new keyframe to 
the clip by pressing Option-[ , it would bypass the Retime Controls, the Effect Curves if those controls 
were closed in the inspector, and add a new Zoom keyframe, as that was the last tool manipulated. 
This also means that when you add a keyframe to a basic clip on a timeline with no modifications, it 
adds an Audio Gain Keyframe.

If you want to do more complex keyframing, or DaVinci Resolve is not picking up on the context 
correctly, you can use the Keyframe Editor.

The Keyframe Editor
The Keyframe Editor in the Timeline is the most powerful way of exposing all of a clip’s keyframes and 
adjusting their timing and interpolation. It’s only available when you’ve already keyframed one of a 
clip’s Inspector properties. 

To open or close the Keyframe Editor:

 — Click a clip’s Keyframe button at the far right of a clip’s name bar.

 — Select a clip and choose Clip > Show Keyframe Editor (Command-Shift-C).

The Keyframe track button 
in the Timeline appearing 
on a keyframed clip

The Keyframe Editor exposes one keyframe track for each group of parameters that’s keyframed. 
For example, the Composite parameters, Transform parameters, and Cropping parameters are all 
encapsulated by group tracks. For example, if you’d added keyframes to the Zoom and Position 
parameters, these keyframes all appear within a single keyframe track labeled Transform, while 
Opacity adjustments appear on a second keyframe track for Composite.
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Group keyframe tracks open in the Timeline

However, each group keyframe track has a disclosure button that lets you show or hide each 
individual parameter that’s keyframed within that group. For example, clicking the Transform 
keyframe track’s disclosure button shows the Zoom and Position tracks, so you can adjust those 
individual keyframes.

Individual parameter keyframe tracks open in the Timeline

These keyframe tracks let you edit keyframes in context of the actual clip durations in the 
Timeline. Click the small Keyframe button at the bottom right of the clip’s name bar to close the 
keyframe tracks when you’re finished.

Methods of adding and selecting keyframes in the Keyframe Editor of the Edit page:

 — To add new keyframes to the Keyframe Editor: Press Command-[ or Option-click anywhere on 
a track of the Keyframe Editor to add a new keyframe, which defaults to whatever the current value 
is for that parameter at that frame. New keyframes create linear animated changes by default.

 — To duplicate one or more keyframes: Make a selection of keyframes, then hold the Option 
key down and drag the selected keyframes to duplicate them and move the duplicates 
to a new position.

 — To select a single keyframe: Click a single keyframe to select it.

 — To select multiple discontiguous keyframes: Command-click all keyframes you want to select, 
whether they’re next to one another or not.

 — To select multiple contiguous keyframes: Click the first keyframe you want to select, and 
then shift-click the last keyframe you want to select, and all keyframes between will also be 
selected, or drag a bounding box within the keyframe track around multiple keyframes to select 
them all at once.
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Methods of changing keyframe interpolation/easing/smoothing in the 
Keyframe Editor of the Edit page:

 — To change one or more Linear keyframe to Ease In or Ease Out: Eased keyframes create 
animated changes that begin slowly and accelerate to full speed, or slow down gradually to 
decelerate to a stop. This only works when you have two or more keyframes creating an animated 
effect. Select one or more keyframes, then right-click one of the selected keyframes and choose 
Ease In, Ease Out, or Ease In and Out, depending on which keyframe you’re editing and the effect 
you want to create.

 — To change one or more eased keyframes to Linear: Select one or more keyframes, then right-
click one of the selected keyframes and choose Linear.

Methods of moving and adjusting keyframes in the Keyframe Editor of the Edit page:

 — To move one or more keyframes: Select one or more keyframes and drag left or right. While you 
drag keyframes, a tooltip appears showing you the offset in frames of your adjustment from the 
beginning of that clip’s source media. If you’re only dragging one keyframe, the tooltip also shows 
you the name of the parameter you’re modifying.

 — To nudge selected keyframes one frame at a time: Select one or more keyframes and press 
Command-Left Arrow or Command-Right Arrow to nudge them back and forth, for precision 
editing. The Curve Editor must also be open.

Methods of Cutting, Copying, Pasting, and Deleting keyframes:

 — To cut or copy, and paste one or more keyframes: Make a selection of keyframes, and use the 
Cut (Command-X) or Copy (Command-C) key shortcuts. Then, move the playhead to where you 
want the first of the copied keyframes to start, and press Paste (Command-V). The Curve Editor 
must also be open.

 — To delete one or more control points from a curve: Select the keyframe(s) you want to delete 
and press Backspace, or press Option-]. The Curve Editor must also be open.

The Curve Editor
If you want to work with keyframes in even more detail, you can use the Curve Editor. The Curve Editor 
can be opened in addition to the Keyframe Editor, or it can be opened in isolation. When clicked, the 
Timeline expands to accommodate a large space under an animated clip in which you can freely adjust 
both the timing and value of selected keyframes, while also providing optional bezier spline controls 
used to create smooth curves with which to adjust the acceleration of animated changes from one 
value to another.

To open or close the Curve Editor:

 — Click a clip’s Curve button at the far right of a clip’s name bar.

 — Select a clip and choose Clip > Show Curve Editor (Shift-C).
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The Curve Editor open in the Timeline

You can open multiple parameters into the Curve Editor using the curve pop-up menu at the 
upper left-hand corner of the Curve Editor that lets you choose which parameters are exposed via 
checkboxes. This menu also lets you choose which curve is selected by clicking the name of the 
parameter you want to edit.

Choosing which parameters to 
display in the Curve Editor
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While you can only work on one curve at a time, you can choose which is selected for editing by either 
selecting it in this pop-up menu or by clicking any dimmed curve in the Curve Editor. Using the control 
points exposed by each curve, you can edit parameters, alter keyframe timing, and change each 
control point’s interpolation to create custom easing effects affecting the acceleration of change from 
one keyframe to the next.

Methods of adding and selecting keyframes in the Curve Editor of the Edit page:

 — To change which curve you’re editing: If the Keyframe Editor is open at the same time as the 
Curve Editor, you can click the keyframe track you want to edit and the corresponding curve 
will be highlighted. Otherwise, click the Curve menu at the upper left-hand corner of the Curve 
Editor, and choose which curves you want to expose to work on. If multiple curves are open in the 
Curve Editor, click any dimmed curve in the background to highlight it for editing. If the clip you’re 
editing is too narrow, then the Curve menu may be hidden; zooming into the Timeline will show 
the Curve menu again.

 — To add new keyframes to a curve: Option-click anywhere on a curve to add a new control point.

 — To duplicate one or more keyframes: Make a selection of keyframes, then hold the Option 
key down and drag the selected keyframes to duplicate them and move the duplicates to a new 
position (and even new values). This can be a good way to quickly loop a repetitive animated 
effect you’ve created.

 — To select a single keyframe: Click a single keyframe to select it.

 — To select multiple discontiguous keyframes: Command-click all keyframes you want to select, 
whether they’re next to one another or not.

 — To select multiple contiguous keyframes: Click the first keyframe you want to select, and then 
shift-click the last keyframe you want to select, and all keyframes between will also be selected, or 
drag a bounding box within the Curve Editor around multiple keyframes to select them all at once.

 — To select all keyframes: If the Keyframe Editor is open and it has focus (by clicking anywhere 
within it), then pressing Command-A will select all keyframes within that Keyframe Editor.

Methods of adjusting keyframes in the Curve Editor of the Edit page:

 — To drag one or more keyframes freely on a curve: Select one or more keyframes and drag left 
or right to retime them, and up or down to change their value.

 — To drag one or more keyframes on a curve in only one direction: Select one or more 
keyframes, then hold the Shift key while dragging either vertically or horizontally to constrain 
keyframe adjustment within that single direction.

 — To nudge selected keyframes one value or frame at a time: Select one or more keyframes and 
Command-Left Arrow and Command-Right Arrow to nudge them in time, or Command-Up Arrow 
and Command-Down Arrow to nudge their value, for precision keyframe adjustments.
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Methods of changing keyframe interpolation/easing/smoothing:

 — To change the interpolation of a single keyframe: There are two methods. You can select the 
keyframes you want to change, and then click one of the four Bezier interpolation buttons in the 
Curve Editor title bar. Or, you can right-click one of the selected keyframes and choose one of 
the interpolation options from the contextual menu. Keyframes that have already been eased in 
the Keyframe Editor or via controls in the Inspector already have bezier handles exposed in the 
Curve Editor.

 — To change the interpolation of multiple keyframes: Select multiple keyframes by Command-
clicking or dragging a bounding box, and then click one of the four Bezier interpolation buttons in 
the Curve Editor title bar to simultaneously change the interpolation of all of them.

 — To adjust a Bezier handle: Drag the Bezier handle in any direction to alter the curve.

The Curve Editor with Bezier interpolated keyframes

Methods of Cutting, Copying, Pasting, and Deleting keyframes:

 — To cut or copy, and paste one or more keyframes: Make a selection of keyframes and use the 
Cut (Command-X) or Copy (Command-C) key shortcuts. Then, move the playhead to where you 
want the first of the copied keyframes to start, and press Paste (Command-V).

 — To delete one or more control points from a curve: Select the keyframe(s) you want to delete 
and press Backspace.

IMPORTANT: Keyframes on the Timeline can exist past a clip’s current extents. For 
example, if you set several keyframes on a clip, then trim its duration on the Timeline 
past one of the keyframes, that keyframe is still there and fully functional, just not visible. 
You can still navigate to these invisible keyframes by using the Previous “[“ and Next “]” 
keyframe commands or using the keyframe controls in the Inspector.
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Keyframable Open FX 
and Resolve FX
The parameters of Open FX and Resolve FX have keyframe controls to the right of each parameter’s 
number field in the Effects Inspector of the Edit and Color pages, so you can animate effects that you 
add to clips and grades.

Resolve FX can now be animated in the Edit page 
using keyframe controls in the Inspector.

Additionally, keyframes added to Resolve FX parameters in the Inspector now appear in both the 
Keyframe and Curve Editor of the Edit page Timeline. You can expose individual keyframe tracks and 
curves for each keyframed parameter of an effect applied to a clip, for smoothing, retiming, or editing.

Resolve FX keyframes exposed in the Edit page Curve Editor
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Chapter 54

VFX Connect
For instances where the various effects of the Edit, Fusion, and 
Color page aren’t enough to achieve the effect you require, you 
can use the VFX Connect feature of DaVinci Resolve to send one or 
more clips from the Edit page timeline to the standalone version 
of Blackmagic Fusion, in order to do more robust compositing and 
effects work there. 

You can use this workflow in the macOS, Windows, and Linux versions of DaVinci Resolve, since Fusion 
works on all three platforms. 

This is a simple round-trip operation that lets you send clips from the DaVinci Resolve Timeline to 
Fusion, add effects, and then render a finished effect out of Fusion that will automatically appear back 
in your timeline.
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Using VFX Connect
Sending one or more clips to the standalone version of Blackmagic Fusion is simple.

To send clips to Fusion:

1 Select one or more clips in the Timeline that you want to send to Fusion. In this example, two 
superimposed clips are selected.

Selecting two clips to send to Fusion

2 Right-click one of the selected clips and choose New VFX Connect Clip from the contextual menu.

The New VFX Connect Clip dialog

3 In the New VFX Connect Clip dialog, choose the following options:

a) Enter a name.

b) Choose a video format (for rendering media to send to Fusion).

c) Choose a codec, based on the format you selected.

d) If you want to send Alpha channels to Fusion, turn the Export Alpha checkbox on. This exports 
alpha channels that are embedded in a clip, as well as alpha channels that are being created in 
DaVinci Resolve.

e) If you want to save the VFX Connect Clip that you’re creating, along with its directory and 
media, to a specific location, turn on the Custom Location checkbox, then click the Browse 
button and choose a location. Otherwise, the directory containing the VFX Connect clip and 
any source media rendered along with it is placed in the same directory as the scratch disk.
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f) If you want to immediately open Fusion, turn on the “Open VFX Connect Clip” checkbox. If you 
do this, then DaVinci Resolve by default renders each of the video clips you selected, along 
with every speed effect, transform, and Color page operation that’s been applied to each clip, 
using the Timeline Color Space. However, if you click Cancel when the Render Composition 
Media dialog appears, then the Fusion project that opens references the source media on 
disk, rather than rendered media that’s generated by DaVinci Resolve.

4 When you’re finished, click Create. DaVinci Resolve creates a VFX Connect clip, which appears in 
the Timeline as a single clip and in the Media Pool.   

(Left) VFX Connect clips in the Timeline, (Right) in the Media Pool

5 Opening the VFX Connect clip in Fusion can be done in one of two ways:

 — If you turned on “Open VFX Connect Clip,” then Fusion automatically opens and the clips you 
selected appear as Loader nodes within Fusion.

 — If you didn’t, then you can right-click the VFX Connect clip in the Media Pool, and choose VFX 
Connect > Open Fusion from the contextual menu.

At this point, new media is rendered (by default), Fusion opens, and the clips you sent are 
converted into a Fusion node tree, explained in greater detail in the following section.

6 In Fusion, use the available tools to create the required effect.

7 Optionally, before you render, if you want to change the Output Format, click the Output node, 
and choose a new format from the Output Format pop-up in the Tools tab. If you don’t do this, the 
Fusion composite will be rendered using the format you selected when you sent the VFX Connect 
clip in the first place.

The Tools panel where you can change the file 
information governing the rendered output
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8 When you’re finished creating your effect in Fusion, click the Render button to open the Render 
Settings, check to make sure that the settings are correct, and click Start Render. This renders the 
Fusion composition to the disk location and using the name that you chose in step 3. 

Selecting two clips to send to Fusion

9 A Render Settings dialog appears, which lets you choose how you want to render the output, with 
options including the Quality, Frame Range, and Size of the media being output. If the default 
settings are good, click Start Render. A progress bar indicates how long the render will take. 
For more information, consult the Fusion User Manual.

10 Once rendering has finished, save your Fusion project, reopen DaVinci Resolve, and you should 
see that the VFX Connect clip in the Timeline has updated to show the new effect you created 
in Fusion.

How Clips are translated 
into Node Trees
In Fusion, each clip that you send appears as a Loader node that is linked to that clip’s media on disk. 
If you selected multiple clips, each clip is superimposed over the one just below it using a Merge node, 
which lets you merge two images at a time with an Over operator by default.

Two superimposed clips sent to Fusion as represented in the Fusion node tree

With this as your starting point, you can add nodes (called Tools in Fusion) to apply operations of 
your own, in order to create more sophisticated effects and composites. For more information 
about using Fusion, see the Fusion User Manual, available from the Support page at the 
Blackmagic Design web site.
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Altering VFX Connect Clips
If, at any point, you want to modify the Fusion composition, you can reopen the project in Fusion, or 
right-click the VFX Connect clip in the DaVinci Resolve Media Pool and choose VFX Connect > Open in 
Fusion. Once in Fusion, make whatever changes you want to, and then re-render the clip to overwrite 
the previously rendered media. When you create new versions in this way, each version’s Fusion 
project file and rendered output is maintained and preserved, so you can always go back and forth.

When you return to DaVinci Resolve, you may need to right-click the VFX Connect clip you just opened, 
and choose VFX Connect > Refresh to make sure that DaVinci Resolve correctly sees the re-rendered 
media from Fusion.

Creating Multiple Versions of Fusion Clips
If you want to render a new version, but you want to keep the previous version, then you can right-
click the VFX Connect clip in the Resolve Media Pool and choose VFX Connect > Create New Version. 

Creating a new version of a VFX Connect composite

This creates a duplicate of the composite in Fusion, with the “_v1” part of the filename incremented so 
it doesn’t overwrite the previous version of that composite. 

Once in Fusion, make whatever changes you need to the composite, then re-render the clip to 
generate an additional piece of media for that version. The filename of the Saver node for the new 
media you’re rendering is also automatically incremented with the “_v1” segment of the filename 
changed to the next version number, such as “_v2” if it’s version two of the effect.

The Tools panel shows the Saver 
node’s updated filename for the 
new version’s rendered output
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When you’re finished, you’ll end up with a Fusion Project file and a corresponding rendered media file 
that share the same version number. When you return to DaVinci Resolve, Resolve will automatically 
detect that there are multiple versions in the VFX Connect directory, and will make each version 
available via a Choose Version submenu for VFX Connect clips in the Media Pool.

Switching Versions of VFX Connect Clips in 
DaVinci Resolve
Once you’ve created multiple versions of a VFX Connect clip, you can switch which version is used for 
that clip in DaVinci Resolve by right-clicking the VFX Connect clip in the Media Pool, and choosing the 
version from the VFX Connect > Select Version submenu of the contextual menu.

Choosing which version to use from the VFX Connect > Select Version submenu

TIP: If you want to switch versions for a VFX Connect clip in a timeline, you can right-click 
that clip and choose Find in Media Pool.

Sending a VFX Connect 
Directory to Another Machine
If you’re going to hand off a VFX Connect directory to someone else using a different workstation, it’s 
a good idea to render self-contained media for the Fusion composition to make it easy to hand off 
everything the compositing artist will need. Otherwise, you’ll need to manually find and provide the 
associated media files yourself. There are two ways of rendering self-contained media for Fusion:

 — If you check “Open VFX Connect Clip” in the New VFX Connect Clip dialog, then DaVinci Resolve by 
default renders each of the video clips you selected, along with every speed effect, transform, and 
Color page operation that’s been applied to each clip, using the Timeline Color Space. 

 — If you haven’t opened the VFX Connect clip in Fusion yet, you can also right-click any VFX Connect 
clip in the Media Pool, and choose VFX Connect > Render Media from the contextual menu.
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Once that’s done, there are two ways you can locate the actual VFX Connect directory’s location, in 
order to copy it for whomever is going to be doing the compositing work for you.

 — You can turn on the Custom Location checkbox in the New VFX Connect Clip dialog, then click the 
Browse button and choose a location where the resulting directory is easily copied.

 — You can also right-click on any VFX Connect clip in the Media Pool, and choose Reveal in Finder to 
open that VFX Connect clip’s directory.

Since your DaVinci Resolve project keeps track of the location of the VFX Connect directory from the 
moment it’s created, you don’t want to move it, since DaVinci Resolve is counting on it being where it 
thinks it is. Once your colleague has completed the compositing work in Fusion, all they need to do is 
send you back the Fusion Composition file (just so you can keep everything together), and the media 
they rendered, both of which you need only copy to the top level of the corresponding VFX Connect 
directory. Once you do that, DaVinci Resolve should automatically see the rendered media and refresh 
those VFX Connect clips on your timeline.

Creating Multiple Versions of 
Fusion Clips on Another Machine
If you’ve handed off the directory created by the VFX Connect process to someone off site, they can 
still create multiple versions of the composite that can be managed by DaVinci Resolve.

Use the Save As command in Fusion to save a duplicate of the Fusion project with the “_v1” segment 
of the filename incremented to the next version number, such as “_v2” if it’s version two of the 
composite. Make sure you save this duplicate Fusion project into the same directory as the original, so 
DaVinci Resolve can find it. Once created, you can change this duplicate project file any way you need.

When you’re finished, select the Saver node (at the very end of the Fusion node tree), and change the 
filename by incrementing the V1 part of the Filename field. For example, if your clip is being named 
Output_V1.mov, then change the filename to Output_V2.mov in the Tools tab, and render. If you’re 
rendering a DPX image sequence, then you’ll want to change the name of the folder that encloses the 
frames, so change the filename from “.../fusion/OutputDirectory_V1/Output_00000000.dpx” to “.../
fusion/OutputDirectory_V2/ Output_00000000.dpx” to obtain a correctly named second version.

Updating VFX Connect Clips 
Using Render Media and Refresh
If you change a grade or effect that’s applied to a clip inside of a VFX Connect clip, you’ll need to 
right-click that clip and choose VFX Connect > Render Media to re-render updated media files for the 
Fusion project.

If you re-render a Fusion composite and overwrite media that’s already referenced by a VFX 
Connect clip in an open DaVinci Resolve project, you may need to refresh that media reference in 
DaVinci Resolve. The easy way to do this is to right-click any VFX Connect clip in the Media Pool, and 
choose VFX Connect > Refresh.
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